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Preface

TIBCO BusinessConnect™ SOAP Protocol is a business protocol designed to enhance the
capabilities of the TIBCO BusinessConnect™ integration platform. Integrated with
TIBCO ActiveMatrix BusinessWorks™, you can use TIBCO BusinessConnect SOAP
Protocol to create and send private process messages.

* Related Documentation, page xiv
» Typographical Conventions, page xvi

* TIBCO Product Documentation and Support Services, page xviii
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Related Documentation

This section lists documentation resources you may find useful.

TIBCO BusinessConnect SOAP Protocol Documentation

The following documents form the 7/BCO BusinessConnect SOAP Protocol
documentation set:

TIBCO BusinessConnect SOAP Protocol Installation Read this manual for
instructions on site preparation and installation.

TIBCO BusinessConnect SOAP Protocol User’s Guide Read this manual for
instructions on using the product to manage SOAP operations between trading hosts
and partners.

TIBCO BusinessConnect SOAP Protocol Release Notes Read the release notes for a
list of new and changed features. This document also contains lists of known issues
and closed issues for this release.

Other TIBCO Product Documentation
You may find it useful to read the documentation for the following TIBCO products:

TIBCO BusinessConnect™

TIBCO Administrator™

TIBCO ActiveMatrix BusinessWorks™
TIBCO Designer™

TIBCO Runtime Agent™

TIBCO Rendezvous®

TIBCO Enterprise Message Service ™
TIBCO BusinessConnect™ Palette

TIBCO ActiveMatrix Business Works™ Plug-in for BusinessConnect

Third Party Documentation

You may find it useful to read the following third-party documentation:

TIBCO BusinessConnect SOAP Protocol Installation
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*  The specification for the SOAP protocol
http://www.w3.org/TR/SOAP

*  Web Services Security UsernameToken Profile 1.1 OASIS Standard Specification, 1
February 2006

http://docs.oasis-open.org/wss/v1.1/wss-v1.1-spec-os-UsernameTokenProfile.pdf

*  Web Services Addressing (WS-Addressing). W3C Member Submission, 10 August
2004

http://www.w3.org/Submission/ws-addressing

*  SOAP Message Transmission Optimization Mechanism. W3C Recommendation, 25
January 2005

http://www.w3.org/TR/2005/REC-soap12-mtom-20050125

» Assertions and Protocols for the OASIS Security Assertion Markup Language
(SAML) V2.0 OASIS Standard, 15 March 2005

http://docs.oasis-open.org/security/saml/v2.0/saml-core-2.0-0s.pdf

* Authentication Context for the OASIS Security Assertion Markup Language (SAML)
V2.0 OASIS Standard, 15 March 2005

http://docs.oasis-open.org/security/saml/v2.0/saml-authn-context-2.0-0s.pdf
*  Web Services Security: SAML Token Profile 1.1 OASIS Standard, 1 February 2006

https://www.oasis-open.org/committees/download.php/16768/wss-v1.1-spec-0s-SAM
LTokenProfile.pdf

*  Web Services Security: SOAP Message Security 1.1 (WS-Security 2004) OASIS
Standard Specification, 1 February 2006

http://docs.oasis-open.org/wss/v1.1/wss-v1.1-spec-0s-SOAPMessageSecurity.pdf

TIBCO provides no warranties or assurances regarding the content located in the
foregoing websites.
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1 General Typographical Conventions

Convention Use

ENV_NAME TIBCO products are installed into an installation environment. A product installed into

TIBCO HOME

an installation environment does not access components in other installation
environments. Incompatible products and multiple instances of the same product must be

installed into different installation environments.

An installation environment consists of the following properties:

BCSOAP_HOME

Name Identifies the installation environment. This name is referenced in
documentation as ENV_NAME. On Microsoft Windows, the name is appended to the
name of Windows services created by the installer and is a component of the path to
the product shortcut in the Windows Start > All Programs menu.

Path The folder into which the product is installed. This folder is referenced in
documentation as TIBCO _HOME.

TIBCO BusinessConnect SOAP Protocol installs into a directory within a TIBCO _HOME.
This directory is referenced in documentation as BCSOAP_HOME. The default value of

BCSOAP _HOME depends on the operating system. For example, on Windows systems,
the default value is C:\tibco\be\version\protocols\soap.

code font Code font identifies commands, code examples, filenames, pathnames, and output
displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code font Bold code font is used in the following ways:

In procedures, to indicate what a user types. For example: Type admin.

In large code samples, to indicate the parts of the sample that are of particular
interest.

In command syntax, to indicate the default parameter for a command. For example,
if no parameter is specified, MyCommand is enabled:
MyCommand [enable | disable]

TIBCO BusinessConnect SOAP Protocol Installation
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Table 1 General Typographical Conventions (Cont’d)

Convention Use
italic font Italic font is used in the following ways:
* To indicate a document title. For example: See 7IBCO BusinessConnect Concepts.

* To introduce new terms. For example: A portal page may contain several portlets.
Portlets are mini-applications that run in a portal.

* To indicate a variable in a command or code syntax that you must replace. For
example: MyCommand pathname

Key Key name separated by a plus sign indicate keys pressed simultaneously. For example:
combinations Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the other.
For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for example,
an additional action required only in certain circumstances.

| The tip icon indicates an idea that could be useful, for example, a way to apply the
‘\'/, . . . . . . .
v information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, data loss
or corruption if certain steps are taken or not taken.

TIBCO BusinessConnect SOAP Protocol Installation
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TIBCO Product Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, or join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website mainly in the HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current
than any other documentation included with the product. To access the latest
documentation, visit https://docs.tibco.com.

Documentation for TIBCO BusinessConnect SOAP Protocol is available on the
https://docs.tibco.com/products/tibco-businessconnect-soap-protocol Product
Documentation page.

How to Contact TIBCO Support
You can contact TIBCO Support in the following ways:

* For an overview of TIBCO Support, and information about getting started with
TIBCO Support, visit http://www.tibco.com/services/support

* For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support portal at
https://support.tibco.com.

*  For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to
https://support.tibco.com. If you do not have a user name, you can request one by
clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.

TIBCO BusinessConnect SOAP Protocol Installation
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Chapter 1

Topics

1

Introduction to SOAP and TIBCO
BusinessConnect SOAP Protocol

This chapter gives an overview of SOAP and TIBCO BusinessConnect SOAP Protocol.

*  SOAP Overview, page 2
* TIBCO BusinessConnect SOAP Protocol Overview, page 3
*  TIBCO BusinessConnect SOAP Protocol Features, page 4

TIBCO BusinessConnect SOAP Protocol User’s Guide



2 | Chapter 1 Introduction to SOAP and TIBCO BusinessConnect SOAP Protocol

SOAP Overview

TIBCO BusinessConnect SOAP Protocol supports both SOAP versions 1.1 and 1.2.

SOAP 1.1 is a lightweight XML-based messaging protocol for exchanging structured data
in a decentralized, distributed environment. Buyers, sellers, and intermediaries can use
SOAP to share business documents and messages over the Internet. SOAP can also be
used for other types of supply chain integration transactions, such as collaborative
forecasting, inventory management, and design collaboration.

SOAP 1.2 is an update version based on SOAP 1.1.

SOAP transactions involve the exchange of documents, most of which are analogous to
hardcopy documents traditionally used in business. These documents are simple text files,
but they have well-defined structure and contents.

SOAP has the following parts:

* An envelope that defines a framework for describing what is in a message and how to
process the message. This defines the message package. The SOAP envelope consists
of an optional header and a mandatory body. The envelope is the first element in the
document and identifies it as a SOAP message. The sender can add management or
control information that can be used for routing, security, or correct handling by the
recipient. The body contains the information sent to the receiver.

*  SOAP attachments which follow the SOAP with Attachment (SwA) standard.
Businesses use SOAP attachments to exchange business documents in arbitrary
formats, such as EDI, PDF, and JPG to facilitate business-to-business transactions.
SwA is also used with MTOM to carry binary data originally contained in XML
infoset.

* A standard for representing request and response.
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TIBCO BusinessConnect SOAP Protocol Overview

TIBCO BusinessConnect SOAP Protocol is the implementation by TIBCO of SOAP 1.1
and SOAP 1.2 specifications. The protocol has been developed by TIBCO for exchanging
any type of business documents used in electronic business, for example, XML, EDI, and
other binary format, such as PDF, JPG, and so on. Based on an agreed-upon process flow
and common document format, you and your trading partner can conduct secure and
verifiable business transactions online by using TIBCO BusinessConnect SOAP Protocol.

See the information about business protocols in the chapter that explains Operations in
TIBCO BusinessConnect Concepts.
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TIBCO BusinessConnect SOAP Protocol Features

The following are some significant features of the TIBCO BusinessConnect SOAP
Protocol:

*  Support for the synchronous Request-Response and Notify operation types.

See Notify Operations on page 10 and Synchronous Request-Response Operations on
page 11.

*  Support for SOAP versions 1.1 and 1.2.
See SOAP Overview on page 2 and SOAP Version on page 101.

*  Support for SOAP fault in versions 1.1 and 1.2.
See SOAP Fault on page 23.

*  Support for Message Transmission Optimization Mechanism (MTOM).
See MTOM on page 22 and SOAP MTOM Enabled on page 102.

*  Support for HTTP, HTTPS, and HTTPSCA transport protocols.

e Multiple server certificate support for HTTPS.

*  Access control through trading partner identification and permissions.

*  Validation of XML documents with XSDs.

«  Signing or encrypting the SOAP body as a whole by using Web Services Security
(WSS).

See SOAP Message Security on page 17.

*  Support for Security Assertion Markup Language (SAML) 2.0 in SOAP header for
digital signature and authorization in conformance with NHIN/esMD Authorization
Framework.

See NHIN/esMD Authorization Framework with SAML Assertions on page 19.

*  Support for signature confirmation in a response to a specific request.

*  Support for WSS UsernameToken authentication.
See SOAP Message Security on page 17.

*  Limited support for Web Services Addressing (WS-Addressing) in SOAP header.
See WS-Addressing on page 20.

*  Ability to specify certain timing constraints.

e Ability to generate audit records.
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See Audit Logs on page 121.
Support for operation setting overriding in a specific business agreement.

See Editing an Operation Binding for the Host on page 108 and Editing an Operation
Binding for the Partner on page 111.

Support for non-repudiation logging for all operations.
See Non-Repudiation Logs on page 127.

Ability to exchange business documents using SwWA.
See Attachment on page 168.

Support for Web Services Description Language (WSDL). WSDL is an
XML-formatted language used to describe the capabilities of a Web service as
collections of communication endpoints capable of exchanging messages. TIBCO
BusinessConnect SOAP Protocol configurations and operation definitions can be
exported to WSDL files, and vice versa.

Tools available to export and import configurations and operation definitions as
WSDL files.

See TIBCO BusinessConnect SOAP Protocol WSDL Tool on page 195.
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Process Flows and Functionalities

This chapter describes process flows and relevant functionalities by using TIBCO
BusinessConnect SOAP Protocol for business transactions.

* TIBCO BusinessConnect SOAP Protocol Messages, page 8

*  Operation Types and Process Flows, page 10

*  Duplicate Message Detection, page 15

*  SOAP Message Security, page 17

*  NHIN/esMD Authorization Framework with SAML Assertions, page 19
*  WS-Addressing, page 20

«  MTOM, page 22

e SOAP Fault, page 23
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TIBCO BusinessConnect SOAP Protocol Messages

In a SOAP transaction, two partners exchange business documents over the Internet based
on a pre-defined business agreement. Among other options, the business agreement
describes what message formats and transport protocols the partners have agreed to use.
The exchange of business documents is known as the process flow. See Operation Types
and Process Flows on page 10.

In a TIBCO BusinessConnect process flow, two types of messages are exchanged: private
messages and public messages.

Private Messages and Processes

Private messages are exchanged between TIBCO BusinessConnect and the private
processes, which are the interface for TIBCO BusinessConnect to integrate with the
back-office system. An example of private process is the TIBCO ActiveMatrix
BusinessWorks process. For a detailed description of TIBCO BusinessConnect SOAP
Protocol private messages, see Chapter 11, Private Messages, page 147. Private messages
can contain a request, a response, or a notification document.

Private processes handle conversion from company back-office data to TIBCO
BusinessConnect private messages.

*  On the initiator side, the private process converts internal company back-office data to
TIBCO BusinessConnect private message. This message represents a request, an
acceptance, or a notification document.

*  On the responder side, the private process receives a private message from TIBCO
BusinessConnect, converts it to internal company back-office format and sends to the
back-office system. If this is a request-response operation, the private process receives
back a response from inside the company, and converts it to a response private
message, and sends it back to TIBCO BusinessConnect.

The following private processes types are available with TIBCO BusinessConnect SOAP
Protocol:

» Standalone Standalone private processes use TIBCO Rendezvous Certified
Messaging to communicate with TIBCO BusinessConnect SOAP Protocol. They are
normally implemented by using any programming language that supports TIBCO
Rendezvous API. For an example, see Chapter 3, Standalone Private Processes
Tutorial, on page 25.

* TIBCO ActiveMatrix BusinessWorks The TIBCO ActiveMatrix BusinessWorks
processes combined with TIBCO BusinessConnect Palette can be used to send
requests to TIBCO BusinessConnect SOAP Protocol, or receive replies from TIBCO
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TIBCO BusinessConnect SOAP Protocol Messages

BusinessConnect SOAP Protocol. For an example, see Chapter 4, TIBCO
ActiveMatrix BusinessWorks Private Processes Tutorial, on page 49.

Public messages are exchanged over the Internet between two trading partners. TIBCO
BusinessConnect SOAP Protocol can be used by an enterprise to send and receive public
messages to do transactions with its trading partners. When trading partners use SOAP
protocol to do transaction with each other, the public messages exchanged between them
are SOAP messages. They can use HTTP, SMTP, FTP, or other transport protocols for the
messages exchange. TIBCO BusinessConnect SOAP Protocol supports HTTP and
HTTPS as transport protocols. Synchronous request-response and notify transaction types
are supported.

On the Initiator side The initiator BusinessConnect server receives requests as
private messages from private processes, converts them into SOAP messages and
sends them to the responder side. In request-response transaction mode, the initiator
BusinessConnect server receives response SOAP messages from the responder side,
converts them into private messages that are eventually sent to private processes.

On the Responder side The responder BusinessConnect server receives SOAP
request messages from the initiator, which is on the trading partner side, and then
converts the SOAP messages into private messages that are sent to private processes.
In request-response transaction mode, the responder BusinessConnect server receives
the response private messages from the responder private processes, and then converts
them into SOAP response messages and then replies back to the initiator side.

TIBCO BusinessConnect SOAP Protocol User’s Guide
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Operation Types and Process Flows

When you use TIBCO BusinessConnect to exchange SOAP messages with a partner, you
can use different operation types for different kinds of transactions. Two operation types
are in SOAP. Any operation defined must be one of these two operation types:

Notify Operations

Notify Use this operation type when the initiator only requires an acknowledgment
from the responder to verify the receipt of the SOAP message.

Synchronous request-response Use this operation type when the initiator and the
responder do a more complex exchange of business documents by exchanging SOAP
messages. When the initiator sends a request SOAP message to the responder, a
response SOAP message is expected to be returned back from the responder in
synchronous HTTP reply.

The following process flow occurs in a Notify type operation. In this process flow, both
the initiator and responder are assumed to be implemented by TIBCO BusinessConnect
SOAP Protocol:

1.

A private process inside the initiating company sends a request private message that
contains the request business document to the initiator BusinessConnect server. See
Initiator Outbound Request — Private Process to BusinessConnect on page 149.

The initiator BusinessConnect server retrieves relevant information from the private
message, packages the message into an appropriate SOAP message and sends the
message to the responder.

The responder BusinessConnect server receives the SOAP message, validates,
unpackages, retrieves the business document, and then forwards the document in
private message format to the responder private process. See Responder Inbound
Request — BusinessConnect to Private Process on page 157.

The responder BusinessConnect server immediately sends a response
(acknowledgment) to the initiator on the same HTTP transport channel as the business
request of initiator.

Alternatively, if the responder BusinessConnect server cannot process the notify
request SOAP message, the responder BusinessConnect server sends a SOAP fault to
the initiator on the same HTTP transport channel.

Time Constrains and Resend

For a Notify type operation, you can specify the time constrains on the initiator side:
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For the initiator: configure in HTTP/HTTPS transport configuration for the specific
trading partner.

— Retry Count
— Retry Interval
— Socket Timeout (seconds)
The flow of information and the associated predefined timing restrictions are as shown in

Figure 1.

Figure I Notification
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As the Initiator
From the initiator, an operation is processed with the following timing restrictions:
1. The initiator sends out a request to the responder.

2. If communication cannot be established, a specified number of retries occur with
specified time intervals between retransmits.

3. If the communication is established and a request is sent over, however, the
acknowledgment does not come back within the specified Socket Timeout, an error is
generated on the initiator side and sent to the private process.

Synchronous Request-Response Operations

The following process flow occurs in a synchronous request-response operation. In this
process flow, both the initiator and responder are assumed to be implemented by TIBCO
BusinessConnect SOAP Protocol:

1. A private process inside the initiating company sends a request private message to the
initiator BusinessConnect server, which contains the request business document. See
Initiator Outbound Request — Private Process to BusinessConnect on page 149.
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The initiator BusinessConnect server retrieves relevant information from the private
message, packages it into a request SOAP message, and sends the SOAP message to
the responder.

The responder BusinessConnect server receives the SOAP message, validates,
unpackages, retrieves the business document, and then forwards it to the responder
private process and waits for the private process to respond. See Responder Inbound
Request — BusinessConnect to Private Process on page 157.

If the validation or unpackaging of the inbound SOAP message fails, the responder

BusinessConnect server sends a SOAP fault on the same HTTP transport channel to
the initiator BusinessConnect server, which forwards the fault content to the private
process.

The responder private process responds to the responder BusinessConnect server with
a response private process message containing the response business document. See
Responder Outbound Response — Private Process to BusinessConnect on page 161.

The responder private process can also return an error message as a SOAP fault to
responder BusinessConnect server if the private process cannot process the request
SOAP message. To send a SOAP fault as the response on the responder side, ensure
that the value in the statusCode field of the ae/SOAP/ResponderResponse AE message is not
in the range of 200-299.

The ae/SOAP/ResponderResponse AE message class in the SOAP fault private message
includes a field called soapFault. TIBCO BusinessConnect SOAP Protocol uses the
values in the soapFault field to generate the public SOAPFault response message.

The responder BusinessConnect server forwards the business response or a SOAP
fault on the same HTTP transport channel to the initiator BusinessConnect server.

The responder BusinessConnect server sends an acknowledgment to the responder
private process if no error occurs during the reply of the response message. See
Responder Acknowledgement — BusinessConnect to Private Process on page 165.

The initiator BusinessConnect server forwards the response or the SOAP fault to the
initiator private process. See Initiator Inbound Response — BusinessConnect to
Private Process on page 154.

Time Constrains and Resend

For a synchronous request-response operation, you can specify the following time
constrains:
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*  For the initiator: configure in HTTP or HTTPS transport configuration for the specific
trading partner.

— Retry Count
— Retry Interval
— Socket Timeout (seconds)
*  For the responder: configure in the response action of the specific operation definition.

— Private Process Wait (seconds)

Figure 2 Synchronous Request-Response
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As the Initiator
From the initiator, an operation is processed with the following timing restrictions:
1. The initiator sends out a request to the responder.

2. If communication cannot be established, a specified number of retries occurs with
specified time intervals between retransmits.

3. Ifthe response does not come back within the specified Socket Timeout, an error is
generated on the initiator side and sent to the private process.

As the Responder
From the responder, an operation is processed with the following timing restrictions:
1. The responder receives a request SOAP message from the initiator.

2. The responder BusinessConnect server hands off the request business document to the
responder private process.

3. The responder private process returns the response business document to the
responder BusinessConnect server. The maximum wait time between the request

TIBCO BusinessConnect SOAP Protocol User’s Guide
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business document sent to the private process and the response from the private
process can be specified as Private Process Wait. If the response message is not
received within the Private Process Wait time, an error is generated by the responder
BusinessConnect server and a SOAP fault is returned back to the initiator.

4. After the responder BusinessConnect server receives the response from the private
process, the response is packaged into a SOAP message and sent back to the initiator.

5. Unless a transport-level error is returned, the responder BusinessConnect server sends
an acknowledgment to the responder private process indicating that the message has
been replied to the initiator.
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Duplicate Message Detection

TIBCO BusinessConnect SOAP Protocol checks for duplicates on all inbound and
outbound messages. If duplicates are found, the duplicate field value in the request or
response message sent to a private process is set to true.

Inbound Messages

For inbound messages, duplicate detection is performed in the same way for the inbound
request and inbound response.

Duplicate detection criteria for the inbound request and inbound response messages are as
follows:

Protocol name

Protocol version

Installation name

Host name

Trading partner name

Operation ID

Body element of the SOAP envelope

TIBCO BusinessConnect SOAP Protocol User’s Guide
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Outbound Messages

For outbound messages, duplicate detection is performed only for the outbound request
received from a private process.

Duplicate detection criteria for the OutboundRequest messages are as follows:

*  Protocol name

*  Protocol version

e Installation name

e Host name

e Trading partner name

e Transaction ID

*  Operation ID

* Request coming from the private process (no header)

The domains of the host and trading partner in private process request messages are not
&

taken into consideration when performing duplicate detection. Only the values hostname and
tpname are considered.
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SOAP Message Security

TIBCO BusinessConnect SOAP Protocol supports the following security features:
» Digital Signature and Encryption

e UsernameToken for Authentication

Digital Signature and Encryption

&

In TIBCO BusinessConnect SOAP Protocol, Web Services Security (WSS) is used to sign
or to encrypt the SOAP body as a whole. Individual elements of the body or any other
parts, such as header elements or attachments, cannot be signed or encrypted.

For more details on how to sign and encrypt, see the Require Digital Signature and
Require Content Encryption for the following operations:

»  Notify Request Action Tab on page 81

* Request Action Tab on page 84

* Response Action Tab on page 87

TIBCO BusinessConnect SOAP Protocol support DES3, AES-128, AES-192, AES-256,

AES-128-GCM, AES-192-GCM, and AES-256-GCM encryption algorithms and the
SHA1, SHA256, SHA384 and SHAS512 digest algorithm for signatures.

UsernameToken for Authentication

As an authentication alternative, WSS Username/Password Token ((WSS11-UT]) can also
be used, without the exclusiveness of Digital Signature Authentication, for inbound
message authentication.

The password type of UsernameToken only digest password in the current implementation
for outbound messages. For inbound messages, either the digest or plain text passwords
are accepted. Plain text password is normally used together with SSL transport.

When UsernameToken is used for authentication, the wsse:UsernameToken €lement is in the
“primary” security header along with other security entities such as digital signature and
encryption element if they are present.

You can set TIBCO BusinessConnect SOAP Protocol to use the UsernameToken for
authentication in TIBCO Administrator by clicking BusinessConnect > Operations
Editor > SOAP > Operation Type > Request/Response Action > General > Require
UsernameToken Authentication.

TIBCO BusinessConnect SOAP Protocol User’s Guide
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If you select the Require UsernameToken Authentication check box on the outbound
side, the user name and password must be typed in the private process.

If you select the Require UsernameToken Authentication check box on the inbound
side, the inbound request and response SOAP messages are required to embed the
UsernameToken element, and the user has to be defined as an external user and be
associated with this trading partner from whom the message is received. You can define
and configure an external user in TIBCO Administrator by clicking BusinessConnect >
User Management > Users > External.

The UsernameToken for Authentication is not supported for SOAP fault messages.

For more details, see the Require UsernameToken Authentication check box for the
following operations:

*  Notify Request Action Tab on page 81
* Request Action Tab on page 84
* Response Action Tab on page 87

Sample of the UsernameToken Part

<wsse:UsernameToken xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/0asis-200401-wss-wssecurity-utility-1.0.xsd">

<wsse:Username>Test</wsse:Username>

<wsse:Password
Type="http://docs.oasis-open.org/wss/2004/01/0asis-20040 1 -wss-username-token-profile-1.0#PasswordDigest">NdiR1/Z4CnW{bFahIBFWxIt7xLM
=</wsse:Password>

<wsse:Nonce
EncodingType="http://docs.oasis-open.org/wss/2004/01/0asis-200401-wss-soap-message-security-1.0#Base64Binary">Prvav23eGuMul/XSIGI07A=
=</wsse:Nonce>

<wsu:Created
xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/o0asis-20040 1 -wss-wssecurity-utility-1.0.xsd">2014-01-13T03:14:56.640Z</wsu:Created>
</wsse:UsernameToken>
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NHIN/esMD Authorization Framework with SAML Assertions

SAML is an XML-based, open-standard data format for exchanging authentication and
authorization data between parties. SAML is a product of the OASIS Security Services
Technical Committee. The Nationwide Health Information Network (NHIN) is a set of
standards, services, and policies for secure exchange of the health information over the
Internet. The NHIN Authorization Framework Specification defines the primary set of
services and protocols that is required to establish a messaging, security, and privacy
foundation for the NHIN.

Electronic Submission of Medical Documentation (esMD), as part of NHIN, follows the
NHIN Authorization Framework with SAML 2.0 assertions. By using SAML assertions,
esMD defines the exchange of metadata used to characterize the initiator of an esMD
request, so the request might be evaluated by the esMD Gateway in local authorization
decisions. The purpose of these SAML assertions exchange is to provide the esMD
Gateway with the required information to make an authorization decision by using the
policy enforcement point for the requested esMD function. Each initiating SOAP message
must convey information by using SAML 2.0 assertions. The NHIN/esMD Authorization
Framework is used by Council for Affordable Quality Healthcare (CAQH) CORE in
exchanging healthcare information.

TIBCO BusinessConnect SOAP Protocol supports SAML assertions in conformance with
the NHIN Authorization Framework. TIBCO BusinessConnect SOAP Protocol can work
as either the esMD Gateway or clients. On esMD Gateway side, requests with SAML
assertions are authenticated before all the Health Information Handler (HIH) and
authorization attributes are forwarded to back office systems for further evaluation in
authorization decisions. Responses sent back to the initiators in asynchronous mode can
use SAML assertion signature, and also convey the HIH and authorization attributes.
Responses sent back to the initiators in synchronous mode can use signature confirmation
to verify the SAML assertion signature.

For more details on how to configure SAML assertions in TIBCO Administrator, see
Request Action Tab on page 84 and Response Action Tab on page 87. For more details on
the NHIN/esMD process definitions, see Introducing NHIN/esMD Process Definitions on
page 62.

SAML 2.0 assertions only support Secure Hash Algorithm 1 (SHA1) digest algorithm.
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WS-Addressing

Web Services Addressing (WS-Addressing) is a specification of transport-neutral
mechanism that specifies the endpoints of a SOAP message.

TIBCO BusinessConnect SOAP Protocol supports WS-Addressing partially in the SOAP
header. When TIBCO BusinessConnect SOAP Protocol processes the inbound messages
that contain the following seven properties, these properties are forwarded in the messages
sent to a private process.

Table 2 WS-Addressing

Field Type Description

MessagelD String The unique URI of the message.

To String Specifies the receiver URI of the message.

From N/A Specifies the endpoint of the service that dispatched the message.

ReplyTo N/A Specifies the endpoint of the receiver for reply messages.

FaultTo N/A Specifies the endpoint of the receiver for fault messages.

Action String The specific semantic operation of the message.

RelatesTo N/A A pair of values that specify the relationship between this message and
another message.

The original request MessageID must correspond with this property.

o If MessageID is not specified from the private process, or from any inbound request or
% response, all the properties are ignored.

* In the response message replied back to the initiator, the To property is set to the same
as the ReplyTo property of the original request message. However, if the private process
specifies the WS-Addressing To property for the response message, it is used to
override the ReplyTo property in the original request message.

*  The RelatesTo property of the response message replied to the initiator is set to the same
as the MessagelD property of the original request message.

Samples of the Messages by Using WS-Addressing

Here is a sample of a request message:
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<S:Envelope
xmlns:S="http://www.w3.0rg/2003/05/soap-envelope"
xmlns:wsa="http://www.w3.0rg/2005/08/addressing">
<S:Header>
<wsa:MessageID>http://example.com/someuniquestring</wsa:MessageI D>
<wsa:ReplyTo>
<wsa:Address>http://example.com/business/client] </wsa: Address>
</wsa:ReplyTo>
<wsa:To>mailto:fabrikam@example.com</wsa:To>
<wsa:Action>http://example.com/fabrikam/mail/Delete</wsa:Action>
</S:Header>
<S:Body>
<f:Delete xmlns:f="http://example.com/fabrikam">
<maxCount>42</maxCount>
</f:Delete>
</S:Body>
</S:Envelope>

WS-Addressing

Here is a sample of a response message:

<S:Envelope
xmlns:S="http://www.w3.0rg/2003/05/soap-envelope"
xmlns:wsa="http://www.w3.0rg/2005/08/addressing">
<S:Header>
<wsa:MessageID>http://example.com/someotheruniquestring</wsa:MessageID>
<wsa:RelatesTo>http://example.com/someuniquestring</wsa:RelatesTo>
<wsa:To>http://example.com/business/client]1</wsa:To>
<wsa:Action>http://example.com/fabrikam/mail/Delete Ack</wsa:Action>
</S:Header>
<S:Body>
<f:DeleteAck xmlns:f="http://example.com/fabrikam"/>
</S:Body>
</S:Envelope>

TIBCO BusinessConnect SOAP Protocol User’s Guide
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MTOM

TIBCO BusinessConnect SOAP Protocol supports MTOM standard for optimizing the
transmission of binary data in XML infoset.

The business document in a request or response might contain large binary data encoded
in base64. MTOM is a standard to optimize this type of data, because the base64 encoded
data might be much larger than the original binary data. Once this standard is applied, the
binary element in the XML infoset is externalized into a separate SOAP attachment.

In the current implementation, you can enable or disable MTOM feature in TIBCO
Administrator. You can configure each trading partner separately. Only the binary element
in the XML document specified in the body node of the request private process is processed
by using MTOM standard. You can provide a value in the xop > tagName > value field to
indicate which binary data element in the XML document to be processed by MTOM
standard.

For inbound messages, if optimized messages by MTOM are detected, the messages are
parsed and the original binary data extracted from the MTOM attachments will be
encoded in base64 and put back into the SOAP body, before the SOAP message is further
processed.

MTOM and attachments from a private process cannot be used together. So if the MTOM
is enabled for outbound message and in the meanwhile some attachments are also
specified from a private process request message, the request will be rejected and the
outbound process will not proceed.

MTOM can also be used together with content encryption. If the XML data is encrypted
for outbound message, the binary content referred to the value in the xop > tagName >
value field in the private process message is ignored. The encrypted data in the Ciphervalue
element after encryption is used to construct the MTOM attachment.

See Configuring General Properties for a Partner on page 100 on how to select SOAP
MTOM.
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TIBCO BusinessConnect SOAP Protocol supports SOAP fault in both versions 1.1 and
1.2. For inbound messages, when an exception or error occurs, TIBCO BusinessConnect
SOAP Protocol generates a SOAP fault in the same version as the incoming message, and
sends back the SOAP fault to the trading partner.

For TIBCO BusinessConnect SOAP Protocol, the TIBCO ActiveMatrix BusinessWorks
private process supports the SOAP fault only in version 1.2.

*  On BusinessConnect responder side, when an error occurs in the back office system, a
SOAP fault is sent back. The responder private process implemented by TIBCO
ActiveMatrix BusinessWorks only supports sending version 1.2 SOAP fault to the
responder BusinessConnect server, regardless of the SOAP version of the original
request message. If the original request message is a version 1.1 SOAP message, the
responder BusinessConnect server converts the version 1.2 SOAP fault into a version
1.1 SOAP fault and sends it back to the initiator. Because of the different fault
structure in versions 1.1 and 1.2, only the first one of the fault reasons in version 1.2 is
extracted and used in the version 1.1 SOAP fault.

¢ On BusinessConnect initiator side, if the initiator receives a SOAP version 1.1 fault
for whatever reason, BusinessConnect server converts this SOAP fault to version 1.2
before it is forwarded to the private process.

For TIBCO BusinessConnect SOAP Protocol, the TIBCO ActiveMatrix BusinessWorks
private process only supports SOAP fault in version 1.2 with BusinessConnect. If you
want to use SOAP fault in version 1.1, you must do the convertion yourself.

If you use TIBCO ActiveMatrix BusinessWorks to convert when you send a SOAP fault,
perform the following steps:

1. Populate the value in the soapFault > Code > Value field as your faultCode.

2. Populate the value in the soapFault > Reason > ReasonText > content field as your
faultString.

3. Populate the value in the soapFault > Role field as your faultActor.

After performing these steps, the SOAP fault you send from TIBCO ActiveMatrix
BusinessWorks private process to BusinessConnect is in version 1.2. BusinessConnect
automatically converts the SOAP fault back to version 1.1 before the SOAP fault is sent to
a trading partner if the trading partner wants the SOAP fault in version 1.1.
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Sample of a SOAPFault in Version 1.1

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/">
<SOAP-ENV:Body>

<SOAP-ENV:Fault>

<faultcode>SOAP-ENV:Server</faultcode>
<faultstring>Server Error</faultstring>

<faultactor>SOAPClient</faultactor>
<detail>

<ei:ErrorInfo xmlns:ei="http://www.tibco.com/
namespaces/bc/2002/04/errorinfo.xsd">
<code>922</code>

</ei:ErrorInfo>
</detail>
</SOAP-ENV:Fault>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>

<description>Actual error from schema validation</description>

Sample of a SOAPFault in Version 1.2

<env:Envelope xmlns:env="http://www.w3.0rg/2003/05/soap-envelope"
xmlns:m="http://www.example.org/timeouts"
xmlns:xml="http://www.w3.org/XML/1998/namespace">
<env:Body>
<env:Fault>
<env:Code>

<env:Value>env:Sender</env:Value>
<env:Subcode>

<env:Value>m:MessageTimeout</env:Value>
</env:Subcode>
</env:Code>
<env:Reason>
<env:Text xml:lang="en">Sender Timeout</env:Text>
</env:Reason>
<env:Detail>
<m:MaxTime>P5SM</m:MaxTime>
</env:Detail>
</env:Fault>
</env:Body>
</env:Envelope>
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This chapter guides you through the steps necessary for running a TIBCO
BusinessConnect SOAP Protocol business-to-business transaction.

The example in this chapter uses standalone private processes.

Topics

*  Overview, page 26

*  Prerequisites, page 29

*  Configuring the Initiator, page 30

*  Configuring the Responder, page 36

*  Running the Tutorial, page 41
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Overview

This chapter provides a short tutorial that demonstrates how to use an operation to send a
sample document from a trading host to a trading partner.

Operations

Two operations are defined in the sample interface file:

PONotify This operation is used only when the initiator requires an acknowledgment
from the responder to verify business document receipt.

POSync This is a synchronous request-response operation that is used when the
initiator and the responder do a more complex business exchange of business
documents.

Only the POSync operation is used in this tutorial.

Trading Partners

The trading host is known as the initiator. The trading partner is known as the responder.

This tutorial includes the sample initiator, responder and operation configuration files
along with the standalone initiator and responder private processes.

Two machines are used in the tutorial: an initiator machine and a responder machine. Each
machine hosts a private process and BusinessConnect.

Transactions

The POSync operation consists of the following message flows:

1.
2.

The initiator private process sends a message to the initiator BusinessConnect server.

The initiator BusinessConnect server sends the message to the responder
BusinessConnect server.

The responder BusinessConnect server sends the message to the responder private
process.

The responder private process sends a response to the responder BusinessConnect
server.

The responder BusinessConnect server sends a response to the initiator
BusinessConnect server.
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6. The responder BusinessConnect server sends an acknowledgement (ack) to the
responder private process.

7. The initiator BusinessConnect server sends a response to the initiator private process.

A detailed diagram of the POSync operation is displayed in Figure 3.

Figure 3 Request Response Operation POSync
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Initiator Machine

The following sample files for the initiator machine are used in the tutorial and are
available in the TIBCO HOME/vc/version_number/protocols/soap/samples/client directory.

*  SOAPClient.properties Contains information on the operation ID, trading partner, and
attachments.

*  runSOAPClient.bat OF runsoapclient Executes the initiator.

*  operations.csx Contains sample SOAP operations to be imported by the initiator.

Responder Machine

The following sample files for the responder machine are used in the tutorial and are
available in the TIBCO HOME/bvc/version _number/protocols/soap/samples/server directory.

e SOAPServer.properties Contains information on attachments.
*  runSOAPServer.bat OF runsoapserver Executes the responder.

e operations.csx Contains sample SOAP operations to be imported by the responder.
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Before starting this tutorial, perform the following prerequisites:

1.

Install the following software packages:
a. TIBCO BusinessConnect
b. TIBCO BusinessConnect SOAP Protocol

If you are unfamiliar with the SOAP standard, see Chapter 1, Introduction to SOAP
and TIBCO BusinessConnect SOAP Protocol, page 1.

See TIBCO BusinessConnect Interior Server Administration and TIBCO
BusinessConnect Trading Partner Administration for complete information on setting
up and running BusinessConnect.
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Configuring the Initiator

This section guides you through the activities you must perform to configure the initiator
trading host:

1.

2
3
4.
5

Importing Operations on the Initiator, page 30

Setting Up the Initiator Server, page 31

Setting Up the Initiator as a Trading Host, page 32
Setting Up the Responder as a Trading Partner, page 33

Configuring the Business Agreement between the Initiator and the Responder,
page 35

Importing Operations on the Initiator

To import the initiator operations that are used in the tutorial, perform the following steps:

1.

Log in to TIBCO Administrator.

2. Expand BusinessConnect > Operations Editor in the left panel.

3. Click Import.

4. Click change.

5. Click Browse and navigate to the
TIBCO_HOME/voc/version_number/protocols/soap/samples/client directory, and select the
operations.csx file.

If you want to use NHIN/esMD Authorization Framework with SAML assertions, import

% the caqh.csx file in the TIBCO_HOME/vc/version_numberiprotocols/soap/samples/cagh directory. This
file contains several sample operations that might help you understand how to use this
feature.

6. Click Open.

7. Click OK.

8. Type a password. This is optional.

9. Click Import.

The Edit Operations window is displayed with imported operations, as shown in
Figure 4.
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Figure 4 Imported Operations PONotify and POSync
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10. Click Done.

Setting Up the Initiator Server

You must set up the initiator server to communicate with its trading partners. To set up the
initiator, perform the following steps:

1. Create the deployment configuration.
See TIBCO BusinessConnect Interior Server Administration.

2. Setting Up the Initiator Server Transport.

Setting Up the Initiator Server Transport
To configure the BusinessConnect server, perform the following steps:

1. In TIBCO Administrator, expand BusinessConnect > System Settings in the left
panel.

Click Inbound Public Transport Types in the right panel.
Select the HTTP, HTTPS and HTTPSCA check boxes, and click Enable.
Click Done.

Click Gateway Services in the right panel.
Click New.

2

3

4

5. Expand BusinessConnect > Gateway in the left panel.

6

7

8. Type HTTP in the Name field, and select HTTP from the Type list.
9

Click OK.

10. In the General tab, select the Active check box.
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11. In the Credentials tab, Click New Private Key.
12. Type Host Key in the Alias field.
13. Click change link.

14. Click Browse and navigate to the following directory:
TIBCO_HOME/bc/version_number/samples/keys.

15. Select bepartnerl_key.p12 and click Open.

16. Click OK.

17. Click set next to Password.

18. Type Password1 in both the Enter password and Enter password again fields.
19. Click OK.

20. Click Save.

21. Click the Transport tab, select Host Key from the Private Key Credential for
Secure Ports list.

22. Click Save.

TIBCO BusinessConnect on the initiator side is configured with HTTP and HTTPS
transports.

Setting Up the Initiator as a Trading Host

On the initiator machine, set up the initiator as a trading host.
The trading host setup for the initiator consists of these steps:

1. Setting Up the Initiator Host, page 32

2. Setting Up the SOAP Protocol for the Initiator Host, page 33
See Setting Up the Responder as a Trading Partner on page 33.

Setting Up the Initiator Host

The trading host is typically defined when setting up TIBCO BusinessConnect.

If the host is set, go to Setting Up the SOAP Protocol for the Initiator Host on page 33. If
the host is not set, perform the following steps:

1. In TIBCO Administrator, expand BusinessConnect > Participants in the left panel.
2. Click New.

3. Type SOAPClient in the Name field.

4. Select Host from the Type list.
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5. Click OK.

6. Inthe New Host Participant window with the participant name SOAPClient, select the
Active check box.

7. Click Save.

8. Expand BusinessConnect > System Settings in the left panel.
9. Click General in the right panel.

10. Confirm that SOAPClient is selected in the Default Host list.

11. Click Save.

Setting Up the SOAP Protocol for the Initiator Host
To set up the SOAP protocol, perform the following steps:
1. Expand BusinessConnect > Participants in the left panel.
2. Click the SOAPClient link in the right panel.
3. Click the Protocols tab.
4. Verity that SOAP is listed in the Protocol Name list.
If SOAP is not displayed in the list of protocols:
a. Click Enable.
b. Select the SOAP check box.
c. Click OK.
d. Click Save.

Setting Up the Responder as a Trading Partner
The responder trading partner setup consists of these steps:
1. Setting Up the Responder Partner, page 33
2. Setting Up the SOAP Protocol for the Responder Partner, page 34

Setting Up the Responder Partner
To set up the responder partner, perform the following steps:
1. Expand BusinessConnect > Participants in the left panel.
2. Click New.

3. Type SOAPServer in the Name field.
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4. Select Partner from the Type list.
5. Click OK.

6. Inthe New Partner Participant window with SOAPServer in the Participant Name filed,
select the Active check box.

Setting Up the SOAP Protocol for the Responder Partner
To set up the SOAP protocol, perform the following steps:
1. In the Edit Partner Participant with SOAPServer window, click the Protocols tab.
Click Enable.
Select the SOAP check box.
Click OK.
Click the SOAP link.
Click the Transports tab.
Click Add.
In the New Transport window, type HTTP in the Name field.
Select HTTP from the Type list.
. Click OK.

A A A N T
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11. In the New HTTP Transport window, type information as shown in Table 3.

Table 3 New HTTP Transport

Transport Name Required. Type a name for this transport: HTTP.

URL Required. URL of the company: www.hostname:6700/dmz/SOAP.
Use HTTP Basic Authentication Clear the Use HTTP Basic Authentication check box.
Username No entry required for this tutorial.

Password No entry required for this tutorial.

Retry Count Leave the default value to 3.

Retry Interval Leave the default value to 6o.

Socket Timeout (seconds) Leave the default value to 300.
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12. Click Save three times.

Configuring the Business Agreement between the Initiator and the Responder

To configure the business agreements, perform the following steps:

I.
2.

W

o 0 =N ok

12.

13.

Expand BusinessConnect > Business Agreements in the left panel.
Click New in the right panel.

Click SOAPClient in the Host Party area and SOAPServer in the Partner Party
area.

Click OK.

In the Protocol Bindings area, click Add Protocol Binding.

In the Select Protocol window, select the SOAP check box.

Click OK.

Click the SOAP link that is displayed in the Agreement Protocol Binding list.

In the Operation Bindings tab, verify that the Allow All Operations check box is
selected. The host and trading partner can initiate all enabled operations.

. Click the Transports tab.
11.

In the Outbound Transports for Host 'SOAPClient' area, select HTTP from the
Primary Transport list.

In the Allowed Inbound Transports for Partner 'SOAPServer' area, ensure that the
HTTP check box is selected.

Click Save twice.

After performing these steps, the initiator configuration is completed.
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Configuring the Responder

This section guides you through the activities you must perform to configure the
responder trading partner:

1.

2
3
4.
5

Importing Operations on the Responder, page 36
Setting Up the Responder Server, page 37

Setting Up the Responder as a Trading Host, page 38
Setting Up the Initiator as a Trading Partner, page 39

Configuring the Business Agreements between the Initiator and the Responder,
page 40

Importing Operations on the Responder

To import the responder operations that are used in the tutorial, perform the following
steps:

1.

In TIBCO Administrator, expand BusinessConnect > Operations Editor in the left
panel.

2. Click Import.

3. Click change.

4. Click Browse and navigate to the
TIBCO_HOME/vc/version_numberiprotocols/soap/samples/server directory and select the
operations.csx file.

If you want to use NHIN/esMD Authorization Framework with SAML assertions, import

% the caqh.csx file in the TIBCO_HOME/vc/version_numberiprotocols/soap/samples/cagh directory. This
file contains several sample operations that might help you understand how to use this
feature.

5. Click Open.

6. Click OK.

7. Type a password. This is optional.

8. Click Import.

9. Click Done.
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Setting Up the Responder Server

You must set up the responder server to communicate with its trading partners. To set up
the responder, perform the following steps:

1.

2.

Create the deployment configuration.
See TIBCO BusinessConnect Interior Server Administration.

Setting Up the Responder Server Transport

Setting Up the Responder Server Transport

To configure the BusinessConnect server, perform the following steps:

1.

A S A T
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15.
16.
17.
18.
19.
20.

In TIBCO Administrator, expand BusinessConnect > System Settings in the left
panel.

Click Inbound Public Transport Types in the right panel.

Select the HTTP, HTTPS and HTTPSCA check boxes, and click Enable.
Click Done.

Expand BusinessConnect > Gateway in the left panel.

Click Gateway Services in the right panel.

Click New.

Type HTTP in the Name field, and select HTTP from the Type list.

Click OK.

. In the General tab, select the Active check box.
. In the Credentials tab, Click New Private Key.
. Type Partner Key in the Alias field.

. Click change link.

. Click Browse and navigate to the following directory:

TIBCO_HOME/vc/version_number/samples/keys.

Select bepartner2_key.p12 and click Open.

Click OK.

Click set next to Password.

Type Passwordl in both the Enter password and Enter password again fields.
Click OK.

Click Save.
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21. Click the Transport tab, select Partner Key from the Private Key Credential for

Secure Ports list.

22. Click Save.

TIBCO BusinessConnect on the responder side is configured with HTTP and HTTPS
transports.

Setting Up the Responder as a Trading Host

On the responder machine, set up the responder as a trading host.

The trading host setup for the responder consists of these steps:

1.

Setting Up the Responder Host, page 38

2. Setting Up the SOAP Protocol for the Responder Host, page 38

See Setting Up the Initiator as a Trading Partner on page 39.

Setting Up the Responder Host

The trading host name property is typically defined when setting up BusinessConnect.

If the property is set, go to Setting Up the SOAP Protocol for the Responder Host on
page 38. If the property is not set, perform the following steps.

1.

7.
8.
9.

2
3
4,
5
6

In TIBCO Administrator, expand BusinessConnect > Participants in the left panel.
Click New.

Type SOAPServer in the Name field.

Select Host from the Type list.

Click OK.

In the New Host Participant window with the participant name SOAPServer, select the
Active check box.

Click Save.
Expand BusinessConnect > System Settings in the left panel.

Click General in the right panel.

10. Confirm that SOAPServer is selected in the Default Host list.

11. Click Save.

Setting Up the SOAP Protocol for the Responder Host

To set up the SOAP protocol, perform the following steps:
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Expand BusinessConnect > Participants in the left panel.
Click the SOAPServer link in the right panel.

Click the Protocols tab.

Verify that SOAP is listed in the Protocol Name list.

If SOAP is not displayed in the list of protocols:

a. Click Enable.

b. Select the SOAP check box.

c. Click OK.

d. Click Save.

Setting Up the Initiator as a Trading Partner

The initiator trading partner setup consists of these steps:

I.
2.

Setting Up the Initiator Partner, page 39
Setting Up the SOAP Protocol for the Initiator Partner, page 39

Setting Up the Initiator Partner

To set up the initiator partner, perform the following steps:

1.

2
3
4.
5
6

Expand BusinessConnect > Participants in the left panel.
Click New.

Type SOAPClient in the Name field.

Select Partner from the Type list.

Click OK.

In the New Partner Participant window with SOAPClient in the Participant Name field,
select the Active check box.

Setting Up the SOAP Protocol for the Initiator Partner

To set up the SOAP protocol, perform the following steps:

1.

2
3.
4

In the Edit Partner Participant with SOAPClient window, click the Protocols tab.
Click Enable.

Select the SOAP check box.

Click OK.
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Click the SOAP link.

Click the Transports tab.

Click Add.

In the New Transport window, type HTTP in the Name field.
Select HTTP from the Type list.

10. Click OK.

o x® =2 @

11. In the New HTTP Transport window, type information as in Table 3.
12. Click Save three times.

Configuring the Business Agreements between the Initiator and the Responder
To configure the business agreements, perform the following steps:
1. Expand BusinessConnect > Business Agreements in the left panel.

2. Click New in the right panel.

(98]

Click SOAPServer in the Host Party area and SOAPClient in the Partner Party
area.

Click OK.

In the Protocol Bindings area, click Add Protocol Binding.

In the Select Protocol window, select the SOAP check box.

Click OK.

Click the SOAP link that is displayed in the Agreement Protocol Binding list.

o o =N ok

In the Operation Bindings tab, verify that the Allow All Operations check box is
selected. The host and trading partner can initiate all enabled operations.

10. Click the Transports tab.

11. In the Outbound Transports for Host 'SOAPServer' area, select HTTP from the
Primary Transport list.

12. In the Allowed Inbound Transports for Partner 'SOAPClient' area, ensure that the
HTTP check box is selected.

13. Click Save twice.

After performing these steps, the responder configuration is completed.
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Running the Tutorial

The following parts demonstrate how to run the standalone private processes on the
initiator and responder machines, and how to view the audit logs.

Running the Standalone Private Processes

To run the tutorial, perform the following steps:

1.
2.

Start the initiator and responder runtime servers.

Open the runSOAPServer.bat O runsoapserver file in the
TIBCO_HOME/bc/version_numberiprotocols/soap/samples/server directory on the responder
machine with a text editor and make the following changes:

— In the line SET BC_INSTANCE=%%BC_INSTANCE%%, replace %%BC_INSTANCE%% with
the name of your installation, such as BC-Responder.

— Inthe line SETJDK_DIR =%%JDK_DIR%%, replace %%JDK_DIR%% with JAVA_directory,
such as C:\tibco\tibcojre\1.7.0.

— In the line SET RV_DIR=%%RV_DIR%%, replace the value %%RV_DIR%% with the RV
library location, such as C:\tibco\tibrv\8.4.

A sample edited runSOAPServer.bat file looks as follows:

@ECHO OFF

SET BC_INSTANCE=BC-Responder
SET JDK_DIR=C:\tibco\tibcojre\1.7.0
SET RV_DIR=C:\tibco\tibrv\8.4

SET CLASSPATH=
AL\ \lib\common\configstore-core.jar;%RV_DIR%\lib\tibrvj.jar;%CLASSPATH%
%JDK_DIR%\bin\java SOAPServer SOAPServer.properties %BC_INSTANCE% body.xml header.xml

Start the responder private process on the responder machine, navigate to the
TIBCO_HOME]/ve/version_number/protocols/soap/samples/server directory and run the
following command on a command line:

— Windows runSOAPServer.bat
— UNIX /runsoapserver

The sample example is performed on a Microsoft Windows machine.
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Example: runSOAPServer.bat

C:\tibco\bc\6.2\protocols\soap\samples\server>runSOAPServer.bat
**%% SOAP Server Private Process ****%*
listening on: AX.BC.BC-Responder.SOAP.RESPONDER.REQUEST

4. Open the runSOAPClient.bat OT runsoapclient file in the
TIBCO_HOME/ociversion_number/protocols/soap/samples/client directory on the initiator
machine with a text editor and make the following changes:

— In the line SET BC_INSTANCE=%%BC_INSTANCE%%, replace %%BC_INSTANCE%% with
the name of your installation, such as BC-Initiator.

— Inthe line SETJDK_DIR =%%JDK_DIR%%, replace %%JDK_DIR%% with JAVA _directory,
such as C:\tibco\tibeojre\1.7.0.

— In the line SET RV_DIR=%%RV_DIR%%, replace the value %%RvV_DIR%% with the RV
library location, such as C:\tibco\tibrv\8.4.

A sample edited runSOAPClientbat file looks as follows:

@ECHO OFF

SET BC_INSTANCE=BC-Initiator
SET JDK_DIR=C:\tibco\tibcojre\1.7.0
SET RV_DIR=C:\tibco\tibrv\8.4

TITLE SOAP Client private process
SET CLASSPATH=

LA\ lib\common'\configstore-core.jar; %RV _DIR%\lib\tibrvlib.jar;%CLASSPATH%
%JDK_DIR%\bin\java SOAPClient SOAPClient.properties %BC_INSTANCE% body.xml header.xml

5. On the initiator machine, start the initiator private process, navigate to the
TIBCO_HOME]/ve/version_number/protocols/soap/samples/client directory and run the following
command on a command line:

— Windows runSOAPClient.bat
— UNIX /runsoapclient
In this example, the following operations are processed:

— The operation POSync containing a purchase order for five copies of a word
processing application is sent from the initiator to the responder.

— The responder confirms the receipt of that order.

— The responder sends an invoice to the initiator.
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The following text is displayed when SOAP Protocol 1.1 is selected:

Example: runSOAPCIlient.bat

**kx% SOAPClient Private Process ****%
listening on: AX.BC.BC-Initiator. SOAP.INITIATOR.RESPONSE

Hit [Enter] to send request:
Sending request...
publishing on subject: AX.BC.BC-Initiator.SOAP.INITIATOR.REQUEST
Sending request:
Trading partner: SOAPServer
Operation ID: POInterface/1.0/POSync
Header: <ep:endpoints xmlns:ep="http://user.org/header" >
<ep:to>
<ep:address>
<name>Book Orders</name>
<street>1st Street</street>
<city>New York</city>
<zip>1111</zip>
</ep:address>
</ep:to>
<ep:from>
<ep:address>
<name>Book Lovers</name>
<street>1st Street</street>
<city>Los Angeles</city>
<zip>90210</zip>
</ep:address>
</ep:from>
</ep:endpoints>
<prop:properties xmlns:prop = "http://user.org/header" >
<identity>uuid:74b9f5d0-33fb-4a81-b02b-5b760641c1d6</identity>
<sentAt>2000-05-14T03:00:00+08:00</sentAt>
<expiresAt>2000-05-15T04:00:00+08:00</expiresAt>
<topic>http://electrocommerce.org/purchase order/</topic>
</prop:properties>

Body: <cpo:CommonPO xmlns:cpo="http://po.org/body" >

<cpo:POHeader CreationDate="2000-06-23" Number="12345" Purpose="PO" Type="EZ" />

<cpo:BillTo/>

<cpo:ShipTo ContactName="BonifazLuis" ContactNumber="12345" ContactType ="CT"/>

<cpo:Item>
<cpo:ItemHeader ExtendedPrice="499.75" Price="99.95" Quantity="5" UnitOfMeasure="EA"/>
<cpo:ItemDescription Description="Word Processing Application" Type="F"/>

</cpo:Item>

<cpo:Total LineltemTotal="87" POTotal="544.15" QuantityTotal="34">12.34</cpo:Total>

<cpo:Description>VGhpcyBpcyBhIHB1cmNoYXNIIG9yZGVyIGRIc2NyaXB0aW9uLg==</cpo:Description>
</cpo:CommonPO>

Attachment : po.txt
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Attachment : image.gif

Hit [Enter] to send request:

Received message from BusinessConnect:
Status code: 200
Status message: OK
operation id: POlInterface/1.0/POSync
transaction id: besoap:DA75A27A-5BCA-401F-930E-1B7BFOEEB59D
response header: <ep:endpoints xmlns:ep="http://user.org/header">
<ep:to>
<ep:address>
<name>Book Orders</name>
<street>1st Street</street>
<city>New York</city>
<zip>1111</zip>
</ep:address>
</ep:to>
<ep:from>
<ep:address>
<name>Book Lovers</name>
<street>1st Street</street>
<city>Los Angeles</city>
<zip>90210</zip>
</ep:address>
</ep:from>
</ep:endpoints>
response: <ci:CommonInvoice xmlns:ci="http://ci.org/body">
<ci:InvoiceHeader Date="2000-05-16" Number="12345" PODate="2000-05-16" PONumber="12345" ShipDate="2000-05-16" Type=
EZ" />
<ci:Seller ContactName="BonifazLuis" ContactNumber="12345" ContactType="CT" />
<Buyer />
<ci:Item>
<ci:ItemHeader LineNumber="1" Price="99.95" Quantity="5" QuantityDiff="10" UnitOfMeasure="EA"/>
<ci:ItemTaxReference Amount="3.75" Description="VAT" />
<ci:ItemDescription Description="Word Processing Application" Type="F" />
</ci:Item>
<ci:InvoiceSummary Amount="544.15" />
<ci:Description>VGhpcyBpcyBhIGludm9pY2UgZGVzY3JpcHRpb24u</ci:Description>
</ci:CommonlInvoice>

On the Responder machine, the complete transaction is displayed as follows:

*xxk SOAP Server Private Process *****
listening on: AX.BC.BC-Responder.SOAP.RESPONDER.REQUEST

Request header:
<ep:endpoints xmlIns:ep="http://user.org/header">
<ep:to>
<ep:address>
<name>Book Orders</name>
<street>1st Street</street>
<city>New York</city>
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<zip>1111</zip>
</ep:address>
</ep:to>
<ep:from>
<ep:address>
<name>Book Lovers</name>
<street>1st Street</street>
<city>Los Angeles</city>
<zip>90210</zip>
</ep:address>
</ep:from>
</ep:endpoints>
<prop:properties xmlns:prop="http://user.org/header">
<identity>uuid:74b9f5d0-33fb-4a81-b02b-5b760641c1d6</identity>
<sentAt>2000-05-14T03:00:00+08:00</sentAt>
<expiresAt>2000-05-15T04:00:00+08:00</expiresAt>
<topic>http://electrocommerce.org/purchase order/</topic>
</prop:properties>

request body:
<cpo:CommonPO xmlns:cpo="http://po.org/body">
<cpo:POHeader CreationDate="2000-06-23" Number="12345" Purpose="PO" Type="EZ"/>
<cpo:BillTo/>
<cpo:ShipTo ContactName="BonifazLuis" ContactNumber="12345" ContactType="CT"/>
<cpo:Item>
<cpo:ItemHeader ExtendedPrice="499.75" Price="99.95" Quantity="5" UnitOfMeasure="EA"/>
<cpo:ItemDescription Description="Word Processing Application" Type="F"/>
</cpo:Item>
<cpo:Total LineltemTotal="87" POTotal="544.15" QuantityTotal="34">12.34</cpo:Total>
<cpo:Description>VGhpcyBpcyBhIHB1cmNoYXNIIG9yZGVyIGRIc2NyaXB0aW9uLg==</cpo:Description>
</cpo:CommonPO>
operation ID: POlInterface/1.0/POSync
closure:9F3E47B8-54CE-42D7-B3F0-E85CF7B1C363
Attachment saved to file po.txt
Attachment saved to file image.gif
Hit [Enter] to send response:
Sending response...
publishing on subject: AX.BC.BC-Responder.SOAP.RESPONDER.RESPONSE
response header:  <ep:endpoints xmlns:ep="http://user.org/header">
<ep:to>
<ep:address>
<name>Book Orders</name>
<street>1st Street</street>
<city>New York</city>
<zip>1111</zip>
</ep:address>
</ep:to>
<ep:from>
<ep:address>
<name>Book Lovers</name>
<street>1st Street</street>
<city>Los Angeles</city>
<zip>90210</zip>
</ep:address>
</ep:from>
</ep:endpoints>
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response: <ci:CommonlInvoice xmlns:ci="http://ci.org/body">
<ci:InvoiceHeader Date="2000-05-16" Number="12345" PODate="2000-05-16" PONumber="12345" Type="EZ"
ShipDate="2000-05-16"/>
<ci:Seller ContactType="CT" ContactName="BonifazLuis" ContactNumber="12345"/>
<Buyer/>
<ci:Item>
<ci:ItemHeader LineNumber="1" Quantity="5" Price="99.95" UnitOfMeasure="EA" QuantityDiff="10"/>
<ci:ItemTaxReference Description="VAT" Amount="3.75"/>
<ci:ItemDescription Type="F" Description="Word Processing Application"/>
</ci:Item>
<ci:InvoiceSummary Amount="544.15"/>
<ci:Description>VGhpcyBpcyBhlGludm9pY2UgZGVzY3JpcHRpb24u</ci:Description>
</ci:CommonlInvoice>

Changing the Message Type

To change the message type that is sent from the initiator to the responder by using the
command-line interface, perform the following steps:

1. Using a text editor, open the SOAPClient.properties file in the
TIBCO_HOME]/ve/version_number/protocols/soap/samples/client directory.

The content of the SOAPClient.properties file looks as follows:

#

# SOAP Client Private process property file.

#

#client.operationID: POInterface/1.0/PONotify
client.operationID: POlnterface/1.0/POSync

client.tradingPartnerID:SOAPServer
client.encoding:ISO8859 1
#client.transactionID:uuid: 1234567917

attachment1.name:po.txt
attachment]1.contentID:<process- 1 @xyz.com>
attachment1.contentType:text/plain

attachment2.name:image.gif
attachment2.contentID:<process-2@xyz.com>
attachment2.contentType:binary

2. Comment out one of the two following lines:
#client.operationID: POlInterface/1.0/PONotify

or

#client.operationID: POlInterface/1.0/POSync

3. The operation that is not commented out is executed: PONotify or POSync.
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Viewing the Audit Logs

To view the audit logs on the initiator or responder machines, perform the following steps:

1. Login to TIBCO Administrator, expand Business Connect > Log Viewer in the left
panel.

2. Click the SOAP link in the right panel.

3. Select items from the following lists: Status, Connection, and Date Range.

4. Click Search.

See TIBCO BusinessConnect Trading Partner Administration for information on
searching the logs.
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TIBCO ActiveMatrix BusinessWorks Private
Processes Tutorial

This chapter gives an overview of how to use TIBCO ActiveMatrix BusinessWorks with
TIBCO BusinessConnect SOAP Protocol.

*  Overview, page 50

« Setting Up the Tutorial, page 53

*  Configuring TIBCO ActiveMatrix BusinessWorks Private Processes, page 54
» Introduction of Process Definitions, page 58

*  Running the Tutorial, page 65
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Overview

You can use TIBCO BusinessConnect SOAP Protocol to exchange data with a TIBCO
ActiveMatrix BusinessWorks installation that is acting as a private process and the
interface to enterprise back office systems.

Two operations are defined in the sample interface file:

* poNotify This operation is used only when the initiator requires an acknowledgment
from the responder to verify business document receipt.

e poSync This is a synchronous request-response operation that is used when the
initiator and the responder do a more complex business exchange of business
documents.

Only the PONotify operation is used in this tutorial.

You must have the TIBCO BusinessConnect palette working as a plug-in of TIBCO
ActiveMatrix BusinessWorks to communicate with TIBCO BusinessConnect.

You must install TIBCO BusinessConnect Palette or TIBCO ActiveMatrix Business Works
Plug-in for BusinessConnect after installing TIBCO BusinessConnect, so the
BusinessConnect palette is installed with TIBCO ActiveMatrix BusinessWorks.

TIBCO BusinessConnect palette consists of several activities, which work in TIBCO
ActiveMatrix BusinessWorks processes for sending and receiving messages from TIBCO
BusinessConnect. By using TIBCO BusinessConnect palette, you can also connect to
TIBCO BusinessConnect configuration store to import the configurations of SOAP
operations, which is useful in the interactions with TIBCO BusinessConnect SOAP
Protocol.

TIBCO Designer and TIBCO Business Studio are the design time tools of TIBCO
ActiveMatrix BusinessWorks processes. You can use TIBCO Designer or TIBCO
Business Studio to design TIBCO ActiveMatrix BusinessWorks processes and interact
with TIBCO BusinessConnect SOAP Protocol.

See TIBCO BusinessConnect Palette User's Guide or TIBCO ActiveMatrix Business Works
Plug-in for BusinessConnect User s Guide.

The TIBCO ActiveMatrix BusinessWorks Project Tutorial

The TIBCO ActiveMatrix BusinessWorks project tutorial is included in the TIBCO
BusinessConnect SOAP Protocol installation in the
TIBCO _HOME/be/version_number/protocols/soap/samples/bepalette directory.

Two files are in this directory:

e bcpalette.zip This file is used with TIBCO ActiveMatrix BusinessWorks 5.
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e bcpalette_for_bw®6.zip This file is used with TIBCO ActiveMatrix BusinessWorks 6.

The tutorial demonstrates the use of TIBCO ActiveMatrix BusinessWorks to interact with
TIBCO BusinessConnect SOAP Protocol. Knowledge of TIBCO ActiveMatrix
BusinessWorks, TIBCO BusinessConnect SOAP Protocol, and business-to-business is a
prerequisite to run this tutorial.

These simple samples have been designed to illustrate the TIBCO BusinessConnect
activities available in TIBCO ActiveMatrix BusinessWorks. In a real-life scenario, the
requesting TIBCO ActiveMatrix BusinessWorks engine would perform a lot of processing
to generate a request. Likewise, the receiving TIBCO ActiveMatrix BusinessWorks
engine would also perform a lot of processing and transformation from the request
received from TIBCO BusinessConnect server to integrate with the backend systems.

To use TIBCO ActiveMatrix BusinessWorks as a private process, it must connect to
TIBCO BusinessConnect configuration store to retrieve SOAP operation configurations.

The PONotify operation consists of the following message flows:

1. The initiator private process sends a private process message to the initiator
BusinessConnect server.

2. The initiator BusinessConnect server sends a request SOAP message to the responder
BusinessConnect server.

3. The responder BusinessConnect server sends the request private process message to
the responder private process.

4. After the message is received, the responder BusinessConnect server sends an
acknowledgement (ack) back to the initiator BusinessConnect server.

A detailed diagram of the PONotify operation is displayed in Figure 5.
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Figure 5 Notify Message

TIBCO ActiveMatrix
BusinessWorks

Send 4@

Private Process Qutbound Request

Company A

b=

TIBCO
BusinessConnect

TIBCO BusinessConnect SOAP Protocol User’s Guide

Notification SOAP Pratocol
$2
kA;j i
Legend
—» Notification . Tl
BusinessConnect
= ACK SOAP Protocol

Company B

TIBCO ActiveMatrix
Business\Works

Receive Notification

Private Process Inbound Request




Setting Up the Tutorial | 53

Setting Up the Tutorial

% Before you proceed, ensure that you have completed the tutorial in Chapter 3.

Prerequisites
To run this tutorial you must perform the following prerequisites:
*  Make sure that you have satisfied all prerequisites listed in Prerequisites on page 29.
* Install TIBCO ActiveMatrix Business Works.

e Install TIBCO BusinessConnect Palette or TIBCO ActiveMatrix BusinessWorks
Plug-in for BusinessConnect, so the BusinessConnect palette is installed with TIBCO
ActiveMatrix BusinessWorks.

Configuring the Machines

The configuration of the machines is the same as described in the standalone private
processes tutorial. If you have not configured the initiator and responder machines yet, see
the following sections:

*  Configuring the Initiator, page 30
*  Configuring the Responder, page 36

Once both machines are configured, proceed with Configuring TIBCO ActiveMatrix
BusinessWorks Private Processes on page 54.
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Configuring TIBCO ActiveMatrix BusinessWorks Private Processes

TIBCO BusinessConnect SOAP Protocol contains an example TIBCO ActiveMatrix
BusinessWorks project, which sends a transaction to BusinessConnect.

This section describes how to configure private processes in the following ways:

Configuring Private Processes in TIBCO Designer, page 54

Configuring Private Processes in TIBCO Business Studio, page 56

Configuring Private Processes in TIBCO Designer

To configure the tutorial in TIBCO Designer, perform the following steps:

Task A Opening the TIBCO ActiveMatrix BusinessWorks Project

To open the TIBCO ActiveMatrix BusinessWorks project in TIBCO Designer, perform
the following steps:

1.

2
3
4.
5
6

~

10.

11.
12.

Start TIBCO Designer.

Click New empty project.

In the Save Project window, click Cancel.

Click Project > Import Full Project.

Click the ZIP Archive tab in the Import Project dialog.

Click [#] and navigate to the
TIBCO_HOME/vc/version_number/protocols/soap/samples/bepalette directory.

Select the bepalette zip file and click Open. Click OK.
In the Options tab, select Try rename in case of name conflict. Click Apply.
Click Project > Save As.

In the Project Directory ficld, navigate to a folder where you want to save the sample
project.

Select UTF-8 from the TIBCO Messaging Encoding list.
Select None from the Multi-User System list. Click OK.

Task B Configuring Connections to TIBCO BusinessConnect

To configure connections to TIBCO BusinessConnect, perform the following steps:

1.

Click the Global Variables tab.
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Verify that the BC_HOME variable is set to TIBCO _HOME\vc\version_number.
Click the Project tab.

Expand the Connections folder and click BCServer Connection.

Click the BusinessConnect Server Access tab in the right panel.

a. Select the JDBC driver you use to communicate with the BusinessConnect
configuration store from the JDBC Driver Type list.

b. Type the URL for the configuration store in the JDBC URL field.

c. Type the configuration store values in the DB User and DB Password fields.
d. Click Apply.

Click the Configuration tab.

If the Update Transport Settings check box is not selected, select it.

Click Update from Configuration Store.

Select SOAP from the Protocol Name list.

10. Click Import Selected Business Protocol.

The operations previously imported to configuration store are displayed, as shown in
Figure 6.

This connection setup must be done on the initiator and the responder sides separately.
The JDBC connection parameters for the TIBCO BusinessConnect configuration store on
the initiator and the responder sides are different.

Figure 6 Imported Operations for SOAP
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When you import TIBCO BusinessConnect SOAP Protocol, TIBCO Designer
retrieves the schema information for the business documents associated with the
SOAP operations. The schema information has been imported to TIBCO
BusinessConnect configuration store previously. By retrieving the schemas of the
business documents to TIBCO Designer, you can use the TIBCO ActiveMatrix
BusinessWorks processes to construct the business document to be sent as a request,
or validate and parse the received business document.

The retrieved schemas are in the BCSchemas project folder. If you expand this folder,
you can see the CommonPO and CommonInvoice Schemas in
BCSchemas > SOAP > POlInterface > 1.0 > PONotify and POSync.

11. Click Apply.
12. Click the Save E icon to save the project.

Configuring Private Processes in TIBCO Business Studio

To configure the tutorial in TIBCO Business Studio, perform the following steps:

Task A Opening the TIBCO ActiveMatrix BusinessWorks Project

To open the TIBCO ActiveMatrix BusinessWorks project in TIBCO Business Studio,
perform the following steps:

1. Start TIBCO Business Studio.
2. Click File > Import.

3. On the Import page, expand the General folder and select Existing Studio Projects
into Workspace. Click Next.

4. Click Browse next to the Select archive file field to navigate to the
TIBCO_HOMEj/ve/version_number/protocols/soap/samples/bepalette directory, and select the
bepalette_for_bwé.zip file. Click Open.

5. Click Finish.

After importing the sample, perform the following steps:

1. Expand bepalette > Module Descriptors in the Project Explorer view.

2. Double-click Module Properties.

3. Change the default value of the BC_HOME property according to your environment.

Task B Configuring Connections to TIBCO BusinessConnect

To configure connections to TIBCO BusinessConnect, perform the following steps:
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In the Project Explorer view, expand Resources > bepalette, and double-click
BCConnection.bcResource.

Click the Server Access tab.

Type information as explained in step 5.

Click the Configuration tab, and click Update from Configuration Store.
Select SOAP from the Protocol Name list.

If you select the Select Operations check box, you can select any of the configured
and imported operations. For this tutorial, select all operations and click OK.

Click Import Selected Business Protocol.

When you import the protocol, TIBCO ActiveMatrix BusinessWorks retrieves
information from the TIBCO BusinessConnect configuration store and puts them in
the project folder.

Click Save.

This connection setup must be done on the initiator and the responder sides separately.
The JDBC connection parameters for the TIBCO BusinessConnect configuration store on
the initiator and the responder sides are different.
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Introduction of Process Definitions

S

After you have opened the TIBCO ActiveMatrix BusinessWorks project, and configured
connections to TIBCO BusinessConnect, you can access the initiator and responder
process definitions:

* Introducing Initiator Process Definitions, page 58
* Introducing Responder Process Definitions, page 60

You can also access the NHIN/esMD process definitions: Introducing NHIN/esMD
Process Definitions, page 62.

Process names are different in TIBCO Designer and TIBCO Business Studio. For
example, the Send Notify process in TIBCO Designer equals the SendNotify process in TIBCO
Business Studio. The following description takes processes in TIBCO Designer as an
example.

Introducing Initiator Process Definitions

Send Notify

In TIBCO Designer, you can access the initiator process definitions by clicking the
Project tab, and then expanding the Initiator folder. The following processes are
available:

+ Send Notify
* Send Request and Receive Response

Only the Send Notify operation is used in this tutorial.

This process uses the TIBCO ActiveMatrix BusinessWorks Read File activity to read the
notify document stored in the samples directory. This process uses the Parse XML activity
to parse the content into an XML tree and pass the tree to the Send Request/Notification
activity.

This process includes a subprocess, the password process. This process converts the clear
text password to base64 encoded data. This is used for sending the user name and
password information to TIBCO BusinessConnect, so you can send a SOAP message with
WSS UsernameToken.

The Send Request/Notification activity creates a notify message and sends it to the
initiator BusinessConnect server, as shown in Figure 7.
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Figure 7 Send Notify
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The initiator BusinessConnect server validates the notification message, and converts it
into a well-formed SOAP document. The initiator BusinessConnect server transmits the
SOAP document to the responder BusinessConnect server, which sends the message to the
responder private process.

Send Request and Receive Response

This process uses the Read File activity to read the request document stored in the samples
directory. The process uses the Parse XML activity to parse the content into an XML tree
and pass the tree to the Send Request/Notification activity.

This process includes a subprocess, the password process. This process converts the clear
text password to base64 encoded data.

The Send Request/Notification activity creates a request message and sends it
synchronously to the initiator BusinessConnect server. The activity waits for the response
from the trading partner, as shown in Figure 8.

Figure 8 Send Request and Receive Response
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When the response document arrives, the initiator BusinessConnect server validates the
response document for syntactical correctness and sends it to the TIBCO ActiveMatrix
BusinessWorks private process.
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The document is received by the Send Request/Notification activity, which is waiting for
the response.

Receive Response

The response from the trading partner could be a SOAP message with a business
document or a SOAP fault. If the trading partner response is a SOAP fault,
BusinessConnect server sends this fault message to the TIBCO ActiveMatrix
BusinessWorks private process. The Send Request/Notification activity parses the fault
message. The fault message fields can be retrieved from this activity.

Introducing Responder Process Definitions

In TIBCO Designer, you can access the responder process definitions by clicking the
Project tab, and then expanding the Responder folder. The following processes are
available:

* Receive Notification Message
* Receive Request and Send Fault
* Receive Request and Send Response

Only the Receive Notification Message operation is used in this tutorial.

Receive Notification Message

This process shows how a TIBCO ActiveMatrix BusinessWorks private process receives a
SOAP notify message initiated by a trading partner. The process uses the Receive
Request/Notification activity.

The Receive Request/Notification activity is configured to wait for a request from
BusinessConnect server, as shown in Figure 9.

Figure 9 Receive Notification Message
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When the responder BusinessConnect server receives a SOAP document from a trading
partner, it validates the SOAP message. After that, the message is sent to a TIBCO
ActiveMatrix BusinessWorks private process for processing.
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Receive Request and Send Fault

This process shows how TIBCO ActiveMatrix BusinessWorks can act as a responder by
receiving a SOAP message initiated by a trading partner and sending back a response. If
the received SOAP message is rejected by default, and a SOAP fault is generated and sent
back to the trading partner.

The process uses the Receive Request/Notification and Send Response activities to
process, as shown in Figure 10.

Figure 10 Receive Request and Send Fault
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When the responder BusinessConnect server receives a SOAP document from a trading
partner, it validates the SOAP message. After that, the message is sent to a TIBCO
ActiveMatrix BusinessWorks private process for processing. In this process, the Send
Response activity sends a fault message to the trading partner.

Receive Request and Send Response

This process shows how TIBCO ActiveMatrix BusinessWorks can act as a responder by
receiving a SOAP message initiated by a trading partner and sending a response to the
trading partner.

The process uses the Receive Request/Notification, Read File, and Send Response
activities to process, read, and respond to the request message. This process includes a
subprocess, the password process. This process converts the clear text password to base64
encoded data. This is used for sending the user name and password information to TIBCO
BusinessConnect, so you can send a SOAP message with WSS UsernameToken.

See Figure 11.
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Figure 11 Receive Request and Send Response
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When the responder BusinessConnect server receives a SOAP document from a trading
partner, it validates the SOAP message. After that, the message is sent to a TIBCO
ActiveMatrix BusinessWorks private process for processing. In this process, the Send
Response activity sends a SOAP message back to the trading partner.

Introducing NHIN/esMD Process Definitions

In TIBCO Designer, you can access the NHIN/esMD process definitions by clicking the
Project tab, and then expand the NHIN/esMD folder. This folder contains two subfolders:
the Initiator and Responder folders.

* The following processes are available in the Initiator folder:
— CAQH Send Batch Request
— CAQH Send RealTime Request

* The following processes are available in the Responder folder:
— CAQH Receive Batch Request Send Response
— CAQH Receive RealTime Request Send Response

These processes are samples of how to use the NHIN/esMD SAML feature for initiators
and responders. You do not have to implement your private process exactly the same way
as these samples do, but you might learn detailed information, such as the AttributeStatement
element, the AuthzDecisionStatement element, and so on. You can also learn how to handle
these elements on the responder side, and how to prepare these elements on the initiator
side.
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In TIBCO ActiveMatrix BusinessWorks private process, the CAQH Send RealTime
Request process and the CAQH Receive RealTime Request Send Response processes
constitute a synchronous request-response transaction for RealTime scenario. The CAQH
Send Batch Request process and the CAQH Receive Batch Request Send Response
constitute a synchronous request-response transaction for Batch Submission scenario.
These transactions are implemented with WS-Addressing to convey routing information..

% The NHIN/esMD process definitions are not used in this tutorial.

Before you run this NHIN/esMD Process sample, you must enable Require Digital
Signature and NHIN/esMD Authorization Framework in the Request Action tab and
you must enable NHIN/esMD Authorization Framework in the Response Action tab for
SOAP sample operation CAQH/2.2.0/RealTimeTransaction and
CAQH?/2.2.0/BatchSubmitTransaction.

CAQH Batch/Real time Transactions

Below are the CAQH operations available at CORERule2.2.0.xsd and CORERule
4.0.0.xsd:

CORE Rule 2.2.0

» Batch Results Acknowledgement Transaction (Operation name is
CAQH/2.2.0/BatchResultsAckSubmit Transaction)

» Batch Results Retrieval Transaction (Operation name is
CAQH/2.2.0/BatchResultsRetrieval Transaction)

*  Batch Submit Acknowledgement Retrieval Transaction (Operation name is
CAQH/2.2.0/BatchSubmitAckRetrieval Transaction)

»  Batch Submit Transaction (Operation name is CAQH/2.2.0/BatchSubmit Transaction)

*  Generic Batch Receipt Confirmation Transaction (Operation name is
CAQH/2.2.0/GenericBatchReceiptConfirmationTransaction)

*  Generic Batch Retrieval Transaction (Operation name is
CAQH/2.2.0/GenericBatchRetrieval Transaction)

*  Generic Batch Submission Acknowledgement Retrieval Transaction (Operation name
is CAQH/2.2.0/GenericBatchSubmissionAckRetrieval Transaction)

*  Generic Batch Submission Transaction (Operation name is
CAQH/2.2.0/GenericBatchSubmissionTransaction)

* Real Time Transaction (Opration name is CAQH/2.2.0/RealTimeTransaction)
CORE Rule 4.0.0

» Batch Results Acknowledgement Transaction (Operation name is
CAQH/4.0.0/BatchResultsAckSubmitTransaction)
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» Batch Results Retrieval Transaction (Operation name is
CAQH/4.0.0/BatchresultsRetrieval Transaction)

*  Batch Submit Acknowledgement Retrieval Transaction (Operation name is
CAQH/4.0.0/BatchSubmitAckRetrieval Transaction)

*  Batch Submit Transaction (Operation name is CAQH/4.0.0/BatchSubmitTransaction)

*  Generic Batch Receipt Confirmation Transaction (Operation name is
CAQH/4.0.0/GenericBatchReceiptConfirmationTransaction)

*  Generic Batch Retrieval Transaction (Operation name is
CAQH/4.0.0/GenericBatchRetrieval Transaction)

*  Generic Batch Submission Acknowledgement Retrieval Transaction (Operation name
is CAQH/4.0.0/GenericBatchSubmissionAckretrieval Transaction)

*  Generic batch Submission Transaction (Operation name is
CAQH/4.0.0/GenericBatchSubmissionTransaction)

* Real Time Transaction (Operation name is CAQH/4.0.0/RealTimeTransaction)
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Running the Tutorial

The steps of how to load and run private processes in TIBCO Business Studio are similar
% to TIBCO Designer. See TIBCO ActiveMatrix BusinessWorks Documentation for more
details.

To run this tutorial, perform the following steps:

1.

Set up the TIBCO BusinessConnect SOAP Protocol trading partners on the initiator
and responder machines as described in Configuring the Initiator on page 30 and
Configuring the Responder on page 36.

Send the transaction.
See Running the TIBCO ActiveMatrix BusinessWorks Processes on page 65.
Check the results of sending the transaction.

See Viewing the Audit Logs on page 67.

Running the TIBCO ActiveMatrix BusinessWorks Processes

Run TIBCO ActiveMatrix BusinessWorks processes on the responder and initiator
machines.

Task A Running Process on the Responder Machine

To run the TIBCO ActiveMatrix BusinessWorks process, perform the following steps:

1.

2
3.
4

In the opened TIBCO Designer project, click the Tester tab.

Click [ ).

Select Responder > Receive Notification message.

Click Load Selected.

Task B Running Process on the Initiator Machine

To run the TIBCO ActiveMatrix BusinessWorks process, perform the following steps:

1.

In the opened TIBCO Designer project, expand the Initiator folder in the Project tab,
and click the Send Notify process.

Click the SendRequest activity, and then click the Input tab to verify the name of the
trading partner, as shown in Figure 12.
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Figure 12 Verifying the Name of the Trading Partner
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3. Make sure that you have the correct tpName for the SendRequest activity. Change the
name if needed, and click Apply.

Click the Tester tab.

Click [&].

Select Initiator > Send Notify.
Click Load Selected.

® N

In the Jobs folder, select Initiator/Send Notify.process and right-click Create a Job.

The operation is tested and verified, as shown in Figure 13.

TIBCO BusinessConnect SOAP Protocol User’s Guide




Running the Tutorial | 67

Figure 13 Send Notify Process
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The password subprocess is for generating a base64 encoded password that is used for

% generating a UsernameToken element in the outbound SOAP request message. In this
tutorial, this feature is not used, because the Require UsernameToken Authentication
check box is not selected for the request action in the configuration store.

Expected Results

After a couple of seconds, if the request has been validated and processed correctly by the
responder BusinessConnect server and responder private process, the line turns green on
the responder machine. When processing is ended, the initiator receives an
acknowledgment from the responder to verify the receipt of the SOAP message.

If something fails at the responder machine, it is likely that nothing is returned from the
responder, and the Send Request activity times out.

Viewing the Audit Logs
To view the audit logs on the initiator or responder machine, perform the following steps:

1. Log in to TIBCO Administrator, expand Business Connect > Log Viewer in the left
panel.

2. Click the SOAP link in the right panel.
3. Select items from the following lists: Status, Connection, and Date Range.
4. Click Search.

See TIBCO BusinessConnect Trading Partner Administration for information on
searching the logs.
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Preparing Information with Your Trading
Partners

This chapter gives an overview of the basic steps you and your trading partners must take
to begin working together with TIBCO BusinessConnect SOAP Protocol.

* Reaching Agreement on Shared Business Documents, page 70
*  Exchanging URI Definitions, page 71

*  Exchanging Identity Information, page 72
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Reaching Agreement on Shared Business Documents

Before trading partners can do business, they must agree on the structure and content of
each XML business document that they plan to exchange over the Internet. To do this,
trading partners must create XSDs that define the contents and structure of their associated
XML business documents.

Trading partners can exchange an XSD file by email, the web, or any other method. This
is like two people trading dictionaries before they communicate in different languages.

You can use any third-party tools to create and validate XSDs.
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Exchanging URI Definitions

Partners must exchange Uniform Resource Identifiers (URIs) as part of the business
agreement before they can transact electronic business. Trading partners can trade URI
definitions by email, the web or any other method. The URI is part of the trading partner
URL.

See Configuring Transports for a Partner on page 103 for instructions on how to type the
URI when setting up your trading partner.

The following is a list of the available transport protocols and their URI formats. If you
want to use TIBCO BusinessConnect SOAP Protocol as the business-to-business gateway,
you must give the URIs in these formats to your trading partners, so the trading partners
can connect to these URIs to exchange SOAP messages with TIBCO BusinessConnect
SOAP Protocol.

e HTTP URI format: nttp://iserverport/dmz/SOAP

* HTTPS URI format: nttps:/server:port/dmz/SOAP
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Exchanging Identity Information

Trading partners must exchange information that they can use to identify the other partner
when conducting electronic business. Trading partners can exchange identity information
by email, the web, or any other method.

The identity information that you must share with a trading partner includes the following:

* Trading partner name Trading partner name is one of the ways how trading partners
identify themselves from each other. See the sections on setting up trading partners for
information on how to specify your partner company name.

— Setting Up the Responder Partner on page 33
— Setting Up the Initiator Partner on page 39

* Domain identifiers Domain and identifies are another way for trading partners to
identify themselves from each other. This is typically when both sides of the trading
partners are using TIBCO BusinessConnect SOAP Protocol for implementations.

See the sections on setting up trading partners for information on where you add the
domain and identifier of your partner:

— Adding a Domain Identity for a Partner on page 102

* Public certificates Trading partners must exchange their public certificates for
encryption and authentication. Your trading partner public certificate is used to
encrypt outgoing messages and authenticate incoming messages signed by your
trading partner.

See TIBCO BusinessConnect Concepts for information on security and certificates
files in general, and 7/BCO BusinessConnect Trading Partner Administration for
instructions on how to set security credentials.
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Chapter6  Managing SOAP Operations

This chapter explains how to manage interfaces, versions, and operations.

Topics

*  Overview, page 74

* Creating a SOAP Interface, page 76

* Adding a Version to an Interface, page 78
* Adding an Operation to a Version, page 79
*  SOAP Operation Properties, page 80

* Importing SOAP Interfaces, page 90

* Exporting SOAP Interfaces, page 91

*  Modifying SOAP Operations, page 92
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Overview

SOAP Interfaces

SOAP Operations

TIBCO BusinessConnect SOAP Protocol uses interfaces, versions, and operations to
categorize and define actions in an electronic business transaction.

An interface is a category of operations, for example, Manage Purchase Order. This
category includes a group of related operations, such as the following operations:

e Create Purchase Order
*  Change Purchase Order
e Cancel Purchase Order

Each interface has a version number. Administrator can preserve older versions of
interfaces when creating newer ones. Each interface contains some specific operations.

For example, a Manage Purchase Order interface could have the following definition:

The purpose of the interface is to specify the purchase order management process between trading partners. The
management process includes the creation, change, and cancellation Business Document. All purchase order
acknowledgments of acceptance are "substantive acceptance”. A substantive acceptance returns some part of the original
business document without modifications.

Each operation defines an action. For example, the definition of a Create Purchase Order
operation might include the following:

*  The operation description and transaction type. Transaction type might be notify or
synchronous request-response.

» The transaction type request parameters, such as the schemas for header and body
element validation, and signing and encryption options for incoming and outgoing
requests.

*  The operation response parameters, such as the schemas for header and body element
validation, signing and encryption options for outgoing and incoming response.

Each installation can be the initiator for certain interfaces. At the same time, the responder
can also be the initiator for the same or other interfaces.

Interfaces are defined in terms of their input and output, with no inherent initiator or
responder. Trading partners can exchange interfaces by exporting or importing them.

After interfaces and operations have been set up, they must be associated with protocol
bindings.
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For step-by-step instructions, see Configuring SOAP Agreement Protocol Binding on
page 106.
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Creating a SOAP Interface

Before you can create versions and operations, you must create or import a SOAP
interface.

1. In TIBCO Administrator, expand BusinessConnect > Operations Editor.
In the Operations Editor window, group the available installed protocols by Plug-in or

None, as shown in Figure 14.

Figure 14 Configuring New Operation for SOAP

BusinessConnect > Operations Editor
Group by Flug-in =

[HEZComm : BusinessConnect EZComm Protocol 1 itemn(s)
[ElsoAP @ BusinessConnect SOAP Frotocol 1 itemn(s)

O soap 0 Operation type

By using this window, you can do the following operations:

— Import Import a new operation by clicking Import.

— Export Export the existing operations by clicking SOAP, and then click Export.
2. Click the SOAP link in the right panel.
3. Click New Interface.
4. In the New Interface window, perform the following steps:

a. In the Name field, type an interface name, such as POInterface.

b. In the Description field, type a brief description for this interface. This is
optional.

5. Click Save.

After the configuration, the new interface POInterface is created, as shown in Figure 15.
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Figure 15 New Interface POlInterface

Edit Operations: SOAP
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Adding a Version to an Interface

To add a version to an interface, perform the following steps:
1. Select an interface, such as POInterface.
2. Click New Version.
3. Inthe New Version window:
a. In the Name field, type a version name, such as 1.0.
b. In the Description ficld, type a brief description for this version. This is optional.
4. Click Save.

After the configuration, the new version 1.0 is created, as shown in Figure 16.

Figure 16 New Interface Version
Edit Operations: SOAP

Export Version | Mew Operation | Delste Version

T

B0 @ polnterface Interface

[l B 1.0 Version
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Adding an Operation to a Version

To add an operation to a version, perform the following steps:

1.
2.
3.

Select a version.
Click New Operation.

In the New Operation window, select Notify or Synchronous Request-Response
from the Operation Type list.

Click OK.

Depending on the operation you have selected, this window has the following content:

— The New Notify Operation window contains the Notify Operation and Notify
Request Action tabs.

— The New Synchronous Request-Response Operation window contains the
Synchronous Request-Response Operation, Request Action, and Response
Action tabs.
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SOAP Operation Properties

S

Signing, encryption, and UsernameToken authentication can be enabled for an operation
by using the Notify Request Action tab for the Notify operation, and by using the
Request Action and Response Action tabs for the synchronous Request-Response
operation. Both the request and response messages can be signed, encrypted, and
authenticated.

Details are explained in the fields Require Digital Signature, Require Content
Encryption, and Require UsernameToken Authentication for these tabs:

* Notify Request Action Tab on page 81
* Request Action Tab on page 84
*  Response Action Tab on page 87

See Document Security Tab on page 115 for information on how to set certificates and
keys for signing and encryption.

If the Require Digital Signature, Require Content Encryption, and Require
UsernameToken Authentication check boxes are cleared, these security elements are not
applied to the outbound messages. However, for inbound messages, if certain check box is
cleared on inbound side operation configuration, whether the specific security feature is
applied or not, the inbound messages are received.

Notify Operation

You can use two tabs for Notify operation: the Notify Operation tab and Notify Request
Action tab.

Notify Operation Tab

Use the Notify Operation tab to specify general information about the operation that
BusinessConnect receives.

Table 4 Notify Operation Tab

Field Description

Name

The name of the operation.

Description

The description of the operation.
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Table 4 Notify Operation Tab (Cont’d)

Field Description

SOAP Action This field specifies the value of the SOAP action HTTP request header field of the SOAP
message. It can be used to indicate the intent of the SOAP HTTP request and its value is a
URI identifying the intent.

See the SOAP 1.1 and 1.2 specifications at http://www.w3.org/TR/soap.

Notify Request Action Tab

Use the Notify Request Action tab to specify how BusinessConnect processes a message.

Table 5 Notify Request Action Tab (Sheet 1 of 3)

Name The name of the operation.
Description The description of the operation.
Direction Initiator to responder (preset).

Security Configurations

Require Digital If selected, you can use this option to sign the outgoing messages and force the
Signature incoming messages to be signed.

Require Content If selected, you can use this option to encrypt the outgoing messages and force the
Encryption incoming messages to be encrypted.

Require If selected, you can use this option to do the following operations:
UsernameToken

*  Send the outbound action message with WSS:UsemameToken Where the user name and

Authenticati . . L
uthentication password are provided by the private process, which is the message producer.

*  Require that the inbound message of the same operation must also carry the
WSS:UsernameToken element to be used for the inbound message authentication. If the
inbound message does not have the WSS:UsemameToken element, the message is
rejected with an error message being replied to the trading partner.

If your trading partners use WSS:UsernameToken to authenticate the message they send to
you, you must define the external users associated with these trading partners.

See the information on how to create an external user and associate this user with a
particular trading partner in the chapter that explains User Access Management in
TIBCO BusinessConnect Trading Partner Administration.
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Table 5 Notify Request Action Tab (Sheet 2 of 3)

Field Description

Validation Configurations

Validate Message Validate the message for the following cases:

* For an initiator, validate the request when it comes from the initiator private
process and goes to a trading partner.

* For a responder, validate the request when it comes from the initiator trading
partner and goes to the responder private process.

When this field is selected, at least one of the schemas, body or header must be
populated. When a schema is present, the corresponding content, body or header must
conform to that schema. If the schema is absent, no validation is performed.

See Appendix B, Schema Validation, on page 191.

SOAP Header The XSD file that TIBCO BusinessConnect uses to validate the header part of the
Validation Schema  SOAP message. This header part contains the customized header elements that both
Name sides of the trading partner agree to put into the SOAP header. All the customized

header elements must have a root element.
The XSD file must have a namespace declaration.

If no file is displayed, you can add a schema by clicking on the change link, browse to
the location of another schema, and load it for validation. If an existing schema file is
displayed, you can replace it by using the change link, or remove it by using the
remove link.

Note: This schema is only used for validating the customized SOAP header. The
partylnfo, security and WS-Addressing €lements are not included.

SOAP Header The top-level element name for the customized SOAP header element.

Root Element . . . . . . .

Name This name canngt contain spaces. This Va!ue is used only for importing j[he gchema into
the TIBCO BusinessConnect palette and is not used during schema validation.

SOAP Body The XSD file that TIBCO BusinessConnect uses to validate the body part of the SOAP

Validation Schema  message. Trading partners use the body element to carry the business document they

Name exchange with each other.

The XSD file must have a namespace declaration.

If no file is displayed, you can add a schema by clicking on the change link, browse to
the location of another schema, and load it for validation. If an existing schema file is
displayed, you can replace it by using the change link, or remove it by using the
remove link.
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Table 5 Notify Request Action Tab (Sheet 3 of 3)

Field Description

SOAP Body Root  The top-level element name for your business document.

ement Name This name cannot contain spaces. This value is used only for importing the schema into
the TIBCO BusinessConnect palette and is not used during schema validation.

% ‘ See Appendix B, Schema Validation, on page 191 for information on validating schemas.
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Synchronous Request-Response Operation

You can use three tabs for Synchronous Request-Response operation: Synchronous
Request-Response Operation tab, Request Action tab, and Response Action tab.

Synchronous Request-Response Operation Tab

Use the Synchronous Request-Response Operation tab to specify general information
about the operation.

Table 6 Synchronous Request-Response Operation Tab

Field Description

Name The name of the operation.

Description The description of the operation.

SOAP Action This field specifies the value of the SOAP action HTTP request header field of the SOAP
message. It can be used to indicate the intent of the SOAP HTTP request and its value is a
URI identifying the intent.

See the SOAP 1.1 and 1.2 specifications at http://www.w3.org/TR/soap.

Request Action Tab

Use the Synchronous Request-Response Request Action tab to specify how
BusinessConnect processes a request.

Table 7 Request Action Tab (Sheet 1 of 4)

Name The name of the operation.
Description The description of the operation.
Direction Initiator to responder (preset).

Security Configurations

Require Digital If selected, you can use this option to sign the outgoing requests and force the
Signature incoming requests to be signed.

Require Content If selected, you can use this option to encrypt the outgoing requests and force the
Encryption incoming requests to be encrypted.
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Table 7 Request Action Tab (Sheet 2 of 4)

Field

Require
UsernameToken
Authentication

Description
If selected, you can use this option to do the following operations:

Send the outbound action message with WSS:UsernameToken Where the user name and
password are provided by the private process, which is the message producer.

*  Require that the inbound message of the same operation must also carry the
WSS:UserameToken element to be used for the inbound message authentication. If the
inbound message does not have the WSS:UsermameToken element, the message is
rejected with an error message being replied to the trading partner.

If your trading partners use WSS:UsernameToken to authenticate the message they send to
you, you must define the external users associated with these trading partners.

See the information on how to create an external user and associate this user with a
particular trading partner in the chapter that explains User Access Management in
TIBCO BusinessConnect Trading Partner Administration.

NHIN/esMD
Authorization
Framework

This check box is used only when you want to use the SAML assertion feature in
conformance with NHIN/esMD Authorization Framework. CAQH CORE is a
standard that uses this feature in the exchange of healthcare documents.

*  Select this check box to use SAML 2.0 assertion for request messages in
conformance with NHIN/esMD Authorization Framework. You must also select
the Require Digital Signature check box, so that the messages are digitally
signed with SAML assertion.

*  When this feature is used, provide all the required values in the saml node from the
private process, such as the AttributeStatement and AuthzDecisionStatement elements that
are required by the NHIN/esMD Authorization Framework. Errors occur if any of
the required values is missing.

Note: On inbound side, if this check box is selected, all the SAML elements required
by the NHIN/esMD Authorization Framework are checked, and errors occur if any of
the required elements is missing. If this check box is not selected, the inbound
messages are still processed but requirement check is not performed.

Validation Configurations
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Table 7 Request Action Tab (Sheet 3 of 4)

Field Description

Validate Message Validate the message for the following cases:

»  For an initiator, validate the request when it comes from the initiator private
process and goes to a trading partner.

» For aresponder, validate the request when it comes from the initiator trading
partner and goes to the responder private process.

When this field is selected, at least one of the schemas, body or header must be
populated. When a schema is present, the corresponding content, body or header must
conform to that schema. If the schema is absent, no validation is performed.

See Appendix B, Schema Validation, on page 191.

SOAP Header The XSD file that TIBCO BusinessConnect uses to validate the header part of the
Validation Schema  SOAP request. This header part contains the customized header elements that both
Name sides of the trading partner agree to put into the SOAP header. All the customized

header elements must have a root element.
The XSD file must have a namespace declaration.

If no file is displayed, you can add a schema by clicking on the change link, browse to
the location of another schema, and load it for validation. If an existing schema file is
displayed, you can replace it by using the change link, or remove it by using the
remove link.

Note: This schema is only used for validating the customized SOAP header. The
partylnfo, security and WS-Addressing elements are not included.

SOAP Header The top-level element name for the customized header elements.

II\{IZ?IEeElement This name cannot contain spaces. This value is used only for importing the schema
into the TIBCO BusinessConnect palette and is not used during schema validation.

SOAP Body The XSD file that TIBCO BusinessConnect uses to validate the body part of the SOAP

Validation Schema  request. Trading partners use the body element to carry the business document they

Name exchange with each other.

The XSD file must have a namespace declaration.

If no file is displayed, you can add a schema by clicking on the change link, browse to
the location of another schema, and load it for validation. If an existing schema file is
displayed, you can replace it by using the change link, or remove it by using the
remove link.
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Table 7 Request Action Tab (Sheet 4 of 4)

Field Description

SOAP Body Root  The top-level element name for your business document.

Element Name . . . . . .
This name cannot contain spaces. This value is used only for importing the schema

into the TIBCO BusinessConnect palette and is not used during schema validation.

Response Action Tab

Use the Synchronous Request-Response Response Action tab to specify how
BusinessConnect processes a response.

Table 8 Response Action Tab (Sheet 1 of 3)

Name The name of the operation (response).
Description The description of the operation.
Direction Responder to initiator (preset).

Security Configurations

Require Digital If selected, you can use this option to sign the outgoing responses and force the
Signature incoming responses to be signed.

Require Content If selected, you can use this option to encrypt the outgoing responses and force the
Encryption incoming responses to be encrypted.

Require If selected, you can use this option to do the following operations:
UsernameToken

*  Send the outbound action message with WSS:UsemameToken Where the user name and

Authenticati . . L
uthentication password are provided by the private process, which is the message producer.

*  Require that the inbound message of the same operation must also carry the
WSS:UsernameToken element to be used for the inbound message authentication. If the
inbound message does not have the WSS:UsemameToken element, the message is
rejected with an error message being replied to the trading partner.

If your trading partners use WSS:UsernameToken to authenticate the message they send to
you, you must define the external users associated with these trading partners.

See the information about how to create an external user and associate this user with a
particular trading partner in the chapter that explains User Access Management in
TIBCO BusinessConnect Trading Partner Administration.
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Table 8 Response Action Tab (Sheet 2 of 3)

Field

Description

NHIN/esMD
Authorization
Framework

This check box is used only when you want to send a response to a request with SAML
assertion in conformance with NHIN/esMD Authorization Framework. The response
contains a signature confirmation defined in this framework.

»  Select this check box to send responses with signature confirmation.

*  When you select this check box, do not select the Require Digital Signature check
box.

Note: If the NHIN/esMD Authorization Framework check box is cleared, the
signature confirmation is not applied to the responses.

Validation Configurations

Validate Message

Validate the message for the following cases:

* For an initiator, validate the request when it comes from the initiator private
process and goes to a trading partner.

» For aresponder, validate the request when it comes from the initiator trading
partner and goes to the responder private process.

When this field is selected, at least one of the schemas, body or header must be
populated. When a schema is present, the corresponding content, body or header must
conform to that schema. If the schema is absent, no validation is performed.

See Appendix B, Schema Validation, on page 191.

SOAP Header
Validation Schema
Name

The XSD file that TIBCO BusinessConnect uses to validate the header part of the
SOAP response. This header part contains the customized header elements that both
sides of the trading partner agree to put into the SOAP header. All the customized
header elements must have a root element.

The XSD file must have a namespace declaration.

If no file is displayed, you can add a schema by clicking on the change link, browse to
the location of another schema, and load it for validation. If an existing schema file is
displayed, you can replace it by using the change link, or remove it by using the
remove link.

Note: This schema is only used for validating the customized SOAP header. The
partyInfo, security and WS-Addressing elements are not included.

SOAP Header
Root Element
Name

The top-level element name for the customized SOAP header element.

This name cannot contain spaces. This value is used only for importing the schema into
the TIBCO BusinessConnect palette and is not used during schema validation.
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Table 8 Response Action Tab (Sheet 3 of 3)

Field Description

SOAP Body The XSD file that TIBCO BusinessConnect uses to validate the body part of the SOAP
Validation Schema  response. Trading partners use the body element to carry the business document they
Name exchange with each other.

The XSD file must have a namespace declaration.

If no file is displayed, you can add a schema by clicking on the change link, browse to
the location of another schema, and load it for validation. If an existing schema file is
displayed, you can replace it by using the change link, or remove it by using the
remove link.

SOAP Body Root  The top-level element name for your business document.

Element Name . . . . . . .
This name cannot contain spaces. This value is used only for importing the schema into

the TIBCO BusinessConnect palette and is not used during schema validation.

Private Process Time to wait for the response from the private process before timeout.

Wait (seconds) The default is 3600 seconds (60 minutes).

% See Appendix B, Schema Validation, on page 191 for information on validating schemas.
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Importing SOAP Interfaces

You might want to import one or more interfaces from a trading partner so that you do not
have to re-create an interface.

To import an interface, perform the following steps:
1. Expand BusinessConnect > Operations Editor.
2. Click Import.

The Import Operations window is displayed, as shown in Figure 17.

Figure 17 Importing Operations

Import Operations

Upload
Canfiguration re fle change...
Data File

3. Click the Change link to upload a configuration data file.

4. In the Change File window, click Browse to navigate to a directory containing an
interface.

Select the interface.

Click Open and then click OK.
Type a password. This is optional.
Click Import.

Click Done.

o ® =N oW

Sample Interfaces

TIBCO BusinessConnect SOAP Protocol provides the following sample interfaces that
can be imported into the BusinessConnect configuration store:

— TIBCO_HOME!/bc/version_number/protocols/soap/samples/server/

operations.csx

— TIBCO_HOME/bc/version_number/protocols/soap/samples/client/

operations.csx

— TIBCO_HOME!/bc/version _number/protocols/soap/samples/cagh/

caqgh.csx
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Exporting SOAP Interfaces

You might want to send an interface to a trading partner so that the partner does not have
to re-create an interface.

To export an interface, perform the following steps:

1.
2.
3.

Expand BusinessConnect > Operations Editor.
Click the SOAP link from the Protocol list in the right panel.
Expand Interface and Version.

The specific version and operations are displayed, as shown in Figure 18.

Figure 18 Exporting SOAP Interface, Version, or Operation

8.
9.

Edit Operations: SOAP

| Export Interface I New Version I Delete Interface |

o

= @B POlInterface Purchase Order Interface  Interface
= Otl 1.0 Version
Oi5 ponotify Notify Operation
O|__% POSync Synchronous Request-Response Operation

Select the Interface, Version or the specific operation you want to export.

Click Export Interface, Export Version, or Export Operation, depending on what
you selected in step 4.

The Export Operations window is displayed for the selected interface, version, or
operation.

To save the exported data, set the password. This is optional.
Click Export Data.
The pop-up dialog is displayed with the suggested file name operations.csx.

Browse to a desired place on your machine and click Save.

10. Click Done to finish export.
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Modifying SOAP Operations

You can modify SOAP operations by defining the SOAP body validation schema name
and SOAP body root element name. This must be done on the initiator and responder
BusinessConnect installations.

Modifying the Notify Operation
To modify the operation, perform the following steps:
1. Expand BusinessConnect > Operations Editor.
2. Click the SOAP link from the Protocol list in the right panel.
3. Click to expand the interface tree.

The expanded interface tree is displayed, as shown in Figure 19.

Figure 19 Expanding the Interface

Edit Operations: SOAP

New Interface
s

= Otl POlInterface Purchase Order Interface Interface
= Otl 1.0 Version
Oi5 ponotify Notify Operation
Olj‘)' POSync Synchronous Request-Response Operation
4. Click the PONotify link.
5. Click the Notify Request Action tab.
6. Next to SOAP Body Validation Schema Name, click change.
7. Select Uploaded File from the Type list.
8. Next to the Uploaded File field, click Browse and select the file to upload, such as the

commonpo.xsd file in the TIBCO_HOME/bc/version_number/protocols/soap/samples/schemas/
tutorial directory.

9. Click Open and then click OK.

The file is uploaded in the Notify Request Action tab of the Notify Operation, as
shown in Figure 20.
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Figure 20 Notify Operation

Edit Notify Operation for Version POInterface/1.0 : PONotify

| Save ” Cancel |

Motify Operation | Notify Reguest Action
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Mame |notify
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Direction Initiator to Responder

Security
Configurations

Require Digital D
Signature

Require Content D
Encryption
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UsernameToken [ |
Authentication
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Configurations
Validate Message

SOAP Header
Validation Schema
Name

SOAP Header Root
Element Name

SOAP Body Validation d ch
Scherma Name fommonpo.xsd change remove

poheader.xsd change remove

SOAP Body Root

Element Name CommonPO

10. Type the name in the SOAP Body Root Element Name field.
11. Click Save.

Modifying the Sync Operation
To modify the operation, perform the following steps:
1. Expand BusinessConnect > Operations Editor.
Click the SOAP link from the Protocol list in the right panel.
Click to expand the interface tree.
Click the POSync link.
Click the Request Action tab.
Next to SOAP Body Validation Schema Name, click change.
Select Uploaded File from the Type list.

S A

Next to the Uploaded File field, click Browse and select the file to upload, such as the
commonpo.xsd file in the TIBCO_HOME/bc/version_number/protocols/soap/samples/schemas/
tutorial directory.
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Click Open and then click OK.

The file is uploaded in the Request Action tab of the Synchronous Request-Response
Operation, as shown in Figure 21.

Figure 21 Synchronous Request-Response Operation: Request Action

General

SOAP Body Validation

| Save ”

Synchronous Request-Response Operation | Request Action | Response Action

MName request
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Direction Initiator to Responder

Security
Configurations
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Signature

Require Content D
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UsernameToken [ |
Authentication
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SOAP Header

Validation Schema
Name

SOAP Header Root
Element Name

poheader.xsd change remove

commonpo.xsd change remove
Schema Name £12nas [emave

SOAP Body Root

Element Name CommonPO

10.
11.
12.
13.
14.
15.
16.

17.

Type the name in the SOAP Body Root Element Name field.
Click Save.

Click the POSync link again.

Click the Response Action tab.

Next to SOAP Body Validation Schema Name, click change.
Select Uploaded File from the Type list.

Next to the Uploaded File field, click Browse and select the file to upload, such as the
commoninvoice.xsd file in the TIBCO_HOME/bc/version_number/protocols/soap/samples/schemas/
tutorial directory.

Click Open and then click OK.

The file is uploaded in the Response Action tab of the Synchronous
Request-Response Operation, as shown in Figure 22.
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Figure 22 Synchronous Request-Response Operation: Response Action

Edit Synchronous Request-Response Operation for Version POInterface/1.0 : POSync
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18. Type the name in the SOAP Body Root Element Name field.
19. Click Save.
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Setting Up Trading Hosts and Partners

This chapter explains how to set up trading hosts and partners in TIBCO BusinessConnect
SOAP Protocol.

* Configuring the SOAP Protocol for a Host, page 98
* Configuring the SOAP Protocol for a Partner, page 100
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Configuring the SOAP Protocol for a Host

To configure the SOAP protocol for a trading host, perform the following steps:
1. In TIBCO Administrator, expand BusinessConnect > Participants.
2. Click a host participant link in the right panel.
3. Click the Protocols tab.
If SOAP is not displayed in the list of protocols, perform the following steps:
a. Click Enable.
b. Select the SOAP check box.
c. Click OK.
4. Click the SOAP link.
5. In the Edit Enabled Protocol window, set properties for SOAP by using Table 9.

Table 9 Configuring a Host: General Tab

Field Description

Default Domain
Identity

The default domain identity to use for this host. Select from the list of domain identities
created in the Domain Identities List window.

See on page 98 to add or edit a domain identity.

Valid Email This field is not used for TIBCO BusinessConnect SOAP Protocol.

Address List

Allow Anonymous SOAP messages can pass through.

Anonymous See Receiving SOAP Messages without TIBCO BusinessConnect-Specific Headers on
SOAP Messages

page 135.

6. Click Save.
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Adding a Domain Identity for a Host

To add a domain identity, perform the following steps:

1.

2
3.
4,
5

In the Edit Enabled Protocol window, click the Add New link.

In the Domain Identity List window, click Add New.

Select a domain from the Domain list and type an identity in the Identity field.
Click Save.

Click OK.
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Configuring the SOAP Protocol for a Partner

To configure the SOAP protocol for a trading partner, perform the following steps:
1. In TIBCO Administrator, expand BusinessConnect > Participants.
2. Click a partner participant link in the right panel.
3. Click the Protocols tab.
If SOAP is not displayed in the list of protocols, perform the following steps:
a. Click Enable.
b. Select the SOAP check box.
c. Click OK.
4. Click the SOAP link. The following configuration options are available:
— General Tab See Configuring General Properties for a Partner on page 100.
— Transports Tab See Configuring Transports for a Partner on page 103.
5. Click Save.

Configuring General Properties for a Partner

Use the General tab to configure general information about your trading partner.

Table 10 Configuring a Partner: General Tab (Sheet 1 of 3)

Field Description

Default Domain The default domain identity to use for this host. Select from the list of domain
Identity identities created in the Domain Identities List window.

See Adding a Domain Identity for a Partner on page 102 to add or edit a domain
identity.

Valid Email Address This field is not used for TIBCO BusinessConnect SOAP Protocol.

List
Duplicate Detection Prevents duplicate messages from being sent to your trading partner and sends an
for Outbound error message to the private process.

See Configuring the SOAP Protocol for a Partner on page 100.

Add BusinessConnect ~ Adds a special header to any messages going to this trading partner.

Specific Header See TIBCO BusinessConnect SOAP Protocol Public Messages on page 140.
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Table 10 Configuring a Partner: General Tab (Sheet 2 of 3)

Field Description

Allow Anonymous Anonymous SOAP messages from this trading partner can pass through.
SOAP Messages From

This Trading Partner See Receiving SOAP Messages without TIBCO BusinessConnect-Specific

Headers on page 135.

SOAP Namespace You can configure the prefix for the envelope namespace. The string SOAP-ENV is
Prefix still the default, but you can replace it by any string of your choice. For example, a
SOAP message can have the following format:

<abc:Envelope
xmlns:abe="http://www.w3.0rg/2003/05/soap-envelope">
<abc:Header>

</abe:Header>

<abc:Body>

</abe:Body>

</abe:Envelope>

where abe replaces the previously pre-defined string SOAP-ENV.

Note: The value Envelope is not applied to SOAP faults, which always have
SOAP-ENYV as the default namespace.

SOAP Version TIBCO BusinessConnect SOAP Protocol supports both SOAP versions 1.1 and 1.2
by selecting SOAP 1.1 Protocol or SOAP 1.2 Protocol in the SOAP Version
field. The default value is SOAP 1.1 Protocol. The configuration is used to set the
outbound messages.

For outbound messages, you can use SOAP protocol to send the request in SOAP
version 1.1 or 1.2. You can also use SOAP protocol to send the response in the
same version of the request from the trading partner. For inbound messages, SOAP
protocol can process the request or response in version 1.1 or 1.2.

Send CAQH Message ~ When you select this check box, BusinessConnect forwards inbound CAQH
To EDI Protocol Batch/Realtime Request/Response to EDI protocol.
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Table 10 Configuring a Partner: General Tab (Sheet 3 of 3)

Field Description

SOAP MTOM TIBCO BusinessConnect SOAP Protocol supports MTOM by selecting the SOAP
Enabled MTOM Enabled check box. The configuration is used to set the outbound
messages.

If selected, the outbound messages are processed by using MTOM standard to
optimize the transmission of the binary data in XML infoset. The binary data is
supposed to be base64 encoded, which is included in the XML document specified
in the body node of the request private process message.

For outbound messages, if the content of the binary data is not in base64 format in
the body node of the request private process messages, the messages processed by
MTOM might not be decoded correctly by the responder side which is also MTOM
enabled.

For inbound messages, if optimized messages by MTOM are detected, the
messages are parsed and the original binary data extracted from the MTOM
attachments is encoded into base64 format and put back into SOAP body, before
the messages are further processed.

Note:

If the SOAP MTOM Enabled check box is selected, the value under xop >
tagName > value of the private process message must be populated according
to the binary data element in the body node. If not, the request is rejected and the
outbound process is ended.

If the SOAP MTOM Enabled check box is not selected, and the value under
xop > tagName > value in the private process is provided, the request is
rejected and the outbound process is ended.

MTOM and attachments from the private process cannot be used together. If
the SOAP MTOM Enabled check box is selected, and some attachments are
also specified from the private process request message, the request is rejected
and the outbound process is ended.

When selecting the SOAP MTOM Enabled and Require Content
Encryption check boxes to send outbound messages, the binary content which
refers to the value under xop > tagName > value in the private process
message is ignored. The encrypted data in the Ciphervalue element after
encryption is used to construct the MTOM attachment.

See MTOM on page 22.

Adding a Domain Identity for a Partner

To add a domain identity, perform the following steps:
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1. In the Edit Enabled Protocol window, click the Add New link.

2. In thew Domain Identity List window, click Add New.

3. Select a domain from the Domain list and type an identity in the Identity field.
4. Click Save.

5. Click OK.

Configuring Transports for a Partner
To add the transport for a partner, perform the following steps:
1. Click the Transports tab.
2. Click Add.

In the New Transport window, type data as explained in Table 11.

Table 11 New Transport for a Partner

Field Description

Name Type the name for the transport.
Type Select HTTP or HTTPS from the Type list.
3. Click OK.

4. Inthe New HTTP Transport window, type information as in Table 3.
5. Click Save three times.

See the information about setting up HTTP/S for a trading partner in 7/BCO
BusinessConnect Trading Partner Administration.
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Chapter8  Configuring Business Agreements

This chapter explains how to configure business agreements and protocol bindings for
TIBCO BusinessConnect SOAP Protocol.

Topics

* Configuring SOAP Agreement Protocol Binding, page 106
e Operation Bindings Tab, page 107

*  Document Security Tab, page 115

*  Transports Tab, page 116

* Overriding Participant Settings, page 117
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Configuring SOAP Agreement Protocol Binding

To configure a SOAP agreement protocol binding, perform the following steps:

1.
2.
3.

10.
11.

In TIBCO Administrator, expand BusinessConnect > Business Agreements.
Click New.
Select a Host and a Partner from the Host Party and Partner Party arcas.

Be sure that both trading partners have the SOAP protocol enabled in the Protocols
list. If SOAP is not listed, see Configuring the SOAP Protocol for a Host on page 98
or Configuring the SOAP Protocol for a Partner on page 100.

Click OK.
Click the New Agreement link just created.

Click the General tab, verify that the Valid check box is selected, which means the
current business agreement is valid.

If you want to specify the time period for which this agreement is valid, clear the
Valid check box, and then use the Start Date and End Date lists to specify the
agreement duration.

Click Add Protocol Binding.

Select SOAP.

Click OK.

Click the SOAP link from the Agreement Protocol Binding list.
Configure each of the following tabs:

— Operation Bindings See Operation Bindings Tab on page 107.
— Document Security See Document Security Tab on page 115.
— Transports Sce Transports Tab on page 116.

— Show Advanced: Participant Configuration See Overriding Participant Settings
on page 117.
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Operation Bindings Tab

Use the Operation Bindings tab to configure the SOAP operations that each participant
in a business agreement can initiate and respond to.

The Initiating Operations and Responding Operations arcas list the activities that the
host and partner can initiate and the partner/host can respond to.

The following properties apply to all the activities that you import in Operations Editor,

as shown in Table 12.

Table 12 Protocol Bindings Tab

Field Description

Allow All Select this check box to enable all operations between participants. You can modify the
Operations behavior by binding the operations in the Initiating Operations and Responding
Operations areas.

When the check box is cleared, it is required that the operation in the Responding
Operations arca be explicitly bound in the Initiating Operations area also. Otherwise,
the following error message is displayed:

Sending SOAPFault. Fault String: TP not allowed access, reason: Operation not bound for trading partner.

This check box is cleared by default for the SOAP protocol.

Non Repudiation This check box is selected by default for the SOAP protocol.

Logging See Non-Repudiation Logs on page 127.

Initiating Operations

Add Operation The Initiating Operations arca lists the activities that the host can initiate and the
Binding partner can respond to. To bind an operation in this area, perform the following steps:

1. Click Add Operation Bindings.
2. Click to expand the interface tree and select the operation.

3. Click OK.

Responding Operations
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Table 12 Protocol Bindings Tab (Cont’d)

Field Description

Add Operation The Responding Operations area lists the activities that the partner can initiate and the
Binding host can respond to. To bind an operation in this area, perform the following steps:

1. Click Add Operation Bindings.
2. Click to expand the interface tree and select the operation.

3. Click OK.

A sample of the operation bindings for the host and partner is displayed, as shown in
Figure 23.

Figure 23 Operation Bindings Added for Host and Partner

Add Operation Binding | Femoy

[ BC/L.0Notify

Add Operation Binding | Femoy

[ BC/L.0Notify

Editing an Operation Binding for the Host

You can use the Operation Settings, Action Settings, and Transports tabs to override
the operation, action, and transport settings of the host.

Operation Settings Tab
To override the operation settings of the host, perform the following steps:

1. Click a Notify or a Synchronous Request-Response operation binding link in the
Initiating Operations area.

2. Click the Operation Settings tab.
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3. Override the operation settings by using information in Table 13.

Table 13 Override Outbound Settings: Operation Settings Tab

Field Description

Override Operation  To override the settings for a SOAP operation, select this check box and then select
Settings General from the list.

The options selected here override those selected in SOAP Operation Properties on
page 80.

SOAP Action You can use this function to override the SOAP action that you typed in Operations
Editor for this operation.

4. Click Save.

Action Settings Tab
To override the action settings of the host, perform the following steps:

1. Click a Notify or a Synchronous Request-Response operation binding link in the
Initiating Operations area.

2. Click the Action Settings tab.

3. Override the action settings by using information in Table 14.

Table 14 Override Outbound Settings: Action Settings Tab

Field Description
Override Action Select this check box and then select General from the list to override the action
Settings settings originally configured.

Security Configurations

Require Digital If selected, this option signs the outgoing requests and forces the incoming requests to
Signature be signed.

You can use this function to override the signature settings originally configured in
Operations Editor.

Require Content If selected, this option encrypts the outgoing requests and forces the incoming requests
Encryption to be encrypted.

You can use this function to override the encryption settings originally configured in
Operations Editor.
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Table 14 Override Outbound Settings: Action Settings Tab (Cont’d)

Field

Require
UsernameToken
Authentication

Description
If selected, you can use this option to do the following operations:

Send the outbound action message with WSS:UsernameToken Where the user name and
password are provided by the private process, which is the message producer.

*  Require that the inbound message of the same operation must also carry the
WSS:UsernameToken element to be used for the inbound message authentication. If the
inbound message does not have the WsS:UsemameToken element, the message is
rejected with an error message being replied to the trading partner.

If your trading partners use WSS:UsernameToken to authenticate the message they send to
you, you must define the external users associated with these trading partners.

You can use this function to override the UsernameToken Authentication settings
originally configured in Operations Editor.

See the information about how to create an external user and associate this user with a
particular trading partner in the chapter that explains User Access Management in
TIBCO BusinessConnect Trading Partner Administration.

NHIN/esMD
Authorization
Framework

This check box is used only for synchronous request-response operation.

If selected, SAML 2.0 assertion is used for request messages in conformance with
NHIN/esMD Authorization Framework. You must also select the Require Digital
Signature check box, so that the messages are digitally signed with SAML assertion.

On inbound side, if this check box is selected, the incoming requests that contain all
the required SAML elements as defined in the framework are checked.

You can use this function to override settings of NHIN/esMD Authorization
Framework originally configured in Operations Editor.

Validation Configurations

Validate Message

When selected, any outbound message is validated.

»  When this field is selected, at least one of the schemas must be populated in
Operations Editor, such as body or header.

*  When the schema is present, the corresponding content must conform to that
schema, such as body or header. If the schema is absent, no validation is
performed.

You can use this function to override the validation settings originally configured in
Operations Editor.

See Appendix B, Schema Validation, on page 191.
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4. Click Save.

Transports Tab
To override the transports settings of the host, perform the following steps:

1. Click a Notify or a Synchronous Request-Response operation binding link in the
Initiating Operations area.

2. Click the Transports tab.

3. Override the transport settings by using information in Table 15.

Table 15 Override Outbound Settings: Transports Tab

Field Description

Override Select this check box to override the settings for a transport.
Transports

Override Outbound Transports

Primary Transport ~ Select the primary transport to override from the list: HTTP, HTTPS, or HTTPSCA.

4. Click Save.

Editing an Operation Binding for the Partner

You can use the Operation Settings and Action Settings tabs to override the operation
and action settings of the partner.

Operation Settings Tab
To override the operation settings of the partner, perform the following steps:

1. Click a Notify or a Synchronous Request-Response operation binding link in the
Responding Operations area.

2. Click the Operation Settings tab.
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3. Override the operation settings by using information in Table 16.

Table 16 Override Inbound Settings: Operation Settings Tab

Field Description

Override Operation  To override the settings for a SOAP operation, select this check box and then select
Settings General from the list.

The options selected here override those selected in SOAP Operation Properties on
page 80.

SOAP Action You can use this function to override the SOAP action that you typed in Operations
Editor for this operation.

4. Click Save.

Action Settings Tab
To override the action settings of the partner, perform the following steps:

1. Click a Synchronous Request-Response operation binding link in the Responding
Operations area.

2. Click the Action Settings tab.

3. Override the action settings by using information in Table 17.

Table 17 Override Inbound Settings: Action Settings Tab (Sheet 1 of 3)

Field Description
Override Action Select this check box and then select General from the list to override the action
Settings settings originally configured.

Security Configurations

Require Digital If selected, this option signs the outgoing responses and forces the incoming
Signature responses to be signed.

You can use this function to override the signature settings originally configured in
Operations Editor.

Require Content If selected, this option encrypts the outgoing responses and forces the incoming
Encryption responses to be encrypted.

You can use this function to override the encryption settings originally configured in
Operations Editor.
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Table 17 Override Inbound Settings: Action Settings Tab (Sheet 2 of 3)

Field Description

Require If selected, you can use this option to do the following operations:
UsernameToken

. Send the outbound action message with WsS:UsernameToken where the user name
Authentication

and password are provided by the private process, which is the message
producer.

*  Require that the inbound message of the same operation must also carry the
WSS:UsernameToken element to be used for the inbound message authentication. If
the inbound message does not have the WSS:UsernameToken element, the message is
rejected with an error message being replied to the trading partner.

If your trading partners use WsSS:UserameToken to authenticate the message they send to
you, you must define the external users associated with these trading partners.

You can use this function to override the UsernameToken Authentication settings
originally configured in Operations Editor.

See the information about how to create an external user and associate this user with
a particular trading partner in the chapter that explains User Access Management in
TIBCO BusinessConnect Trading Partner Administration.

NHIN/esMD This check box is used only for synchronous request-response operation.
Authorization

If selected, the responder can send a response to a request with SAML assertion in
Framework

conformance with NHIN/esMD Authorization Framework. The response contains a
signature confirmation defined in this framework.

You can use this function to override settings of NHIN/esMD Authorization
Framework originally configured in Operations Editor.

Validation Configurations

Validate Message When selected, any inbound message is validated.

*  When this field is selected, at least one of the schemas must be populated in
Operations Editor, such as body or header.

*  When the schema is present, the corresponding content must conform to that
schema, such as body or header. If the schema is absent, no validation is
performed.

You can use this function to override the validation settings originally configured in
Operations Editor.

See Appendix B, Schema Validation, on page 191.
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Table 17 Override Inbound Settings: Action Settings Tab (Sheet 3 of 3)

Field Description

Private Process Wait  Select to override the wait time originally configured. This is the amount of time the
(seconds) responder waits for the response from the private process.

The default value is 3600 seconds (60 minutes).

You can use this function to override the time settings originally configured in
Operations Editor.

4. Click Save.
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Document Security Tab

Information about this topic, see Document Security tab in 7/BCO BusinessConnect
Trading Partner Administration.

See also Security in 7/BCO BusinessConnect Concepts.

TIBCO BusinessConnect SOAP Protocol supports SHA1, SHA256, SHA384 and
% SHAS12 digest algorithm for signatures and DES3, AES-128, AES-192, AES-256,
AES-128-GCM, AES-192-GCM, and AES-256-GCM encryption algorithms.

% SAML 2.0 assertions only support Secure Hash Algorithm 1 (SHA1) digest algorithm.
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Transports Tab

To configure the Transports tab, see Table 18.

Table 18 Transports Tab

Field Description

Outbound Transports for Host (Host to Trading Partner)

Primary Transport The following options are available: HTTP, HTTPS, HTTPSCA, or None.

The primary transport is configured by using the steps described in Configuring
Transports for a Partner on page 103.

Client Authentication  Select one of the private keys that were assigned to the host.
Identity for FTPS,

HTTPSCA See Managing Host Credentials in 7IBCO BusinessConnect Trading Partner

Administration.

Client Authentication  Select one of the SSH private keys assigned to the host, which is used to support the
Identity for SSHFTP SSHFTP transport.

See Managing Host Credentials in 7IBCO BusinessConnect Trading Partner
Administration.

Allowed Inbound Transports for Partner (Trading Partner to Host)

HTTP or HTTPS Transport types are displayed. HTTP or HTTPS is selected in the deployment
configuration.

See the information about Setting Up HTTP/S for a Trading Partner in 7/BCO
BusinessConnect Trading Partner Administration.

TIBCO BusinessConnect SOAP Protocol User’s Guide



Overriding Participant Settings

Overriding Participant Settings

Use the participant configuration tabs to override the general settings for a participant per
agreement protocol binding.

» To view the participant configuration tabs, click Show Advanced.

Host’s Configuration and Partner’s Configuration tabs are displayed, where Host
and Partner are the participants in the business agreement.

* To hide the participant configuration tabs, click Hide Advanced.

Overriding Settings for the Host
To override settings for the host, perform the following steps:
1. Click the Host’s Configuration tab.

2. Override settings by using information in Table 19.

Table 19 Show Advanced: Host'’s Configuration

Field Description

Override Settings If this check box is selected, the settings specified for the host in Table 9, Configuring
a Host: General Tab, on page 98 are overridden.

Default Domain Select a domain identity from the list.

Identity The domain identity is configured as explained in on page 98.

3. Click Save.

Overriding Settings for the Partner
To override settings for the partner, perform the following steps:
1. Click the Partner’s Configuration tab.

2. Override settings by using information in Table 20.

Table 20 Show Advanced: Partners Configuration

Field Description

Override Settings If this check box is selected, the settings specified for the partner in Table 10,
Configuring a Partner: General Tab, on page 100 are overridden.
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Table 20 Show Advanced: Partner s Configuration (Cont’d)

Field Description

Default Domain Select a domain identity from the list.

Identity The domain identity is configured as explained in Adding a Domain Identity for a

Partner on page 102.

3. Click Save.
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Chapter9  Viewing Logs

This chapter discusses how to view audit, non-repudiation, and resend logs after
conducting business transactions.

Topics

*  Overview, page 120

*  Audit Logs, page 121

* Non-Repudiation Logs, page 127
* Resend Logs, page 129
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Overview

TIBCO BusinessConnect provides logs that are used to store messages processed through
the system. These logs are as follows:

e Audit logs
*  Resend logs
*  Non-repudiation logs

Use the Log Viewer to search for SOAP transaction records.

Accessing Logs
To access a log, perform the following steps:
1. In TIBCO Administrator, expand BusinessConnect > Log Viewer in the left panel.
2. Select SOAP from the Protocol list.
3. Click one of the following buttons to select which log to view:
— Audit Displays the audit log search options.
— Non-repudiation Displays the non-repudiation log search options.
— Resendable Transactions Displays the resend log search options.
— Resend History Displays the resend history log search options.

See TIBCO BusinessConnect Trading Partner Administration for information on
searching the logs.
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Audit Logs

The audit log is used to store information about the messages and documents processed by
BusinessConnect. You can use the audit log to follow the processing states of inbound or

outbound documents. Some information types stored in the audit log include the following
aspects:

* Sent and received documents
*  Document originator

* Trading partner name

*  Processing status

e Validation errors

Configuring an Audit Log for SOAP
To configure an audit log for SOAP, perform the following steps:
1. Expand BusinessConnect > Log Viewer in the left panel.
2. Inthe Log Viewer window, click the SOAP link.
3. Select the options of the audit log by using information in Table 21.

Table 21 Audit Log: Search Filters

Column Name Definition

Status Select a specific status, such as ANY, COMPLETED, COMPLETED_WITH_ERROR, ERROR, Or
PENDING.
Connection The database that you connect to.

You can switch among multiple audit log databases from this list.

Date Range Select a specific date range, such as One Day, One Week, One Month, One Year, OF --Custom--.

If --custom-- is selected, additional fields for defining exact dates are available.

4. To configure the advanced search filters, click Add.
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5. Configure the advanced search settings by using information in Table 22.

Table 22 Audit Log: Advanced Search Filters

Column Definition

Save as Query Type the name under which you want to save the query you define in this field.

Gateway Instance Indicates which gateway instance transferred this message.

Information

Boolean search: is, contains, is not, is not like.
Trading Partner The name of the trading partner.

Boolean search: is, contains, is not, is not like.
Operation ID The operation ID.

Boolean search: is, contains, is not, is not like.
Transaction ID The transaction ID.

Boolean search: is, contains, is not, is not like.

Audit Log Views

You can view summary, transaction details, and state details information of audit logs.

Summary View

Table 23 lists the columns that are displayed in the audit log.

Table 23  Audit Log Columns

Column Definition

Date Group Results are grouped according to the day the transactions occurred.
Time Stamp When each of the transaction states is logged.

Trading Partner The name of the trading partner.

Operation ID The operation ID used for this operation.

Example: POInterface/1.0/PONotify.

Transaction ID The transaction ID for this transaction.
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Transaction Details View
To view the details of a transaction, click | attheleftofa specific time stamp.

The general information for this entry and a table with available information for each
event in that transaction are displayed. The table columns are listed in Table 24.

Each transaction is identified with its Process Instance Identifier.

Table 24 Transaction Detail Columns

Column Definition

Time Stamp When each of the transaction states is logged.

Status Status of the message.

Valid values: COMPLETED, ERROR, PENDING. These values come from the status field in
certain tables.

State The current state of the message.
Example: REQUEST FROM_PP.

See State Field Values on page 123 for a list of the possible values.

Description Description of the last action recorded for the message.

Example: Sending Notification to Trading Partner.

State Details View
To view the details of a specific state, click [, at the left of a transaction detail entry.

All information from the summary view and transaction details view for the transaction
entry are displayed.

State Field Values

Table 25 provides a list of the State field values for the initiator process.

Table 25 State Field Values for Initiator Process

Short Message Definition Comments
REQUEST FROM_PP Received request from private Received notification from private process.
process. Depending on the message types, different

descriptive messages are logged.

REQUEST SEND TO_TP Request or notification is about ~ This entry is logged before the request has
to be sent to trading partner. been sent to the trading partner.
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Table 25 State Field Values for Initiator Process (Cont’d)

Short Message Definition Comments
REQUEST_SENT_TO_TP Request or notification sent to This entry is logged only after the request has
trading partner; received been successfully posted to the trading
acknowledgment. partner.
Either this entry or the next one is the last one
logged for notification.
RESPONSE_FROM_TP Received response from trading ~ This entry is logged only after a response is
partner. received from the trading partner.
RESPONSE_TO_PP Response sent to private Logging is done after a response, such as an
process. error message, was handed off to the private
process.
In case an error is returned, a descriptive
message is logged instead.
PACKAGE_MSG SOAP Message packaged Logging is done after the SOAP message is
successfully. packaged. For example, after the header
elements, body elements, and attachments
have been added.
If security is enabled, the SOAP body is
signed, encrypted, and authenticated.
UNPACKAGE_MSG Message from the <trading partmer> ~ Logging is done after the received HTTP
parsed to a SOAP message message (request/response) is converted to a
successfully. SOAP message and decrypted (if encrypted
previously).
RESPONSE_DECRYPTED Encrypted response message Logging is done after the incoming message
successfully decrypted. is decrypted successfully.
RESPONSE_VERIFIED Signed response from the Logging is done after the signed response
trading partner verified message is verified successfully.
successfully.
DOCUMENT_DENIED Received request document is Logging is done when the incoming request

denied because of encryption,
signing, or authentication
permissions.

or response is denied because of security
permissions for this operation.
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Short Message

VALIDATE_REQUEST

Definition

Incoming request (<header/Body>)
is validated.
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Comments

Logging is done after the validation of the
incoming or outgoing request. The description
specifies if the validation was a success or
failure.

VALIDATE_RESPONSE

Incoming response
(<header/Body>) is validated.

Logging is done after the validation of the
incoming or outgoing response. Description
specifies if validation was a success or failure.

Table 26 State Field Values for Responder Process

Short Message

REQUEST FROM_TP

Description

Received request from trading
partner.

Table 26 provides a list of the State ficld values for the responder process:

Comments

Received notification from trading partner.
Logging is done after having successfully
received a notification or request.

REQUEST TO PP

Request sent to private process.

Notification sent to private
process.

Logging is done just before sending
notification or request to the private process.

This is the last entry in case of notification.

RESPONSE_FROM_PP

Received response from private
process.

Logging is done after having received
response from the private process.

RESPONSE_TO TP

Response sent to trading partner.

Logging is done after having the response was
successfully posted to the trading partner.

PACKAGE_MSG

SOAP Message packaged
successfully.

Logging is done after the SOAP message is
packaged. For example, after the header
elements, body elements, and attachments
have been added.

If security is enabled, the SOAP body is
signed, encrypted, and authenticated.

UNPACKAGE_MSG

Message from the <trading partner>
parsed to a SOAP message
successfully.

Logging is done after the received HTTP
message (request/response) is converted to a
SOAP message and decrypted (if encrypted
previously).
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Table 26 State Field Values for Responder Process (Cont’d)

Short Message Description Comments

REQUEST_DECRYPTED Encrypted request message Logging is done after the incoming message is
successfully decrypted. decrypted successfully.

REQUEST_VERIFIED Signed request from Trading Logging is done after the signed request

Partner verified successfully.

message is verified.

DOCUMENT _DENIED Received request document is
denied because of encryption,
signing, or authentication
permissions.

Logging is done when the incoming request or
response is denied because of security
permissions for this operation.

VALIDATE_REQUEST Incoming request (<header/Body>)
is validated.

Logging is done after the validation of the
incoming or outgoing request. The description
specifies if the validation was a success or
failure.

VALIDATE_RESPONSE Incoming response (<header/Body>)
is validated.

Logging is done after the validation of the
incoming or outgoing response. Description
specifies if validation was a success or failure.

COMPLETED_WITH The response cannot be sent to
ERROR the partner.

This state is logged when responder fails to
send a response to the initiator.
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Non-Repudiation Logs

TIBCO BusinessConnect SOAP Protocol logs the signed incoming messages to the
non-repudiation tables: the incoming notify or synchronous request messages are logged
on the responder side, and the synchronous response messages are logged on the initiator
side.

You can use non-repudiation logging in a business agreement and then apply it to all
operations. It extracts the SOAP envelope from an incoming SOAP message and logs it
when the message verification succeeds.

Non-repudiation logging stores the SOAP envelope without attachments, and also stores
the verification certificates and decryption identities for encrypted messages.

The incoming SOAP messages are logged as follows:

» If messages are signed and encrypted, both the verification certificate and encryption
identities are logged.

» If messages are signed, but not encrypted, only the verification certificate is logged.

Configuring a Non-Repudiation Log for SOAP
To configure a non-repudiation log for SOAP, perform the following steps:
1. Expand BusinessConnect > Log Viewer in the left panel.
2. Inthe Log Viewer window, select SOAP.
3. Click Non-Repudiation to display the Non-Repudiation log search options.
4

Select the options of the Non-Repudiation log by using information in Table 27.

Table 27 Non-Repudiation Log: Search Filters

Column Name Definition

Status Select a specific status, such as ANY, COMPLETED, COMPLETED WITH_ERROR, ERROR, OF
PENDING.
Connection The database that you connect to.

You can switch among multiple databases from this list.

Date Range Select a specific date range, such as One Day, One Week, One Month, One Year, OI --Custom--.

If --Custom-- is selected, additional fields for defining exact dates are available.

5. To configure the advanced search filters, click Add.
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6. Configure the advanced search settings by using information in Table 28.

Table 28 Non-Repudiation Log: Advanced Search Filters

Column Definition

Save as Query Type the name under which you want to save the query you define in this field.

Operation ID The operation ID.

Boolean search: is, contains, is not, is not like.

Document ID The document ID.

Boolean search: is, contains, is not, is not like.

Trading Partner The name of the trading partner.

Boolean search: is, contains, is not, is not like.

Details for the transactions in the non-repudiation logs view cannot be opened for
viewing.
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Resend Logs

You can use the resend log to search for and view both resent transactions and resendable
transactions. You can also easily initiate a resend.

* Resendable Transactions Resend a transaction.
* Resend History View messages that have been resent.

See Resend Logs in T/IBCO BusinessConnect Trading Partner Administration.

Resendable Transactions
To configure a resendable transaction for SOAP, perform the following steps:
1. Expand BusinessConnect > Log Viewer in the left panel.
2. Inthe Log Viewer window, select SOAP.

3. Click Resendable Transactions to display the resendable transactions log search
options.

4. Configure the search for resendable transactions.

Table 29 lists the options to select in the search transactions log.

Table 29 Resend Log: Resendable Transactions

Column Name Definition

Status Select a specific status, such as ANY, COMPLETED, COMPLETED_WITH_ERROR, ERROR, OF
PENDING.
State Select the transaction state: REQUEST FROM_ PP, REQUEST TO PP, and RESPONSE_TO PP.

See Table 30, State Values for Resendable Transactions, on page 130.

Connection The database that you connect to.

You can switch among multiple databases from this list.

Date Range Select a specific date range, such as One Day, One Weck, One Month, One Year, OT --Custom--.

If --Custom-- 1s selected, additional fields for defining exact dates are available.
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Table 30 gives the explanation of transaction states for resendable transactions.

Table 30 State Values for Resendable Transactions

Short Message Description Comments

REQUEST _FROM_PP Received request from private The initiator message that was originally
process. received is resent.

REQUEST_TO_PP Request sent to private process. The responder request messages are resent.

This state cannot be resent for synchronous
transactions.

RESPONSE TO PP

Response sent to private process.  The initiator response is resent.

5.
6.

To configure the advanced search filters, click Add.

Configure the advanced search settings by using information in Table 31.

Table 31 Resend Log: Advanced Search Filters

Column Name

Definition

Trading Partner The name of the trading partner.
Boolean search: is, contains, is not, is not like.
Operation ID The operation ID.

Boolean search: is, contains, is not, is not like.

Transaction ID

The transaction ID.

Boolean search: is, contains, is not, is not like.

Resend History

To configure a resend history log for SOAP, perform the following steps:

1.

2
3.
4

Expand BusinessConnect > Log Viewer in the left panel.
In the Log Viewer window, select SOAP.
Click Resend History to display the resend history log search options.

Configure the search for resend history.
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Table 32 lists the options to select in the resend history log.

Table 32 Resend Log: Resend History

Column Name Definition

Status Select a specific status, such as ANY, COMPLETED, COMPLETED_WITH_ERROR, ERROR, Of
PENDING.
Connection The database that you connect to.

You can switch among multiple databases from this list.

Date Range Select a specific date range, such as One Day, One Week, One Month, One Year, OT --Custom--.

If --custom-- is selected, additional fields for defining exact dates are available.

5. To configure the advanced search filters, click Add.

6. Configure the advanced search settings by using the list presented in Table 33.

Table 33 Resend Log: Advanced Search Filters

Column Definition

Trading Partner The name of the trading partner.

Boolean search: is, contains, is not, is not like.

Operation ID The operation ID.

Boolean search: is, contains, is not, is not like.

Transaction ID The transaction ID.

Boolean search: is, contains, is not, is not like.
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Advanced Topics

This chapter covers several advanced topics, such as trading with a third-party SOAP
implementation, using the passthrough feature, and so on.

*  TIBCO-Specific Header: Partylnfo, page 134

e Trading with a Third-Party SOAP Implementation, page 135

o Using the Passthrough Feature, page 137

* TIBCO BusinessConnect SOAP Protocol Public Messages, page 140

*  SOAP Message with a TIBCO BusinessConnect-Specific Header, page 142
«  SOAP Envelope Attributes and Namespaces, page 144
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TIBCO-Specific Header: Partyinfo

TIBCO BusinessConnect specific header are the SOAP header elements defined by
TIBCO for the interactions between business-to-business Gateway of two trading partners
both implemented by TIBCO BusinessConnect SOAP Protocol. These header elements
are the meta-data of the SOAP messages describing attributes of these messages: from
which this message was sent, to whom this message is targeted, and the operation ID of
the message, so the receiver knows how to process the message, and do other operations.
The receiver of the SOAP message with this TIBCO BusinessConnect-specific header,
which is also implemented by TIBCO BusinessConnect SOAP Protocol, understands
these header elements.

The TIBCO-specific header data is defined by the schema, and is available in the
partyinfo.xsd file in the TITBCO_HOME/ve/version_number/protocols/soap/samples/schemas directory.

This schema describes information such as:
e From (partner)

e To (partner)

*  Transaction ID

*  Operation ID

*  Operation type

The from and to partner identification in the outbound messages, which are in the partylnfo
header element, are from the Domain and ID configurations of the partner and host.
Values received in the request messages from private process always take precedent.

This results in the following outcomes:

e If the Domain and ID values are not available from the configuration or the private
process message, the name sub-element of the from or to element is populated with the
host or partner name.

* Ifthe Domain and ID values are available from either configuration or the private
process message, the Domain and ID values are used for the from or to elements.

o Ifthe host and partner configuration and private process messages both provide the
same type of identifications (both are partner names, or both are Domain and ID
values), the values from private process messages take precedence.
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Trading with a Third-Party SOAP Implementation

This section describes how a SOAP message from a third-party SOAP implementation
must look like to be processed by a TIBCO BusinessConnect SOAP Protocol
implementation. The BusinessConnect-specific header elements, while useful for the
messages exchange between two TIBCO BusinessConnect SOAP Protocol
implementations, might not be adopted by other third-party SOAP implementations. So
rather than using TIBCO BusinessConnect-specific headers, some other approaches must
be used to make seamless interactions with trading partners.

Receiving SOAP Messages without TIBCO BusinessConnect-Specific Headers

As an alternative to including the TIBCO BusinessConnect-specific header in the SOAP
header, information can be encoded in the URL. In such cases, when receiving an
incoming SOAP message without any TIBCO BusinessConnect-specific header data, the
incoming URL for the following is checked:

e Trading partner
* Host name
e Operation ID

e Transaction ID

Information has to be provided completely either in the partylnfo header or in the URL: it

% cannot be specified partially in the header and partially in the URL. When information is
present both in the partyinfo header and in the URL, information in the partylnfo header takes
precedence.

The URL format is as follows:

http://host:port/dmz/SOAP
?host=host_name&tpname=trading_partner name
&opid=operation_ID

&transid=transaction_ID

Example:

http://www.SOAPServer.com:6700/dmz/SOAP
?host=SOAPServer&tpname=SOAPClient
&opid=Sync/1.0/PORequest
&transid=1232456789

None of the URL parameters is a required value.
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Sending SOAP Messages without TIBCO BusinessConnect-Specific Headers

To enable TIBCO BusinessConnect SOAP Protocol to send a SOAP message without
TIBCO BusinessConnect-specific headers, do not select the Add BusinessConnect
Specific Header check box in the trading partner setup procedures. See Configuring
General Properties for a Partner on page 100.

Without the TIBCO BusinessConnect-specific header in the outbound SOAP messages,
the header information is put and encoded in the URL of the outbound HTTP requests.
The format of the URL is the same.
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Using the Passthrough Feature

In cases that some of the header values are missing from the inbound URL, TIBCO
BusinessConnect SOAP Protocol uses the following rules to process the inbound
message:

*  The tpName and opid parameter values are the minimum information in the URL for
inbound message to be processed end-to-end.

The tpName parameter value indicates which trading partner the message is sent from,
and the opid parameter value indicates which operation is used to process the message.
In a synchronous request-response operation type, the response message can be sent
back if everything else is correct.

o Ifeither tpName or opid parameter value is missing, the following two situations occur:

— If the Allow Anonymous SOAP Messages check box is selected, the message is
processed in passthrough mode and forwarded directly to private process without
validation and parsing. For a synchronous request reply operation, the message is
processed as a notify operation without any response being sent back.

The Allow Anonymous SOAP Messages check box can be configured in various
locations. If the host parameter value is present in the URL, the Allow Anonymous
SOAP Messages check box in the configuration of the local host referred by this
host parameter value takes effect. If the tpName parameter value is present in the
URL, the Allow Anonymous SOAP Messages From This Trading Partner
check box in the configuration of the trading partner referred by this tpName
parameter value takes effect. If neither host or tpName value is present, the
configuration of the default host takes effect.

— Ifthe Allow Anonymous SOAP Messages check box is unselected in either the
related host or trading partner configuration, the message is rejected.

Here are the detailed descriptions of some typical scenarios:

Case 1
SOAP header is absent; URL has no parameters.
Example: http:/www.SOAPServer.com:6700/dmz/SOAP

The SOAP message is rejected by default, and a SOAP fault is generated and sent back to
the trading partner. To avoid messages from trading partners being rejected, you must
select the Allow Anonymous SOAP Messages check box under BusinessConnect >
Participants > Default Host > Protocols > SOAP > General.
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When anonymity is enabled, TIBCO BusinessConnect SOAP Protocol has no context for
the inbound message. It can only handle the incoming message as a notify operation.
TIBCO BusinessConnect server forwards the inbound SOAP message to the private
process through the ResponderRequest message. The request and requestHeader fields of this
message contain the incoming SOAP header and body information in XML format. Once
the inbound SOAP message is forwarded to the local private process, BusinessConnect
server sends an HTTP 204/No Content response back to the trading partner.

Case 2
SOAP header is absent; URL has no tpName and host parameters.

Example:

http://www.SOAPServer.com:6700/dmz/SOAP
?0pid=Sync/1.0/PORequest
&transid=1232456789

TIBCO BusinessConnect SOAP Protocol cannot determine the trading partner context
information. The behavior is identical to when no parameters are present.

Case 3
SOAP header is absent; URL has no opid parameter, but has the tpName parameter.

Example:

http://www.SOAPServer.com:6700/dmz/SOAP
?tpname=SOAPClient
&transid=1232456789

The SOAP message is rejected by default, and a SOAP fault is generated and sent back to
the trading partner. To avoid messages from trading partners being rejected, you must
select the Allow Anonymous SOAP Messages From This Trading Partner check box
under BusinessConnect > Participants > SOAPClient > Protocols > SOAP > General.

When anonymity is enabled for this trading partner, TIBCO BusinessConnect SOAP
Protocol has no operation-related context for the inbound message. It can only handle the
incoming message as a notify operation. TIBCO BusinessConnect SOAP Protocol
forwards the inbound SOAP message to the private process through the ResponderRequest
message. The request and requestHeader fields of this message contain the incoming SOAP
header and body information in XML format. Once the incoming SOAP message is
forwarded to the local private process, BusinessConnect server sends an HTTP 204/No Content
response back to the trading partner. For this transaction, host is the default host of the
system.
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Case 4

SOAP header is absent; URL has no transid parameter, but has the tpName and opid
parameters.

Example:

http://www.SOAPServer.com:6700/dmz/SOAP

2tpname=SOAPClient &opid=Sync/1.0/PORequest
TIBCO BusinessConnect SOAP Protocol has the complete context of the inbound SOAP
message. The transaction is processed as a regular synchronous request response or notify
transaction, depending on the type of operation in the incoming message. A unique
transaction ID is generated and this ID is passed to the private process.

Case 5

SOAP header is absent; URL has no opid parameter, but has the host and tpName parameters.

Example:

http://www.SOAPServer.com:6700/dmz
/SOAP?host=SOAPClient&tpname=SOAPServer

The SOAP message is rejected by default and a SOAP fault is generated and sent back to
the trading partner, because no operation context is used for processing the inbound
message. To avoid messages from trading partners being rejected, you must select the
Allow Anonymous SOAP Messages From This Trading Partner check box under
BusinessConnect > Participants > SOAPClient > Protocols > SOAP > General. With
the host and tpName parameters, the configuration of the trading partner that is SOAPClient
referred by the tpName takes precedence. BusinessConnect server forwards the inbound
SOAP message to the private process through the ResponderRequest message. The request and
the requestHeader ficlds of this message contain the incoming SOAP header and body
information in XML format. Once the incoming SOAP message is forwarded to the local
private process, BusinessConnect server sends an HTTP 204/No Content response back to the
trading partner.

Passthrough is only available for HTTP and HTTPS transports. The HTTPSCA transport

can be used only when the tpname parameter is populated in the URL for passthrough
messages.
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TIBCO BusinessConnect SOAP Protocol Public Messages

The following is an example of a public SOAP request message that TIBCO
BusinessConnect SOAP Protocol generates if the Add BusinessConnect Specific
Header check box is selected in the configuration of the sending trading partner.

See Configuring General Properties for a Partner on page 100 to set up this option for a
trading partner.

Descriptions of the messages are available in the following sections:
*  SOAP Header on page 140
*  SOAP Body on page 140

SOAP Header

Header Section 1 - Customized Header Elements

From <ep:endpoints xmlns:ep="http://user.org/header"> to </prop:properties>

This is the part of the SOAP header that contains customized header elements and comes
from the requestHeader field in the InitiatorRequest message from the private process.

See a sample SOAP envelope message in SOAP Message with a TIBCO
BusinessConnect-Specific Header on page 142.

See Initiator Outbound Request — Private Process to BusinessConnect on page 149 for a
description of this private process message.

Header Section 2 - TIBCO-Specific Header Elements

From <pi:PartyInfo xmlns:pi="http://www.tibco.com/namespaces/bc/2002/04/partyinfo.xsd"> to </pi:PartyInfo>

This is the BusinessConnect specific part of the SOAP header that is added if the Add
BusinessConnect Specific Header check box is selected under
BusinessConnect > Participants > Partner > Protocols > SOAP > General.

SOAP Body
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From <cpo:CommonPO xmlns:cpo="http://po.org/body"> to </cpo:CommonPO>

This is the part of the SOAP body that comes from the request field in the InitiatorRequest
message from the private process, which is actually the business document to be
exchanged to the responder side.

See Initiator Outbound Request — Private Process to BusinessConnect on page 149 for a
description of this private process message.
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SOAP Message with a TIBCO BusinessConnect-Specific Header

This is a sample SOAP 1.1 XML message that has the TIBCO BusinessConnect specific
header:

<?xml version='1.0" encoding="ut{-8'?>
<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<SOAP-ENV:Header>
<ep:endpoints xmlns:ep="http://user.org/header">
<ep:to>
<ep:address>
<name>Book Orders</name>
<street>1st Street</street>
<city>New York</city>
<zip>1111</zip>
</ep:address>
</ep:to>
<ep:from>
<ep:address>
<name>Book Lovers</name>
<street>1st Street</street>
<city>Los Angeles</city>
<zip>90210</zip>
</ep:address>
</ep:from>
</ep:endpoints>
<prop:properties xmlns:prop="http://user.org/header">
<identity>uuid:74b9f5d0-33fb-4a81-b02b-5b760641c1d6</identity>
<sentAt>2000-05-14T03:00:00+08:00</sentAt>
<expiresAt>2000-05-15T04:00:00+08:00</expiresAt>
<topic>http://electrocommerce.org/purchase_order/</topic>
</prop:properties>
<pi:Partylnfo xmlns:pi=""http://www.tibco.com/namespaces/bc/2002/04/partyinfo.xsd"">
<from>
<name>SOAPClient</name>
</from>
<to>
<name>SOAPServer</name>
</to>
<operationID>POInterface/1.0/PONotify</operationID>
<operationType>notify</operationType>
<transactionID>ZrGSGRWSbWkd0UePKiQcfcJUbQo</transactionID>
</pi:PartyInfo>
</SOAP-ENV:Header>
<SOAP-ENV:Body>
<cpo:CommonPO xmlns:cpo="http://po.org/body">
<cpo:POHeader xmlns:cpo="http://po.org/body" CreationDate="2000-06-23" Number="12345" Purpose="PO" Type="EZ" />
<cpo:BillTo />
<cpo:ShipTo ContactName="BonifazLuis" ContactNumber="12345" ContactType="CT" />
<cpo:Item>
<cpo:ItemHeader xmlns:cpo="http://po.org/body" ExtendedPrice="499.75" Price="99.95" Quantity="5" UnitOfMeasure="EA" />
<cpo:ItemDescription Description="Word Processing Application" Type="F" />
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</cpo:Item>
<cpo:Total LineltemTotal="87" POTotal="544.15" QuantityTotal="34">12.34</cpo:Total>
<cpo:Description>VGhpcyBpcyBhIHB1cmNoYXNIIG9yZGVyIGRIc2NyaXB0aW9uLg==</cpo:Description>
</cpo:CommonPO>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>
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SOAP Envelope Attributes and Namespaces

This section shows how a private process can set SOAP envelope attributes and
namespaces. The SOAP message generated by TIBCO BusinessConnect SOAP Protocol
has the private process-supplied envelope attributes and namespaces along with the
default attributes and namespaces generated by TIBCO BusinessConnect SOAP Protocol.

The SOAP envelope attributes are managed following these rules:
*  For outbound messages, all attributes are populated on the SOAP envelope.

*  For inbound messages, only the envelope attributes with their associated namespaces
are sent to the private process. The unused namespace attributes are not sent.

*  The envelope attributes must be bound to a namespace prefix.

* A SOAP envelope namespace, such as http:/www.w3.org/2003/05/soap-envelope, cannot be
sent from the private process. The private process cannot send the namespace for a
SOAP envelope prefix that has been defined in TIBCO Administrator for a given
trading partner.

Envelope Attributes and Namespaces Example

The ae/SOAP/InitiatorRequest and ae/SOAP/ResponderResponse SOAP AE class have the
envelopeAttributes field. This field is of type sequence, ac/SOAP/Attributes. ac/SOAP/Attributes
is a sequence of the class ae/SOAP/Attribute.

The ae/SOAP/Attribute class contains the following fields:
* name
* value

The following example is a SOAP 1.2 message:
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<SOAP-ENV:Envelope
xmlns:SOAP-ENV="http://www.w3.0rg/2003/05/soap-envelope/"
xmlns:xsi="http://www.w3.0org/2001/XMLSchema-instance"
xmlns:pro="http://myorg.com/schemas/promotions"
pro:promotionExpiryDate="03/12/2003">

</SOAP-ENV:Envelope>

This SOAP message has a namespace and a promotionExpiryDate attribute in the namespace

http://myorg.com/schemas/promotions.

Create an ae/SOAP/Attributes sequence element. This sequence node has two ae/SOAP/Attribute
elements.

The field values for the first ae/SOAP/Attribute:

°* name: xmins:pro

e value: "http:/myorg.com/schemas/promotions"

The field values for the second ae/SOAP/Attribute:
°* name: pro:promotionExpiryDate

e value: 03/12/2003

Set the ae/SOAP/Attributes sequence element to the envelopeAttributes field in the
ac/SOAP/InitiatorRequest OT ac/SOAP/ResponderResponse node.

If an attribute is not bound to a namespace, an error occurs and the transaction is
cancelled.

Configurable Namespace Prefix for the Envelope Namespace
The prefix for the envelope namespace is now configurable.

For example, a SOAP message can have the following format:

<abc:Envelope
xmlns:abe="http://www.w3.0rg/2003/05/soap-envelope/">
<abc:Header>

</abe:Header>

<abc:Body>

</abe:Body>

</abce:Envelope>

where abe replaces the previously pre-defined string SOAP-ENV.

The string SOAP-ENV is still the default, but it can be replaced by any string that you want.
This prefix is not used for SOAP faults, which are always sent with the SOAP-ENV prefix.
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Chapter 11 Private Messages

This chapter describes private message formats in TIBCO BusinessConnect SOAP
Protocol transactions and elements included in private messages.

Topics

*  Overview, page 148

* Initiator Messages, page 149

*  Responder Messages, page 157
» Advisory Message, page 166

* Attachment, page 168

* Attachment Type, page 172

e TradingPartner Type, page 173
* Attributes, page 174

*  SOAPFault, page 175

*  WS-Addressing, page 176

e XOP, page 178

* AuthenticationToken, page 179

TIBCO BusinessConnect SOAP Protocol User’s Guide



148 | Chapter 11 Private Messages

Overview

The following sections describe the messages used for private request and response
document exchange in TIBCO BusinessConnect SOAP Protocol.

* For RV Messages, message fields are packaged in the ~data” tag as part of the acRvMsg
format.

*  For JMS messages, these values are part of the node message.

See acRvMsg Message Format and JMS Message Format in 7/BCO BusinessConnect
Concepts.

Private process messages are described in this chapter:
» Initiator Messages on page 149

* Responder Messages on page 157

* Advisory Message on page 166

The following nodes can be included in private messages:
* Attachment Type on page 172

*  TradingPartner Type on page 173

* Attributes on page 174

*  SOAPFault on page 175

*  WS-Addressing on page 176

e XOP on page 178

* AuthenticationToken on page 179
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Initiator Messages

The following initiator messages are described:
* Initiator Outbound Request — Private Process to BusinessConnect on page 149

* Initiator Inbound Response — BusinessConnect to Private Process on page 154

Initiator Outbound Request — Private Process to BusinessConnect

The initiator private process uses this message to handle outbound requests, as shown in
Figure 24.

Figure 24 Initiator Outbound Request

Initiator
Request

y

A

Initiator Private BC Initiator BC Responder | ™| Responder Private
Process Process

| 4
Subject Name  prefix.installation.SOAP.INITIATOR.REQUEST
Example RV Subject: AX.BC.BC-ACME.SOAP.INITIATOR.REQUEST
Example JMS queue: AX.BC.BC-ACME.INITIATOR. REQUEST
Table 34 Initiator Request (Sheet 1 of 5)
Field Type Required Description
standardID String Yes The name of the protocol: SOAP.
transactionID String No A unique ID within the initiator private process.

This value is sent across the public boundary to the
trading partner in the BusinessConnect specific
SOAP header.

See TIBCO BusinessConnect SOAP Protocol
Public Messages on page 140.

operationID String Yes A three-part ID of the form:
interface/version/operation_name.

See Adding an Operation to a Version on page 79.
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Table 34 Initiator Request (Sheet 2 of 5)

Field Type Required Description

closure String No The private process generates a closure message
and sends it to BusinessConnect. BusinessConnect
is required to return this closure contents back in the
InitiatorResponse message to ensure that the private
process can match it with the original InitiatorRequest
message.
This field is not available for JMS messages. In
JMS header fields, closure is populated as
JMSCorrelationID.

hostName String No Identifies the local host in a multi-host
environment. If the value is not present, the default
host is used.
This filed can either have the actual name of the
host, or the domain ID of the host.

hostDomain String No Identifies the local host domain in a multi-host
environment.
If this field is present, the hostName field must contain
the domain identity.

tpName String Yes Name of the trading partner.
This filed can either have the actual name of the
partner, or the domain ID of the partner.

tpDomain String No Trading partner domain.

If this field is not present, the default domain TPname
is used.
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Table 34 Initiator Request (Sheet 3 of 5)

Field Type Required Description

Xop N/A No Identifies the specific value under xop >
tagName > value if MTOM is selected when
sending outbound messages.

Note:

* Ifthe SOAP MTOM Enabled check box is
selected, the value under xop > tagName >
value of the private process message must be
populated according to the binary data element
in the body node. If not, the request is rejected
and the outbound process is ended.

» Ifthe SOAP MTOM Enabled check box is not
selected, and the value under xop > tagName >
value in the private process is provided, the

request is rejected and the outbound process is
ended.

*  MTOM and attachments from the private
process cannot be used together. If the SOAP
MTOM Enabled check box is selected, and
some attachments are also specified from the
private process request message, the request is
rejected and the outbound process is ended.

*  When selecting the SOAP MTOM Enabled
and Require Content Encryption check boxes
to send outbound messages, the binary content
which refers to the value under xop > tagName
> value in the private process message is
ignored. The encrypted data in the Ciphervalue
element after encryption is used to construct the
MTOM attachment.

See Configuring General Properties for a Partner on
page 100 on how to select SOAP MTOM.
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Table 34 Initiator Request (Sheet 4 of 5)

Field

saml

Type
N/A

Required
No

Description

Specifies the required values in the saml node if
SAML assertions are used when sending outbound
messages.

If you use SAML assertions in conformance with
NHIN/esMD Authorization Framework, provide all
the required values in the saml node from the private
process. Errors occur if any of the required values is
missing.

See Request Action Tab on page 84 on how to
configure SAML assertions in conformance with
NHIN/esMD Authorization Framework.

authentication
Token

N/A

Includes the user name and password information
that is used for WSS UsernameToken
authentication, which is an alternative to the WSS
signature authentication.

See UsernameToken for Authentication on page 17.

attachment

Sequence of
Attachment

No

A sequence of attachments.

See Attachment on page 168.

request

String

The body of the public SOAP message in XML
format.

requestHeader

String

The header of the public SOAP message in XML
format.

WS-Addressing

N/A

Specifies the WS-Addressing parameters.
See WS-Addressing on page 176.

httpAttributes

Sequence of
SOAP/
Attribute

No

Contains the HTTP header attributes, which are
populated in the HTTP header of the outbound
HTTP request.

These optional attribute values might be useful for
the receiving server.

See Attributes on page 174.
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Table 34 Initiator Request (Sheet 5 of 5)

Field Type Required Description

envelope Sequence of  No Contains the SOAP envelope attributes. These

Attributes SOAP/ optional attribute values might be useful for the
Attribute receiving server.

See Attributes on page 174 and SOAP Envelope
Attributes and Namespaces on page 144.

enableMTOM Boolean No If you provide value for this field, this value will
override the value given in Trading Partner’s
settings for SOAP MTOM Enabled filed.

requestFile String No Specify the reference file for request.
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Initiator Inbound Response — BusinessConnect to Private Process

A synchronous response is sent from the responder BusinessConnect to the initiator
BusinessConnect and forwarded to the local private process, as shown in Figure 25.

Figure 25 Initiator Inbound Response

Initiator Private
Process

Subject Name

Initiator

e

Response

4

A

BC Initiator BC ReSpOnder P g Responder Private
( Process

A 4

prefix.installation. SOAP INITIATOR. RESPONSE

Example RV Subject: AX.BC.BC-ACME.SOAP.INITIATOR. RESPONSE

Example JMS queue: AX.BC.BC-ACME.INITIATOR.RESPONSE

Table 35 Initiator Response (Sheet 1 of 3)

Field

response

Type Required Description

String Yes

The body of the SOAP response from the
responder in XML format.

The body element is modified to have appropriate
namespaces; for example, if a body element is in a
default namespace, it is added to the body element
before converting to XML format.

statusCode

Integer Yes

See statusCode and statusMsg Field Reference
on page 182.

statusMsg

String Yes

OK, or the string representing the cause of the
error.

See statusCode and statusMsg Field Reference
on page 182.

operation]D

String Yes

A three-part ID of the form:
interface/version/operation_name

See Adding an Operation to a Version on
page 79.
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Field

transactionID

Type
String

Initiator Messages | 155

Required Description

No

The same value that was in the transactionID
field of the initiator request.

closure

String

Yes

The private process generates a closure message
and sends it to BusinessConnect.
BusinessConnect is required to return this closure
contents back in the mitiatorResponse message to
ensure that the private process can match it with
the original InitiatorRequest message.

This field is not available for JMS messages. In
JMS header fields, closure is populated as
IMSCorrelationID.

attachment

Sequence of
Attachment

Sequence of attachments.

The class definition name for this message is
ae/BC/Attachment. See Attachment on page 168.

responseHeader

String

The header of the response SOAP message in
XML format.

The header element is modified to have
appropriate namespaces; for example, if a header
element is in a default namespace, it is added to
the header element before converting it to XML
format.

saml

N/A

Contains the SAML parameters.

WS-Addressing

N/A

Contains the WS-Addressing parameters.
See WS-Addressing on page 176.

envelopeAttributes

Sequence of
SOAP/
Attribute

Contains the SOAP envelope attributes. These
optional attribute values might be useful for the
receiving server.

See Attributes on page 174 and SOAP Envelope
Attributes and Namespaces on page 144.

resend

Boolean

This field is set to true When the message is a
resent transaction.

standardID

String

Yes

The name of the protocol: SOAP.

TIBCO BusinessConnect SOAP Protocol User’s Guide



156 | Chapter 11 Private Messages

Table 35 Initiator Response (Sheet 3 of 3)

Field Type Required Description
duplicate Boolean No This field is set to true when this is a duplicate
response.
responsefile String No Specify the reference file for response.
The Receive Response activity can receive a SOAP fault or any valid XML document as a
% response. Therefore, if the Parse XML Payload check box in the Configuration tab in

private process is selected, the body element can have either the schema for the response, or
the SOAPFault element.

To get an appropriate response, the root element has to be configured in TIBCO
Administrator, and also the schema has to be present for that operation. If no schema is
defined for the response, only the SOAPFault element is displayed. This behavior is the same
as in the case of the Send Response activity when sending a response.

See SOAPFault on page 175.
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Responder Messages

The following responder messages are described:
*  Responder Inbound Request — BusinessConnect to Private Process on page 157
*  Responder Outbound Response — Private Process to BusinessConnect on page 161

* Responder Acknowledgement — BusinessConnect to Private Process on page 165

Responder Inbound Request — BusinessConnect to Private Process

The responder private process uses this message to handle inbound requests, as shown in
Responder Inbound Request.

Even if the incoming message size exceeds the threshold set under

%% BusinessConnect > Gateway > Gateway Services > HTTP > Transport > Advanced >
Data Streaming Threshold (KB) in TIBCO Administrator, the full message, not a file
reference, is sent to the private process through RV or JMS.

A new property bc.soap.pp.fileref.threshold is added under BusinessConnect > System
Settings > Activated Protocol Plug-ins and properties > SOAP in TIBCO
Administrator. The default value is SMB.

Figure 26 Responder Inbound Request

Responder
Request
Initiator Private BC Initiator BC Responder [~ ) Responder Private
Process Process
»
»

Subject Name  prefix.installation.SOAP.RESPONDER.REQUEST
Example RV Subject: AX.BC.BC-ACME.SOAP.RESPONDER.REQUEST

Example JMS queue: AX.BC.BC-ACME.RESPONDER.REQUEST
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Table 36 Responder Inbound Request (Sheet 1 of 3)

Field Type

request String

Required
Yes

Description

The body of the public SOAP message in XML
format.

The body element is modified to have appropriate
namespaces; for example, if a body element is in a
default namespace, it is added to the body element
before converting to XML format.

sourceTP String

Yes

The name of the initiator of this message.

This field contains name or domain identity
value.

sourceTPDomain Strin g

The domain of the initiator of this message.

destinationTP String

The name of the responder to this message.

This field contains name or domain identity
value.

destinationTPDomain String

The domain of the responder to this message.

operationID Strin g

Yes

A three-part ID of the form:
interface/version/operation_Name.

See Adding an Operation to a Version on
page 79.

transactionID String

The value of the transaction ID from TIBCO
BusinessConnect SOAP Protocol specified
HTTP URL. If no transaction ID is specified, a
unique one with the name besoap:guid is generated.

See TIBCO BusinessConnect SOAP Protocol
Public Messages on page 140.
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Table 36 Responder Inbound Request (Sheet 2 of 3)

Field Type Required Description

closure String No Used for synchronous request-response
operation. BusinessConnect generates a closure
message and sends it to the local private process.

If this is a request of a synchronous
request-response operation, the private process
is required to return this closure contents back in
the ResponderResponse message to ensure that
BusinessConnect can match it with the original
ResponderRequest message.

This field is not available for JMS messages. In
JMS header fields, closure is populated as

IJMSCorrelationID.
standardID String Yes The name of the protocol: SOAP.
attachment Sequence of  No A sequence of attachments.
Attachment See Attachment on page 168.
requestHeader String No The header of the public SOAP message in XML
format.
The header element is modified to have
appropriate namespaces; for example, if a header
element is in a default namespace, it is added to
the header element before converting to XML
format.
saml N/A No Contains the SAML elements received from
inbound requests.
WS-Addressing N/A No Contains the WS-Addressing parameters.
See WS-Addressing on page 176.
envelopeAttributes Sequence of  No Contains the SOAP envelope attributes. These
SOAP/ optional attribute values might be useful for the
Attribute receiving server.

See Attributes on page 174 and SOAP Envelope
Attributes and Namespaces on page 144.
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Table 36 Responder Inbound Request (Sheet 3 of 3)

Field Type Required Description

resend Boolean No This field is set to true when the message is a
resent transaction.

duplicate Boolean No This field is set to true when this is a duplicate
request.

operationType String Yes Type of operation: notify or synchronous
request-response.

requestFile String No Specify the reference file for request if request

data is too big to embed in the message directly.
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Responder Outbound Response — Private Process to BusinessConnect

The responder private process uses this message to handle outbound responses, as shown
in Figure 27.

Figure 27 Responder Outbound Response

Initiator Private BC Initiator BC Responder ¢ | Responder Private
Process Process

| 2
Responder
Response
Subject Name  prefix.installation. SOAP RESPONDER.RESPONSE
Example RV Subject: AX.BC.BC-ACME.SOAP.RESPONDER.RESPONSE
Example JMS queue: AX.BC.BC-ACME.RESPONDER.RESPONSE
Table 37 Responder Outbound Response (Sheet 1 of 3)
Field Type Required Description
statusCode Integer No All status codes below 200 and above 299 are

considered to be SOAP fault.

When the value in the statusCode field is set to under 200
or above 299, the SOAPFault element is sent to the
trading partner and the body is ignored even if it
contains data. To send the content of the body, the
value in the statusCode field must range between 200 and
299.

See statusCode and statusMsg Field Reference on
page 182.

statusMsg String No OK, or the string representing the cause of the error. See
statusCode and statusMsg Field Reference on
page 182.

response String Yes The response business document in XML format.
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Table 37 Responder Outbound Response (Sheet 2 of 3)

Required Description

xop N/A No Identifies the specific value under xop >
tagName > value if MTOM is selected when sending
outbound messages.

Note:

e Ifthe SOAP MTOM Enabled check box is
selected, the value under xop > tagName > value
of the private process message must be populated
according to the binary data element in the body
node. If not, the request is rejected and the
outbound process is ended.

e Ifthe SOAP MTOM Enabled check box is not
selected, and the value under xop >
tagName > value in the private process is
provided, the request is rejected and the outbound
process is ended.

*  MTOM and attachments from the private process
cannot be used together. If the SOAP MTOM
Enabled check box is selected, and some
attachments are also specified from the private
process request message, the request is rejected
and the outbound process is ended.

e When selecting the SOAP MTOM Enabled and
Require Content Encryption check boxes to send
outbound messages, the binary content which
refers to the value under
xop > tagName > value in the private process
message is ignored. The encrypted data in the
CipherValue element after encryption is used to
construct the MTOM attachment.

See Configuring General Properties for a Partner on
page 100 on how to select SOAP MTOM.

authentication N/A No Includes the user name and password information that
Token is used for WSS UsernameToken authentication, which
is an alternative to the WSS signature authentication.

See UsernameToken for Authentication on page 17.
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Table 37 Responder Outbound Response (Sheet 3 of 3)

Required

Description

attachment Sequence of  No A sequence of attachments.
Attach
tachment See Attachment on page 168.

closure String Yes BusinessConnect generates a closure message, and
sends it to the local private process in the
ResponderRequest message upon receiving a request for a
synchronous request-response operation. The private
process must return this closure contents in the
ResponderResponse message to ensure that
BusinessConnect can match it with the original
ResponderRequest Message.
This field is not available for JMS messages. In JMS
header fields, closure is populated as JMSCorrelationID.

operationID String Yes A three-part ID of the form:
interface/version/operation_Name.

responseHeader String No The header of the response.
This becomes the header of the public SOAP message.

WS-Addressing N/A No Specifies the WS-Addressing parameters.
See WS-Addressing on page 176.

envelope Sequence of  No Contains the SOAP envelope attributes. These optional

Attributes SOAP/ attribute values might be useful for the receiving

Attribute server.

See Attributes on page 174 and SOAP Envelope
Attributes and Namespaces on page 144.

saml N/A No Not used for Responder.Response messages.

soapFault N/A No See SOAPFault on page 175.

standardID String Yes The name of the protocol: SOAP.

responseFile String No Specify the reference file for response.
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The Send Response activity has the SOAPFault element as a part of a body element, and also
% of the BCResponderResponse element.

When sending a SOAP fault, you can populate it in the SOAPFault element under the
BCResponderResponse element or in the SOAPFault element under the body element. Any SOAP
fault values specified under the body element are ignored when the values under the
BCResponderResponse element are provided.

See SOAPFault on page 175.
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Responder Acknowledgement — BusinessConnect to Private Process

When the responder BusinessConnect sends a response, the responder BusinessConnect
sends an acknowledgement to the local private process if the initiator BusinessConnect
returns no error, as shown in Figure 28.

Figure 28 Responder Acknowledgement
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Initiator Private BC Initiator BC Responder | ™| Responder Private
Process Process
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Responder
Acknowledgement

Subject Name  prefix.installation.SOAP.RESPONDER.ACK
Example RV Subject: AX.BC.BC-ACME.SOAP.RESPONDER.ACK

Example JMS queue: AX.BC.BC-ACME.RESPONDER.ACK

Table 38 ResponderAck

Field Type Required Description
statusCode Integer Yes See statusCode and statusMsg Field Reference on
page 182.
statusMsg String Yes OK, or the string representing the cause of the error. See

statusCode and statusMsg Field Reference on page 182.

operationType String Yes ACK.

closure String Yes BusinessConnect generates a closure message, and sends
it to the local private process in the ResponderRequest
message upon receiving a request for a synchronous
request-response operation.

This field has the same value as in the ResponderRequest
message.

This field is not available for JMS messages. In JMS
header fields, closure is populated as JMSCorrelationID.
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Advisory Message

This message is used to publish status information.

Subject Name  prefix.installation.SOAP.ERROR
Example RV Subject: AX.BC.BC-ACME.SOAP.ERROR

Example JMS topic: AX.BC.BC-ACME.ERROR

Table 39 Advisory Messages
Field Type Required Description
statusCode Integer Yes One of the error codes.

See statusCode and statusMsg Field Reference on
page 182.

statusMsg String Yes Represents the cause of the error.
In this case, the response might be an error document.

See statusCode and statusMsg Field Reference on
page 182.

details String No More detailed description of the error.

This can be an analysis of the problem.

operationID String Yes A three-part ID of the form:
interface/version/operation_Name.

transactionlD String No Request-response ID for which the error message is
generated.
closure String No If the error occurred on the initiating side, it contains a

closure sent as part of the request. Otherwise, it contains a
closure passed to the responder private process. It might
be null.

This field is not available for JMS messages. In JMS
header fields, closure is populated as JMSCorrelationID.

host soap/ No Host information.

Trading .

Partner See TradingPartner Type on page 173.
tpName String Yes Name of the trading partner.
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Field Type Required Description
tradingPartner soap/ No Trading partner information.
gﬁzf This field is populated only if TIBCO BusinessConnect

SOAP Protocol is able to extract the domain and ID
information for the trading partner.
See TradingPartner Type on page 173.

Code N/A No Specifies the value and subcode to check detailed fault
information.

Reason N/A No Specifies the cause of the fault.

Node String No Identifies the node in which the fault occurred.

Role String No Identifies the role of the node in the SOAP message that
caused the fault to happen.

Detail String No Detailed message of the SOAP fault in the SOAP body.
The content format must be well-formed XML.

msgDirection String No Currently not used.

standardID String No The name of the protocol: SOAP.

timestamp String No Currently not used.

extralnfo String No Currently not used.
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Attachment

You can use TIBCO BusinessConnect SOAP Protocol to send and receive attachments in
binary format, such as jpg, .zip, or .doc, or in the text format. TIBCO BusinessConnect
SOAP Protocol private process sends the attachments to BusinessConnect, or receives the
attachments from BusinessConnect.

The attachment class in the messages has the following fields:
* name The name of the attachment

» content-type The type of the content associated with this attachment, such as text of
binary

» content-id The content ID for the attachment
* content Content of the attachment
» originalContentType The original received content type

This field is only available for the ResponderRequest and InitiatorResponse private process
messages. It has the same value as the content-type field, unless the content-type
field cannot be inferred by Business Connect. In that case, the content-type ficld is
changed to application/octet-stream and the originalContentType ficld is set to the actual
value that is received.

All attachment fields are defined as strings, which require that the binary content be

specified as base64 encoded.

MTOM and attachments from the private process cannot be used together. If the SOAP
MTOM Enabled check box is selected, meanwhile some attachments are also specified
from the private process request message, the request is rejected and the outbound process
is ended.

See Configuring General Properties for a Partner on page 100 on how to select SOAP
MTOM.

Multipart MIME Messages

When attachments are present, SOAP messages are formulated as multipart Multipurpose
Internet Mail Extensions (MIME) messages and TIBCO BusinessConnect SOAP Protocol
depends on the parameters in the content-type field for packaging.

MIME messages are configured as follows:

*  The first message part carries the SOAP envelope.
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*  Other message parts carry the attachments. Each message part carries the following
header information:

Content-Type Indicates the type of the content embedded in the part.
Content-Disposition Indicates the presentation style used for the MIME part.
Content-Transfer-Encoding Indicates the encoding used for the MIME part.

Content-ID Indicates the content from anywhere in the multipart SOAP message.

Determining the Content Type of an Attachment

The value in the content-type field must be defined in the type/subtype format, such as
text/xml, application/zip, and so on.

TIBCO BusinessConnect SOAP Protocol processes the attachment content based on the
value in the content-type field as follows:

» Content is processed as plain text and the content type is referred to as text if it is in the
text/* OT application/*xml* formats.

* Content is processed as binary and the content type is referred to as binary if it is in the
application/binary, application/octet-stream, application/zip, application/pdf, application/doc, image/*, audio/*,
or video/* formats.

» Content type that is not in text or in binary format is processed as unknown and
referred to as unknown. Content is packaged or interpreted as either text or binary,
depending on the situation.

« If'the value in the content-type field does not conform to the Request for Comments
(RFC) standard, it is changed to application/octet-stream and the content is processed as

binary.

The only exception to this rule is when the value in the content-type field is defined
as binary and is subsequently changed to application/binary. This change is made to
maintain backward compatibility with TIBCO BusinessConnect SOAP Protocol 5.0.

The value in the content-type field for attachments must conform to MIME
[RFC2045] standards, for example, it has to be in the type/subtype format. For complete
syntax of this property, see RFC 2045 at http://www.ietf.org/rfc/rfc2045.txt.

Outbound Attachments

Outbound attachments are populated for the outbound request or response messages such
as InitiatorRequest OT ResponderResponse.

If the value in the content-type field is not specified, it is determined based on the type of

content:
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If content is of type String, the value in the content-type field defaults to text/plain.

If content is of type byte Array, the value in the content-type field defaults to

application/octet-stream.

Content for the outbound attachments is packaged as a byte array as follows:

If the value in the content-type field is text, content is converted to bytes and the
attachment is populated.

If the value in the content-type field is binary, content is base64 decoded if it was
previously base64 encoded. Otherwise, content is converted to bytes and the
attachment is populated.

If the value in the content-type field is unknown, the content type is changed to
application/octet-stream, content is converted to bytes, and the attachment is populated.

Inbound Attachments

Inbound attachments are received from public process multipart MIME SOAP messages,
which can carry the attachment content either in text or binary format.

Since the private process has to receive the attachment content as a string, TIBCO
BusinessConnect SOAP Protocol handles the attachments with the different content types
as follows:

If the attachment content type is text, content is sent to the private process as text.

If the attachment content type is binary, content is base64 encoded and sent to the
private process.

If the attachment content type is unknown, content is base64 encoded and sent to the
private process. In this case, the value in the content-type field is changed to
application/octet-stream and the content is processed as binary. For example, even if the
plain text is received with the value in the content-type field described as unknown, this
content is base64 encoded.

See Converting Attachments to Base64 Strings on page 170.

Converting Attachments to Base64 Strings

Attachments are converted to base64 string as follows:

1.

Content-Transfer-Encoding is inspected. If it is base64, content is sent as base64 to the
private process.

Content itself is inspected for bases4 characters. If all the characters are in the base64
character range, content is sent as base64. Otherwise, content is base64 encoded and
sent.
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OriginalContentType

For inbound attachments, if the content type is unknown, it is changed to application/octet-stream.
The same value is passed on to the private process in the content-type field. The original
value received is populated in the originalContentType field.

For text and binary content types, the content-type and originalContentType fields for
the private process have the same value. The originalContentType field is populated
even when the attachment property from the release 5.0 is preserved.

Preserving the SOAP 5.0 Attachment Functionality

TIBCO BusinessConnect SOAP Protocol version 5.0 processes the attachments as plain
strings. For binary attachments, this could cause a problem.

From 5.1 release and onward, the behavior has been changed so that the binary
attachments are converted to base64 encoding before they are sent to private process if
they are not in base64 encoding originally.

However, you can still keep version 5.0 behavior for a particular partner by setting the
TIBCO BusinessConnect SOAP Protocol Boolean property:

be.soap.<tpname>.enableS0Attachment = true

where <tpname> is the name of the trading partner. When enabled, the original content type
that was received is sent to the private process.
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Attachment Type

The attachment node (ae/BC/attachment) has the following fields:

Table 40 Attachment Type

Field Type Description
name String Name of the attachment file.

If the name of the attachment is not provided, the attachment name is
auto-generated as attachmentindex. content-type.

Example: If the second attachment file name is missing and
content-type=image/jpeg, and then the name generated for that attachment
1S attachment2.jpeg.

content-type String Content type of attachment.

Examples: plain/text and application/binary.

content-id String The unique identifier used to identify an attachment in outgoing
document.
content String Actual attachment.

All text-based payloads and attachments from the private process to
BusinessConnect must be encoded in UTF-8.

Binary attachments must be base64 encoded.

originalContentType String The original received content type is populated in this field.

The field is available only for the ResponderRequest and InitiatorResponse
private process messages.
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TradingPartner Type

The tradingPartner node (ae/BC/tradingPartner) has the following fields:

Table 41 Trading Partner Type

Field Type Description
name String Trading partner name.
domain String Trading partner domain.
id String Trading partner ID.
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Attributes

The Attributes node (ae/SOAP/Attribute) has the following fields:

Table 42 Attribute Node

Field Type Description
name String The name of the attribute.
value String The value associated with the name.
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The soapFault node (ae/SOAP/soapFault) has the fOHOWiI‘lg fields:

Table 43 SOAP Fault Node

Field Type Description
Code
Value String Specifies the value from the set of SOAP fault:
VersionMismatch, MustUnderstand, DataEncodingUnknown,
Sender, and Receiver.
SubCode String Specifies the value of the subcode to check detailed
fault information.
Reason
ReasonText
lang String Specifies the language code used for the fault reason.
content String Specifies the cause of the fault.
Node String Identifies the node in which the fault occurred.
Role String Identifies the role of the node in the SOAP message
that caused the fault to happen.
Detail String A detailed message of SOAP fault in the SOAP body.

The content format must be well-formed XML.

faultString.

to 1.1.

For TIBCO BusinessConnect SOAP Protocol, the TIBCO ActiveMatrix BusinessWorks
private process supports the SOAP fault only in version 1.2. If you want a SOAP fault in
version 1.1, perform the following steps:

1. Populate the value in the soapFault > Code > Value field as your faultCode.

2. Populate the value in the soapFault > Reason > ReasonText > content field as your

3. Populate the value in the soapFault > Role field as your faultActor.

After performing these steps, BusinessConnect converts the SOAP fault from version 1.2

TIBCO BusinessConnect SOAP Protocol User’s Guide



176 | Chapter 11 Private Messages

WS-Addressing

The Ws-Addressing node (ac/SOAP/WS-Addressing) has the following fields:

Table 44 WS-Addressing Node

Field Type Description

MessagelD String The unique URI of the message.

To String Specifies the receiver URI of the message.

From N/A Specifies the endpoint of the service that dispatched the message.

ReplyTo N/A Specifies the endpoint of the receiver for reply messages.

FaultTo N/A Specifies the endpoint of the receiver for fault messages.

Action String The specific semantic operation of the message.

RelatesTo N/A A pair of values that specify the relationship between this message and
another message.

The original request MessageID must correspond with this property.

o If MessageID is not specified from the private process, or from any inbound request or
% response, all the properties are ignored.

* In the response message replied back to the initiator, the To property is set to the same
as the ReplyTo property of the original request message. However, if the private process
specifies the WS-Addressing To property for the response message, it is used to
override the ReplyTo property in the original request message.

*  The RelatesTo property of the response message replied to the initiator is set to the same
as the MessagelD property of the original request message.

The From, ReplyTo, and FaultTo properties has the following fields, as shown in Table 45.

Table 45 The From, ReplyTo, and FaultTo Properties

Field Type Description
Address String Specifies the URI address of the endpoint.
ReferenceProperties String Specifies the required properties for identifying the

transferred entity or resource.
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Table 45 The From, ReplyTo, and FaultTo Properties (Cont’d)

Field Type Description

ReferenceParameters String Specifies the elements used to associate with the
endpoint to boost an interaction.

PortType String Specifies the primary PortType of the endpoint being
conveyed.

ServiceName

PortName String Specifies the name of the <wsdl:port> definition that
interacts with the referenced endpoint.

value String Specifies the <wsdl:service> definition that contains a
WSDL description of the referenced endpoint.

The RelatesTo property has the following fields, as shown in Table 46.

Table 46 The RelatesTo Property

Field Type Description

RelationshipType String Specifies the relationship type between this message and another
message.

value String The specific content of the RelateTo property.
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XOP

The xop node contains the tagName ficld, and you can type the specific value in the value
field when expanding the tagName field.

The xop node (ae/SOAP/xop) has the following fields:

Table 47 XOP Node

Field Type Description
tagName Sequence of  Specifies the tag names of the element node that is optimized with
tagName MTOM.

See Configuring General Properties for a Partner on page 100 on how to select SOAP
MTOM, and see also MTOM on page 22 for more information.
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AuthenticationToken

The authenticationToken node (ae/SOAP/authenticationToken ) has the following fields:

Table 48 AuthenticationToken Node

Field Type Description
userName String The user name of the token for authentication.
password base64Binary The password of the token for authentication.

If you select the Require UsernameToken Authentication check box, the user name and
password must be typed in the private process.

&
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Appendix A Status Codes

This appendix describes the possible values in the statusCode and statusMsg fields. It
also explains schema validation errors.

Topics

» statusCode and statusMsg Field Reference, page 182
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statusCode and statusMsg Field Reference

The statusCode and statusMsg ficlds are used in private messages that are sent in
response to a request. See Responder Inbound Request — BusinessConnect to Private
Process on page 157 and Responder Outbound Response — Private Process to
BusinessConnect on page 161 for examples of this.

The following values might be displayed in the statusCode and statusMsg ficlds:

Table 49 statusCode and statusMsg Fields (Sheet I of 8)

Code

(status Description Role

Category Possible Resolution

Code) (statusMsg)

The following status codes (200-500) are standard HTTP codes:

200 OK All status codes below 200 and above 299
are considered to be SOAP fault.

201-299 HTTP(S) OK codes . .
When the value in the statusCode field is set

to under 200 or above 299, the SOAPFault
element is sent to the trading partner and
the body is ignored even if it contains
data. To send the content of the body, the
value in the statusCode field must range

between 200 and 299.
300 - HTTP(S) error codes Error System
499
500 Internal Server error. Error System Check fault code, fault string, and fault
SOAP fault occurred. reason.
510 Socket closed. Error System

The 600-699 status codes are error related to Web Services Security:

601 Generic errors occurred  Error Security
when processing the
message for security.

650 Message encryption Error Security Check the certificates or encryption
failed. algorithm. One of them might be invalid.
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Table 49 statusCode and statusMsg Fields (Sheet 2 of 8)

Code -

Description - -

g;zt;s (statusMsg) Possible Resolution

651 Message signing failed.  Error Security Check the identity used for signature or

the signing algorithm. One of them might
be invalid.

652 Signature verification Error Security Check the certificates used for signature
failed. verification. It might be wrong.

653 Message decryption Error Security Check the identity used for decryption. It
failed. might be wrong.

654 WSSecurity process Error Security Either the decryption or verification of the
upon inbound message inbound message has failed. For more
failed. details, look in the status message.

656 UsernameToken Error Security

authentication failed.

657 User name or password  Error Security
is not supplied by
private process.

659 Unknown errors Error Security Errors occurred while processing the
message for security. For more details,
look in the status message.

The 800-899 status codes are for errors trapped locally on the initiator side:

800 Access Denied: reason  Error Configuration

801 Duplicate outgoing Error Configuration This is detected by the initiator process.
message detected Make sure unique IDs are used.

802 Transport transport is Error Configuration SOAP supports HTTP and HTTPS only.
not supported by
SOAP.

803 Cannot process a Error Configuration
synchronous EMAIL
request
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Table 49 statusCode and statusMsg Fields (Sheet 3 of 8)

Code -

Description - -

&s;zt:)s (statusMsg) Role Category Possible Resolution

804 Cannot send operation ~ Error Configuration
type request to multiple
trading partners

805 Notification did not Error Configuration
reach all trading
partners.

806 Received SOAP Fault. Error
Fault String:
fault_string

807 Errors occurred when Error
reading a response.

820 Schema validation Error Schema Depending on what caused the error to
error: missing validation and occur, load either header, body schema or
validating schema message both.

(request) contents

821 Schema validation Error Schema Depending on what caused the error to
error: missing validation and  occur, load either header, body schema or
validating schema message both.

(response) contents

822 Schema validation Error Schema This is detected by the initiator process.
error: request not validation and ~ Make sure there is an agreement between
conforming to schema. message the message and the schema registered in
reason contents the

Operation > Request Action tab of the
Operations Editor. Or do not select
Validate Message check box in the
Operation > Request Action tab of the
Operations Editor.
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Code
(status

Code)

Description
(statusMsg)
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Possible Resolution

823 Schema validation Error Schema This is detected by the initiator process.
error: response not validation and ~ Make sure there is an agreement between
conforming to schema. message the message and the schema registered in
reason contents the

Operation > Response Action tab of the
Operations Editor. Or do not select
Validate Message check box in the
Operation > Response Action tab of the
Operations Editor.

824 Attachment processing  Error Schema
error, msg: message validation and
(request from private message
process) contents

825 Attachment processing  Error Schema
error, msg: message validation and
(response from private message
process) contents

827 Failed to set HTTP Error HTTP error
basic authorization
header

831 Partner is not Error Configuration
configured:

841 Posting error: reason Error HTTP error

842 Invalid transport URI Error HTTP error The transport URL for the trading partner

is not correct: check and correct the URL.

855 Errors occurred when Error Schema
processing the validation and
attachments. message

contents

856 Errors occurred when Error Package

extracting the envelope Message

attributes.
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Table 49 statusCode and statusMsg Fields (Sheet 5 of 8)

Code o

Description - -
&s;zt:)s (statusMsg) Role Category Possible Resolution
857 Errors occurred when Error Configuration

processing MTOM

configuration: reason

858 Errors occurred when Error Configuration
processing SAML
configuration: reason

866 Received response Error Security Check the Operations Editor settings.
document is denied
because of
encryption/signing
permissions.

867 Errors occurred when Error Package Verify that envelope attributes are
setting envelope Message correctly specified as described in the
attributes. documentation.

872 Errors occurred when Error Security
verifying or decrypting
the response.

888 Errors occurred when Error Package A problem happened when packaging the
serializing SOAP Message SOAP message.
fmessage. Verify the SOAP body and header

elements.

890 No matching

transaction found for
ID ID. The request
might have timed out.

899 Errors occurred. No Error System
available detailed
information.

The 900 - 999 status codes are for errors trapped by the responder and sent back to the
initiator:
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Code e
Description : ;
g;zt;s (statusFI)VIsg) Possible Resolution
900 Trading partners arenot  Error Configuration
permitted to access:
reason
901 Access Denied: reason ~ Error Passthrough Verify that your default host accepts
anonymous messages by selecting the
Allow Anonymous SOAP Messages
check box for the default host.
910 Inbound transport is not
enabled.
920 Request parsing error Error Schema
validation and
message
contents
921 Missing validating Error Schema Depending on what caused the error to
schema validation and occur, load either header, body schema or
message both.
contents
922 Request not Error Schema Depending on what caused the error to
conforming to schema validation and  occur, load either header, body schema or
message both.
contents This is detected by the responder process.
Make sure there is an agreement between
the message and the schema registered in
the
Operation > Request Action tab of the
Operations Editor. Or do not select
Validate Message check box in the
Operation > Request Action tab of the
Operations Editor.
923 Attachment processing  Error Schema
error, msg: (request validation and
from trading partner) message
contents
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Table 49 statusCode and statusMsg Fields (Sheet 7 of 8)

Code -

Description - -
(status (statusMsg) Category Possible Resolution
Code)
924 Attachment processing  Error Schema

error in response from validation and

private process, detail: message

contents

925 Errors occurred when Error Security Check the Operations Editor settings.

decrypting or verifying

the SOAP message.
926 Non-Repudiation

logging of signed

request failed.

927 Errors occurred when Error
processing the
response, detail:

928 Errors occurred when Error Configuration
processing MTOM
configuration: reason
929 Errors occurred when Error Configuration
processing SAML
configuration:
940 Client authentication Error HTTP/
failed. Comm
941 Errors occurred when Error HTTP/
receiving a response Comm
from private process.
Detail:
942 Failed to send reply to Error HTTP/ Check the DMZ timeout parameters.
DMZ Comm
943 Errors occurred when Error System Could not save context information in the
sending a request to database. Check database connection
private process. status.
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Code
(status

Code)

Description
(statusMsg)

statusCode and statusMsg Field Reference

Possible Resolution

944 Response not Error Schema Depending on what caused the error to
conforming to schema validation and  occur, load either header, body schema or

message both.

contents This is detected by the responder process.
Make sure there is an agreement between
the message and the schema registered in
the
Operation > Response Action tab of the
Operations Editor. Or do not select
Validate Message check box in the
Operation > Response Action tab of the
Operations Editor.

990 No matching
transaction found for
ID ID. The request
might have timed out.

999 Errors occurred. No Error System This is detected by the responder process.
available detailed Turn on tracing to capture the traces.
information. Contact TIBCO Support and forward the

traces to them.

1000 - Private-party-defined Error

1999 error codes
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AppendixB  Schema Validation

This appendix explains how to perform schema validation with TIBCO BusinessConnect
SOAP Protocol.

Topics

* Overview, page 192

e Schema Validation Errors, page 193
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Overview

When schema validation is selected, it is performed on the SOAP header, SOAP body, or
both.

When validation is used, at least one of the schemas, body or header must be populated. If
schema validation is selected and the schema is not uploaded, the schema validation for
body or header is ignored. Schema validation fails if schema is uploaded for body or
header in TIBCO Administrator and message does not have that part.
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Schema Validation Errors

This section explains SOAP fault and SOAP advisory messages that are displayed if
schema validation fails.

Schema validation errors are accessed through Log Viewer by using TIBCO
Administrator.

If schema validation fails on the initiator side for an outbound SOAP message, the
SOAP advisory message on the ERROR subject on the initiator side has the complete

details of the schema validation errors. These details are posted in the statusMsg field of
the SOAP/Advisory AE message.

If the schema validation fails on the responder side for an inbound SOAP message,
which means the SOAP message from the public process, a SOAP fault is sent to the
trading partner. The SOAP fault detail has the complete schema validation error.

A sample 1.1 SOAP fault message structure with fault details looks as follows:

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/"

xmlns:xsd="http://www.w3.0org/2001/XMLSchema" xmlIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<SOAP-ENV:Body>

<SOAP-ENV:Fault>
<faultcode>SOAP-ENV:Client</faultcode>
<faultstring>Request not conforming to schema</faultstring>
<faultactor>SOAPServer</faultactor>
<detail>
<ei:ErrorInfo xmlns:ei="http://www.tibco.com/namespaces/bc/2003/10/errorinfo.xsd">
<code>922</code>
<description>Request not conforming to schema</description>
</ei:ErrorInfo>
</detail>
</SOAP-ENV:Fault>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>

The schema for the Errorinfo element is in the errorinfo.xsd file in the
TIBCO_HOME]/ve/version_number/protocols/soap/samples/schemas directory.

The SOAP advisory message is published both on the initiator and responder sides,
with the statusMsg element containing the schema validation errors.

If the schema validation fails when processing a response message from the private
process on the responder side, a SOAP fault is sent with the fault string, Response not
conforming to schema. This SOAP fault message does not have fault details.

A SOAP/Advisory AE message is published on the ERROR subject with the schema
validation errors in the statusMsg element.
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o If the schema validation fails when processing a response message on the initiator
side, a SOAP/Advisory AE message is published on the ERROR subject with schema
validation errors in the statusMsg element.
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Appendix C  TIBCO BusinessConnect SOAP Protocol
WSDL Tool

This appendix gives an introduction to TIBCO BusinessConnect SOAP Protocol WSDL
tool and shows how to use it to export and import WSDL files.

Topics

*  Overview, page 196
*  WSDL Import, page 197
»  WSDL Export, page 199
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Overview
You can use TIBCO BusinessConnect SOAP Protocol WSDL tool to import the WSDL
files into TIBCO BusinessConnect configuration or export the TIBCO BusinessConnect
configuration into the WSDL files.
The TIBCO BusinessConnect SOAP Protocol WSDL tool does not automatically set
% certificates for participants. After importing the WSDL files, you must explicitly set

certificates for the HTTPS and HTTPSCA transports.
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WSDL Import
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To import the WSDL files into TIBCO BusinessConnect configuration, navigate to the
TIBCO _HOME/bc/version_number/protocols/soap/tools/wsdl directory and run the following
commands:

— Windows wsdlimport.exe

— Unix /wsdlimport

After importing the WSDL files, log off from TIBCO Administrator, and then log in to
TIBCO Administrator to view the imported WSDL operations.

When importing the WSDL files with the WSDL tool, you must note the following:

e Operation bindings are created for the operations imported through the WSDL by
selecting BusinessConnect > Business Agreement > Agreement Name > SOAP >
Host X can initiate of that particular host and partner mentioned in the wsdlimport.tra
file. Business agreement is created if it is not present before the import process. The
Override Transports check box in the Transports tab of these operation bindings is
selected, and primary transport is set to the transport created under partner for this
particular operation.

* The Require Digital Signature, Require Content Encryption, and Require
UsernameToken Authentication check boxes for that operation in Operations
Editor are always unselected after the import process if at least one schema for that
operation is in WSDL. The Validate Message check box for that operation in
Operations Editor is always selected.

Importing WSDL in nested Schemas

If nested schemas are configured as file references, their location should not change
compared to the configured location in the operations editor. This is due to the fact that the
content of the schemas components are loaded into the BusinessConnect schema cache
on-demand from the specified location. In addition, if the BC palette-based private
process imports operations that have been configured with such referenced schema, the
original location - with the same path - must be accessible from the importing project only
for the duration of the update. After the update on the palette-based project is complete
there is no further correlation between the original schema file resources and the imported
schemas.

When you use nested schemas in BusinessConnect, use the file reference option and make
sure that all dependant schemas are present within the same directory. This way the
BusinessConnect palette will import the mentioned schemas to the Designer.

1.Set up the schema as a file reference in BusinessConnect.
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2.Import it into BusinessWorks.
3.Import the rest of the nested schemas into a subdirectory in your BusinessWorks project.

4.0pen the root schema in BusinessWorks. When it asks for the reference to a
sub-schema, select the appropriate file in the imported BusinessWorks directory.

WSDL Import TRA File Configuration

TIBCO BusinessConnect SOAP Protocol WSDL import tool uses the wsdlimport.tra file in
the TIBCO_HOME)/bc/version_number/protocols/soap/tools/wsdl directory for configuration and
command line arguments.

Table 50 and Table 51 describe the properties in the wsdlimport.tra file that you can use to
modify for WSDL import process.

Table 50 BusinessConnect Database Configuration Properties for WSDL Import Process

Properties Description
java.property.be.repo.db.user=database user Specify the user name and password of the
java.property.bc.repo.db.password=database password database.

java.property.be.repo.db.url=/DBC URL Specify JDBC URL and driver of the database.

java.property.be.repo.db.driver=/DBC Driver

Table 51 WSDL File, Trading Partner, Local Host Name, and SOAP Version Properties for WSDL Import
Process

Properties Description

java.property.wsdlfilename=WSDL filename Specify the WSDL file name to be imported. If the WSDL
filename is a directory, all the WSDL files under this
directory are imported.

java.property.tradingpartner=trading partner name Specify the name of the trading partner.

java.property.hostname=host name Specify the local host name.

Host name to be used in a multi-host configuration. This value
is used to create business agreement between this trading
partner and host. If this property is not specified, the default
host is used.

java.property.wsdl.soap.version=SOAP version Specify the SOAP version of the imported WSDL file, such as
SOAPI.1 or SOAP1.2. You can use this parameter to update the
SOAP version of a trading partner in configuration store.

The default SOAP version is SOAP1.1.
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WSDL Export

To export TIBCO BusinessConnect configuration into the WSDL files, navigate to the
TIBCO _HOME/bc/version_number/protocols/soap/tools/wsdl directory and run the following
commands:

— Windows wsdlexport.exe
— Unix /wsdlexport
% To export schemas into a WSDL file, the root element has to be available. If no root

element is available, schemas are not exported even if the schemas are uploaded in TIBCO
Administrator.

WSDL Export TRA File Configuration

TIBCO BusinessConnect SOAP Protocol WSDL export tool uses the wsdlimport.tra file in
the TIBCO_HOME/vc/version_numberiprotocols/soap/tools/wsdl directory for configuration and
command line arguments.

Table 52 and Table 53 describe the properties in the wsdlexport.tra file that you can use to
modify for WSDL export process.

Table 52 BusinessConnect Database Configuration Properties for WSDL Export Process

Properties Description

java.property.be.repo.db.user=database user Specify the user name and password of the database.

java.property.bc.repo.db.password=database password

java.property.be.repo.db.url=/DBC URL Specify JDBC URL and driver of the database.
java.property.be.repo.db.driver=/DBC Driver

Table 53 WSDL File, Endpoint, SOAP Version, Service, Namespace, and List Properties for WSDL Export
Process

Properties Description
java.property.wsdlfilename=wsd! file name Specify the WSDL file name.
java.property.wsdl.url=ur{ Specify WSDL endpoint URL.

For example: http://SOAPServer:6700/dmz/SOAP

java.property.wsdl.soap.version=SOAP version Specify the SOAP version of the exported WSDL file,
such as SOAPI.1 or SOAP1.2.

The default SOAP version is SOAP1.1.
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Table 53 WSDL File, Endpoint, SOAP Version, Service, Namespace, and List Properties for WSDL Export
Process (Cont’d)

Properties Description

java.property.wsdl.service=service name Specify the WSDL service name.
java.property.wsdl.namespace=wsd! namespace Specify the WSDL namespace.
java.property.wsdl.operationlist=export list filename Specify the WSDL export list.

This file contains list of interface / version that can be
exported into the WSDL file.

Each line of this file must have one interface / version.
Format of each line is as follows:
interface name | version name

Interface and version name separated by ‘/°.
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